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Preface

StorNext provides high performance data sharing and intelligent 
archiving that is compatible with an industry-leading range of operating 
systems, server platforms, and storage devices.

StorNext includes two main components:

• StorNext File System (SNFS) is high performance data sharing 
software that lets applications on multiple operating systems access 
a single data set.

• StorNext Storage Manager (SNSM) is an intelligent, policy-based 
data mover that automatically moves and locates data across 
multiple storage tiers.

In addition, StorNext and StorNext FX client software allows client 
operating systems to mount and work with StorNext and Xsan file 
systems.

Audience This document is intended for service professionals and system 
administrators who install StorNext software. The installer should have 
strong familiarity with the operating system on which StorNext is 
installed.

Only service professionals, experienced StorNext users, or individuals 
who have successfully completed StorNext training should configure 
StorNext. Attempting to configure StorNext without proper experience 
or training can affect system performance and may result in data loss.
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Purpose This document provides information about installing and configuring 
StorNext. The following topics are covered:

• System requirements

• Pre-installation tasks

• Installation

• Configuration

• Uninstalling StorNext

DVD Directories Files on the StorNext installation DVD are located in the following 
locations, depending on whether a media kit DVD or a user-created DVD 
from an .iso image for a web-release download is used:

Directory Location Directory Contents

Media Kit DVD /fs_only This contains the installation binaries for 
supported platforms for StorNext 
Filesystem-only and Filesystem-only 
clients and clients plus Distributed Data 
Mover (DDM), which are located in the 
_plus_mover directory. This also 
contains the StorNext and StorNext FX 
client installation binaries for supported 
platforms.

/stornext_full This contains the installation binaries for 
supported platforms for full installation 
of StorNext, including both the File 
System and Storage Manager..

/stornext_full/clients This contains the StorNext and StorNext 
FX client installation binaries for 
supported platforms.

/documentation This contains the current set of StorNext 
documentation and the documentation 
front end, which provides a way to 
navigate to the documents.

/offlinenotification This contains the installation binaries for 
supported platforms for StorNext offline 
notification installations.
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Document Organization This document contains the following chapters: 

• Chapter 1, StorNext Linux Server Installation/Configuration provides 
system requirements, pre-installation information, and instructions 
for installing and configuring StorNext File System and Storage 
Manger on a server, called the Metadata Controller (MDC).

• Chapter 2, Lightweight Linux Server Installation/Configuration 
provides system requirements, pre-installation information, and 
instructions for installing and configuring RPM-only installations on 
Linux servers.

• Chapter 3, Windows SNFS Server Installation/Configuration provides 
system requirements, pre-installation information, and instructions 
for installing and configuring StorNext File System on Windows 
servers.

• Chapter 4, StorNext and StorNext FX Client Installation/
Configuration provides system requirements, pre-installation 

Directory Location Directory Contents

Web Release DVD /fs_only This contains the installation binaries for 
supported platforms for StorNext 
Filesystem-only and Filesystem-only 
clients and clients plus Distributed Data 
Mover (DDM), which are located in the 
_plus_mover directory. This also 
contains the StorNext and StorNext FX 
client installation binaries for supported 
platforms.

/stornext_full This contains the installation binaries for 
supported platforms for full installation 
of StorNext, including both the File 
System and Storage Manager.

/stornext_full/clients This contains the StorNext and StorNext 
FX client installation binaries for 
supported platforms.

/offlinenotification This contains the installation binaries for 
supported platforms for StorNext offline 
notification installations.
StorNext and StorNext FX 4.7.x Installation Guide xix



Preface
information, and instructions for installing the StorNext and 
StorNext FX client software on Linux and Windows machines.

• Chapter 5, Configuring LAN Clients and Gateway Servers describes 
how to configure a distributed LAN client or server for both single-
server and high-availability (HA) systems.

• Appendix A, Uninstalling StorNext describes how to remove 
StorNext software from a server or client system.

•  Appendix B, Administration Tasks describes how to perform file 
system tasks that do not apply to a typical StorNext setup, including 
Connecting Xsan Clients to StorNext MDCs.

•  Appendix C, StorNext Files describes the files used and modified to 
configure a file system, the cluster-wide control feature, and the file 
used to configure the cluster-wide security controls.

• Appendix D, Quality of Service Guide describes how to configure 
and use the StorNext File System (SNFS) Quality of Service (QOS) 
feature.

Notational Conventions This manual uses the following conventions:

Convention Example

User input is shown in bold font. ./install

Computer output and command 
line examples are shown in 
monospace font.

install.stornext

User input variables are enclosed in 
angle brackets.

https://<machine 
name>:<port number>

For UNIX and Linux commands, the 
command prompt is implied.

./snPreInstall 
is the same as 
# ./snPreInstall

File and directory names, menu 
commands, button names, and 
window names are shown in bold 
font.

/usr/cvfs/config
xx StorNext and StorNext FX 4.7.x Installation Guide 
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The following formats indicate important information:

Note: Note emphasizes important information related to the main 
topic.

Caution: Caution indicates potential hazards to equipment or data.

WARNING: Warning indicates potential hazards to personal safety.

Related Documents For a list of documents related to StorNext, visit the Quantum Service 
and Support page at: 

http://www.quantum.com/sndocs

Contacting Quantum More information about this product is available on the Quantum 
Service and Support website at www.quantum.com/ServiceandSupport. 
The Quantum Service and Support website contains a collection of 
information, including answers to frequently asked questions (FAQs). 
You can also access software, firmware, and drivers through this site.

To request a software upgrade, visit www.quantum.com/
ServiceandSupport/Upgrade/Index.aspx. For further assistance, or if 
training is desired, contact Quantum Global Services:

Menu names separated by arrows 
indicate a sequence of menus to be 
navigated.

Configuration > File 
Systems

Convention Example

North America 1+800-284-5101 Option 5

EMEA 00800 7826 8888 
49 6131 3241 1164

Online Service and 
Support

www.quantum.com/OSR
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(Local numbers for specific countries are listed on the Quantum Service 
and Support Website.

Worldwide Web www.quantum.com/ServiceandSupport
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Chapter 1
StorNext Linux Server 

Installation/Configuration 

This chapter describes how to install StorNext File System (SNFS) and 
StorNext Storage Manager (SNSM) together as a complete package on a 
Linux Metadata Controller (MDC). Install both SNFS and SNSM for 
storage systems that require policy-based data movement (for example, 
systems that use the Replication feature or include tape drives or 
libraries or to use the StorNext Linux GUI).

Quantum recommends performing a full StorNext install on a Linux 
MDC, with the StorNext web GUI and StorNext Storage Manager. This 
provides a user-friendly interface, and the ability to use archiving.

If you do not need Storage Manager components or the StorNext Linux 
GUI, you can perform an RPM-only installation (see Chapter 2, 
Lightweight Linux Server Installation/Configuration). 

The Storage Manager component of StorNext can only be installed on 
Linux systems. For Windows installation, see Chapter 3, Windows SNFS 
Server Installation/Configuration. 

Once the StorNext File System is installed, you can configure it using the 
StorNext Configuration Wizard. To configure StorNext, you will enter 
license information and create one or more file systems. In addition, on 
Metadata Controllers (MDCs) running StorNext Storage Manager, you 
can add storage devices and media, create storage policies, and set up 
e-mail notifications. To access the Configuration Wizard, use the Web-
based GUI to access StorNext running on an MDC.
StorNext and StorNext FX 4.7.x Installation Guide 1
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To ensure successful operation, do the following tasks before installing 
StorNext:

• Make sure the MDC meets all operating system and hardware 
requirements (see System Requirements on page 3).

• Make sure all storage devices are correctly configured and are visible 
to the MDC (see Getting Ready to Install on page 9)

• (Optional) Run the pre-installation script to check for available disk 
space and view recommended locations for support directories (see 
Running the Pre-Installation Script on page 12).

When you are ready to install StorNext File System and Storage Manager 
on the MDC, run the installation script (see Running the StorNext 
Installation Script on page 17).

This chapter covers:

• System Requirements

• Getting Ready to Install

• Running the Pre-Installation Script

• Running the StorNext Installation Script

• Post-Installation Steps

• Enabling and Installing Licenses

• Converting to HA

• Configuring StorNext Using the StorNext GUI

• Linux Device Mapper Multipath Support
2 StorNext and StorNext FX 4.7.x Installation Guide 
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System Requirements

To run StorNext, the Metadata Controller must meet all operating 
system, hardware, and LAN requirements.

Note: The performance of the storage holding the Storage Manager 
database and metadumps has an impact on overall StorNext 
file system performance. Quantum recommends that the 
Storage Manager database and metadata dumps are stored on 
high performance storage devices, such as a RAID array. Storing 
the Storage Manager database on slower storage devices, 
including local disks, can result in poor performance or time-
outs.

Note: The UIDs for the quantumdb and tdlm users and the adic 
group must be identical on both nodes of an HA pair. If the 
UIDs are not identical, the MySQL database will not start (due 
to file permission errors), which in turn prevents storage 
manager from fully starting up. Quantum recommends 
creating the UIDs for the quantumdb and tdlm users along 
with the adic group on both nodes prior to running 
install.stornext.

Operating System 
Requirements

The operating systems, kernel versions, and hardware platforms 
supported by StorNext File System are listed in the StorNext 
Compatibility Guide posted here (click the “Select a StorNext Version” 
menu to view the desired version of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the operating system and platform 
requirements outlined in the guide, and, if necessary, update to a 
supported release or kernel version before installing StorNext.

Modifying the grub.conf File

A fix is required prior to installing the StorNext file system and Storage 
Manager. This fix avoids potential clock jumps and temporary system 
StorNext and StorNext FX 4.7.x Installation Guide 3
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System Requirements
freezes on some systems. This fix only affects Red Hat Linux releases 6.0, 
6.1, 6.2 and their CentOS counterparts on systems with Intel processor 
versions identified by the internal codename Nehalem. 
 
Follow the steps below to modify the grub.conf file so that the Intel 
sleep state is disabled. Making this change could result in increased 
power consumption, but it helps prevent problems which result in 
system hangs due to processor power transition.

1 For the above systems, prior to installation: 
 
Add the following text to the "kernel" line in /boot/grub/:

2 Reboot the system for the change to take effect.

Note: The install.stornext script will scan the rpms that are to be 
installed to ensure that all dependencies will be successfully 
resolved. Unresolved dependencies will result in a warning 
from the install.stornext script, and prompt the user to 
either quit or continue. Continuing without resolving the 
dependencies may result in system instability or disabling 
StorNext. It is strongly recommended that the missing 
dependencies are resolved prior to installing StorNext. 
 
Consult your operating system's package repository for the 
missing dependencies. A common missing dependency with 
4.3.0 is the perl-DBI package which is not installed by default 
on some Linux distributions. Other required dependencies 
include gcc, make and kernel-headers on Red Hat or kernel-
source on SUSE.

Installing StorNext 
from a DVD

Installation and upgrade media is shipped on DVDs. Both software and 
documentation are now stored on a single DVD, eliminating multiple 
discs for different operating systems. If you plan to install from media, 
you must have a DVD ROM drive to perform the installation or upgrade. 

grub.conf:Idle=polling intel_idle.max_cstate=0 
processor.max_cstate=1
4 StorNext and StorNext FX 4.7.x Installation Guide 
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Downloading a 
StorNext Media Kit 
(Creating an ISO Image)

Another way to obtain a StorNext media kit is by downloading the 
software. This process consists of obtaining a download authorization 
certificate, creating a download account (or signing on if you already 
have an account), downloading a software ISO image onto DVD, and 
then installing the software as described in this guide.

For more information about downloading StorNext media kits or to 
obtain a download authorization certificate, contact your Quantum 
StorNext support representative.

Installing StorNext 
from a Web Download

A third StorNext delivery method is downloading from the Web. With 
this method you will download an executable program that will require 
you to accept the StorNext end user license agreement and will then 
extract the StorNext installer.

As part of the installation from a Web download, the software files are 
extracted into the /tmp/stornext directory by default. The software, 
when extracted, requires approximately 400 MB of space. Make sure 
there is enough free space in the default directory to extract the files. If 
there is not sufficient space, you may need to specify an alternative 
directory with the -d option.

To specify an alternate location before beginning the installation, enter 
the following command:

where <installation file> is the name of the installation file, and 
<dir> is the directory into which you want to extract the installation 
files.

Hardware 
Requirements

RAM and hard disk space requirements to run the StorNext File System 
are listed in the StorNext Compatibility Guide posted here (click the 
“Select a StorNext Version” menu to view the desired version of the 
guide):

http://www.quantum.com/sndocs

# ./<installation file> -d <dir>
StorNext and StorNext FX 4.7.x Installation Guide 5
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Make sure the MDC meets the hardware requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

Partitioning Local Hard Disks

StorNext can be installed on any local file system (including the root file 
system) on the MDC. However, for optimal performance, as well as to 
aid disaster recovery, follow these recommendations:

• Avoid installing StorNext on the root file system.

• Partition local hard disks so that the MDC has four available local file 
systems (other than the root file system) located on four separate 
hard drives. This is so you can install the support directories in four 
separate locations (for more information, see Support Directories on 
page 12).

Note: You can run the pre-installation script to help determine 
the estimated size of and optimal location for StorNext 
support directories. For more information, see Running the 
Pre-Installation Script on page 12.

Additional Memory and 
Disk Requirements for 
Deduplication and 
Replication

Additional requirements that must be met in order to use the data 
deduplication and replication features on the StorNext MDC are listed in 
the “StorNext MDC Additional RAM and Disk Requirements for 
Deduplication and Replication” section of the StorNext Compatibility 
Guide posted here (click the “Select a StorNext Version” menu to view 
the desired version of the guide):

http://www.quantum.com/sndocs

Make sure the MDC meets the requirements outlined in the guide, and, 
if necessary, update the MDC before installing StorNext.
 

LAN Requirements StorNext LAN requirements are listed in the “StorNext MDC Network 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs
6 StorNext and StorNext FX 4.7.x Installation Guide 
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Make sure the MDC meets the network requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

Other Requirements Additional requirements that must be met for the StorNext system are 
listed in the “Additional StorNext MDC and StorNext Client 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the additional requirements outlined in the 
guide, and, if necessary, update the system before installing StorNext.

Windows Recycle Bin Requirements

If you are using the StorNext client software with Windows Server 2003, 
Windows Server 2008, Windows XP, Windows Vista or Windows 7, turn 
off the Recycle Bin in the StorNext file systems mapped on the Windows 
machine.
You must disable the Recycle Bin for the drive on which a StorNext file 
system is mounted. Also, each occurrence of file system remapping 
(unmounting/mounting) will require disabling the Recycle Bin. For 
example, if you mount a file system on E: (and disable the Recycle Bin 
for that drive) and then remap the file system to F:, you must then 
disable the Recycle Bin on the F: drive.
As of release 3.5, StorNext supports mounting file systems to a 
directory. For Windows Server 2003 and Windows XP you must disable 
the Recycle Bin for the root drive letter of the directory-mounted file 
system. (For example: for C:\MOUNT\File_System you would disable the 
Recycle Bin for the C: drive.) 
For Windows Server 2003 or Windows XP:

1 On the Windows client machine, right-click the Recycle Bin icon  
on the desktop and then click Properties.

2 Click Global.

3 Click Configure drives independently.

4 Click the Local Disk tab that corresponds to the mapped or 
directory-mounted file system.
StorNext and StorNext FX 4.7.x Installation Guide 7
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5 Click the checkbox Do not move files to the Recycle Bin. Remove files 
immediately when deleted.

6 Click Apply, and then click OK.
For Windows Server 2008, Windows Vista and Windows 7 systems, you 
must disable the Recycle Bin on C: and the File system name:

1 On the Windows client machine, right-click the Recycle Bin icon  
on the desktop and then click Properties.

2 Click the General tab.

3 Select the mapped drive that corresponds to the StorNext mapped 
file system. For directory-mounted file systems, select the file system 
from the list.

4 Choose the option Do not move files to the Recycle Bin. Remove files 
immediately when deleted.

5 Click Apply.

6 Repeat steps 3-5 for each remaining directory-mounted file system.

7 When finished, click OK.

(See Windows Recycle Bin Settings Example on page 8)

Figure 1  Windows Recycle Bin 
Settings Example
8 StorNext and StorNext FX 4.7.x Installation Guide 
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Getting Ready to Install

Before installing StorNext SNFS and SNSM, complete the following tasks 
to ensure successful installation:

• Correctly configure all storage devices (see Configuring Storage 
Devices).

• If using LUNs larger than 1 TB, decide on a label type and install any 
necessary operating system patches (see Planning for LUNs Larger 
than 1 TB).

• (Linux only) Install the kernel source code (see Installing the Linux 
Kernel Source Code on page 11).

Configuring Storage 
Devices

Before installing StorNext SNFS and SNSM, make sure that all LUNs are 
visible to the MDC. (A LUN, or logical unit number, is a logical device 
that corresponds to one or more disks, drives, or storage devices.)

If there are any connection issues, resolve them before installing 
StorNext. For assistance in configuring storage devices, refer to the 
documentation that came with the storage device, or contact the 
manufacturer.

Note: LUNs that you plan to use in the same stripe group must be the 
same size. Consider this when configuring storage devices. (For 
more information about stripe groups, see the StorNext User’s 
Guide.)

Caution: StorNext does not support the connection of multiple 
devices through fibre channel hubs. Multiple devices must 
be connected using fibre channel switches.

Note: Quantum recommends that only the storage devices required 
for an environment are visible to each system. Unnecessary disk 
visibility will affect system start-up performance and increase 
the risk of inadvertent reuse of resources. 
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Planning for LUNs 
Larger than 1 TB

StorNext supports LUNs greater than 1 TB in size if they are allowed by 
the operating system. To enable support for 1 TB or larger LUNs, all 
StorNext LUNs must be correctly labeled according to the requirements 
of the operating system running on the MDC as well as the operating 
system running on all connected clients. Disk LUNs can have one of 
three labels: VTOC, EFI, or sVTOC (short VTOC). Before installing 
StorNext, decide what label type will be used.

Required disk LUN label settings based on operating system and LUN 
size are presented in Table 1. Before installing StorNext, install any 
required operating system patches or updates (for both MDC and client) 
as indicated in the notes for Table 1.

Note: After labeling a disk LUN, you must reboot systems running 
Solaris before they can access the disk LUN.

Table 1  Required Disk LUN 
Labels Operating 

System
Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs 
> 2 TB

Windowsa VTOC, EFI VTOC, EFI EFI, sVTOC

Linux 2.6 
Kernel

VTOC, EFI VTOC, EFI EFI, sVTOC

Solaris 10b VTOC, EFI EFI EFI

HP-UXc VTOC, EFI VTOC, EFI EFI, sVTOC

IBM AIXd VTOC, EFI VTOC, EFI EFI, sVTOC

SGI IRIXe VTOC VTOC Not supported

Apple Xsan 
2.1.1 (MacOS 
X 10.5 
Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC

Apple Xsan 2.2 
(MacOS X 10.6 
Snow Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC
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Note: For best results, Quantum recommends using persistent 
binding for disk LUNs. For more information, contact the 
vendor of your HBA (host bus adapter).

Installing the Linux 
Kernel Source Code

For management servers running Red Hat Enterprise Linux version 5 or 
6, before installing SNFS and SNSM you must first install the kernel 
header files (shipped as the kernel-devel or kernel-devel-smp RPM, 
depending on your Linux distribution).

For servers running SUSE Linux Enterprise Server, you must install the 
first kernel source code (shipped as the kernel-source RPM). StorNext 
will not operate correctly if these packages are not installed. You can 
install the kernel header files or kernel source RPMs by using the 
installation disks for your operating system.

Verifying Hostname 
Length

The maximum hostname length for a StorNext server is limited to 255 
characters. Before you begin the installation, verify that the destination 
hostname is not longer than 255 characters.

a. For Windows XP 32-bit systems only, support for LUNs larger than 2 TB is 
limited to the first 2 TB. All other supported Windows platforms 
(including Windows XP 64-bit) support LUNs greater than 2 TB.

b. Support for 2 TB or larger LUNs requires Solaris 10 Update 2 (06/06).
c. Supports only the first 2 TB of LUNs larger than 2 TB.
d. Supports only LUNs of 2.2 TB or less.
e. IRIX is not supported starting with StorNext 4.0. However, StorNext 3.5 

IRIX clients can be used with StorNext 4.7.x  MDCs.

Operating 
System

Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs 
> 2 TB
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Running the Pre-Installation Script

The StorNext pre-installation script (snPreInstall) is included on the 
StorNext installation DVD. When you run snPreInstall, you are 
prompted for information about your system. The pre-installation script 
uses this information to estimate the amount of local disk space 
required for SNFS and SNSM support directories. In addition, the script 
recommends the optimal locations for support directories.

Support Directories StorNext uses four support directories to store application support 
information. These directories are stored locally on the Metadata 
Controller. 

The StorNext support directories are described in Table 2.

Table 2  StorNext Support 
Directories Support Directory* Description

Database

/usr/adic/mysql/db
Records information about where and 
how data files are stored.

Journal

/usr/adic/mysql/
journal

Records changes made to the 
database.

Mapping

/usr/adic/TSM/
internal/mapping_dir

Contains index information that 
enables quick searches on the file 
system.

Metadata

/usr/adic/database/
metadumps

Stores metadata dumps (backups of 
file metadata).

*Depending on file system configuration, the support directory locations 
may be different. However, symbolic links in /usr/adic/ will always point 
to the support directories.
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Before You Begin Before running the pre-installation script, be prepared to answer the 
following questions:

• Is this an upgrade installation?

• What local file systems can be used to store support information?

• Which version of StorNext will be installed?

• What is the maximum number of directories expected (in millions)? 

• What is the maximum number of files expected (in millions)?

• How many copies will be stored for each file?

• How many versions will be retained for each file?

Note: Keep in mind that storage needs typically grow rapidly. 
Consider increasing the maximum number of expected 
directories and files by a factor of 2.5x to ensure room for 
future growth.

Note: The pre-installation script ignores unmounted file systems. 
Before running snPreInstall, be sure to mount all local file 
systems that will hold StorNext support information.

Running snPreInstall To run the pre-installation script, use the StorNext installation DVD.

1 Log on to the MDC as root.

2 Mount the StorNext installation DVD and change to the DVD root 
directory.

3 List the installation directories on the DVD. At the command 
prompt, type:

ls -l
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4 Change to the stornext_full directory.

Note: Make sure you are in the stornext_full directory and not 
the fs_only directory. The fs_only directory installs the 
StorNext File System only.

5 List the directories in the stornext_full directory. At the command 
prompt, type:

6 Identify the correct installation directory for your operating system 
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 5 running on an x86 64-bit platform, 
change to the RedHat50AS_26x86_64 directory.

7 Run the script. At the command prompt, type the following:

The pre-installation script runs (Figure 2).

Figure 2  Pre-Installation Script

ls -l

./snPreInstall
14 StorNext and StorNext FX 4.7.x Installation Guide 



Chapter 1: StorNext Linux Server Installation/Configuration
Running the Pre-Installation Script
8 Follow the onscreen instructions, and answer each question when 
prompted.

The script outputs results based on the information you entered.

Interpreting 
snPreInstall Output

After you enter all requested information, the pre-installation script 
outputs the following results:

• Estimated disk space required for each support directory.

• Recommended file system location for each support directory.

There are three types of directory recommendations, as indicated by the 
text preceding the recommendation. The three types of 
recommendations are described in Table 3.

Table 3  Pre-Installation Script 
Recommendation Types

The pre-installation script bases directory location recommendations on 
the following criteria: 

• To aid disaster recovery, the Database and Journal directories 
should be located on different file systems.

• For optimal performance, each support directory should be located 
on its own local file system, and each local file system should reside 
on a separate physical hard disk in the MDC.

Note: These recommendations apply to non-HA systems only.

Type Description

RECOMMEND The suggested directory locations will result in 
optimal system performance.

NOTE The suggested directory locations are valid but 
system performance will not be optimal.

SPACE Additional hard disk space is required to store 
the required support directories.
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Note: Do not change the location of support directories manually. 
Instead, use the installation script to specify the location for 
support directories. For more information, see Running the 
StorNext Installation Script.
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Running the StorNext Installation Script

When you are ready to install StorNext, use the StorNext installation 
script to install StorNext File System and Storage Manager on the 
Metadata Controller. The installation script also installs the client 
software on the MDC.

Upgrading From a 
StorNext File System-
Only Configuration

If you have StorNext File System only and are adding StorNext Storage 
Manager, some components remain from the File System installation 
and the new installation could fail. To prevent installation failure, you 
should first remove the old components.

The following procedure describes how to remove the old components 
before starting the new StorNext installation. Follow the steps below 
only if you are upgrading from a StorNext File System-only 
configuration to StorNext File System and Storage Manger.

1 Log on to the MDC as root.

2 Save /etc/fstab and /usr/cvfs/config

3 Remove the existing StorNext File System rpms.

4 Install StorNext as described in Launching the StorNext Installation 
Script on page 18.

5 Restore /etc/fstab and /usr/cvfs/config
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Launching the StorNext 
Installation Script

The StorNext installation script lets you choose installation configuration 
options and install StorNext. To launch the script, you will need to use 
the correct file on the StorNext installation DVD for your operating 
system.

Note: localhost cannot map to multiple IP addresses. Before 
running the StorNext installation script, make sure localhost 
in the /etc/hosts file is mapped to a single IPv4 address, and 
not an IPv6 address.

1 Log on to the MDC as root.

2 Mount the StorNext installation DVD and change to the DVD root 
directory.

Note: When you mount a DVD in a Red Hat 5 or 6 system, DVDs 
are mounted by default with a noexec (non-executable) 
option which prevents you from proceeding with the 
installation. 
 
For Red Hat users only, before proceeding you must 
remount the DVD by typing mount -o remount, exec ...

3 List the installation directories on the DVD. At the command 
prompt, type:

4 Change to the stornext_full directory.

Note: Make sure you are in the stornext_full directory and not 
the fs_only directory. The fs_only directory installs the 
StorNext File System only.

5 List the directories in the stornext_full directory. At the command 
prompt, type:

ls -l

ls -l
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6 Identify the correct installation directory for your operating system 
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 5 running on an x86 64-bit platform, 
change to the RedHat50AS_26x86_64 directory.

7 Run the script. For new StorNext installations, at the command line, 
type:

After the database migration, the installation script runs (Figure 3).

Figure 3  StorNext Installation 
Script

8 Type the number corresponding to a menu option and press 
<Enter>. Installation menu options are described in Table 4.

Table 4  StorNext Installation 
Main Menu Options

./install.stornext

Menu Option Description

1 Change installation options, including the 
location of application directories and the default 
media type (see Changing Installation 
Configuration Options on page 20).

2 Install StorNext using the installation options 
specified on the Configuration Menu (see 
Performing an Installation Operation on 
page 21).
StorNext and StorNext FX 4.7.x Installation Guide 19



Chapter 1: StorNext Linux Server Installation/Configuration
Running the StorNext Installation Script
Changing Installation 
Configuration Options

Use the Configuration Menu to change StorNext installation options. 
You can specify the location of application and support directories and 
change the default media type for storage devices.

On the Main Menu, type 1 and press <Enter>. The Configuration Menu 
appears (Figure 4).

Figure 4  Configuration Menu

Changing Application Directory Locations

When you first enter the Configuration Menu, it displays recommended 
locations for StorNext application directories based on the available file 
systems detected by the installation script. To accept the recommended 
directory locations and return to the Main Menu, press <Enter>.

Alternately, customize the installation by specifying the file systems 
where application and support files are stored.

3 View the status of an installation operation that 
is currently in progress.

4 Exit the StorNext installation script.

Menu Option Description
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1 On the Configuration Menu, type the number that corresponds to 
the directory location you want to customize (1–16), and then press 
<Enter>.

A list of available local file systems is shown.

2 To change the file system where the directory is located, type the 
name of the file system and press <Enter>.

3 To confirm the change, type yes and press <Enter>.

To customize additional directory locations, repeat steps 1–3.

4 When you are done customizing the installation, press <Enter> to 
return to the Main Menu.

Note: To help determine the optimal location for StorNext 
support directories, use the StorNext pre-installation script. 
For more information, see Running the Pre-Installation 
Script on page 12.

Changing the Default Media Type

If you do not specify a different media type, the StorNext installation 
script selects LTO as the default media type for storage devices. If 
storage devices in your system use a different media type, change the 
default media type before installing StorNext.

1 On the Configuration Menu, type 16 and press <Enter>.

A list of valid default media types is shown. The valid media types 
are: SDISK, LTO, LTOW, 3590, 3592, 9840, 9940, AITW, AIT, DLT4, 
and T10K.

2 Type the correct default media type for storage devices in your 
system and press <Enter>.

3 To confirm the change, type yes and press <Enter>.

4 When you are done customizing the installation, press <Enter> to 
return to the Main Menu.

Performing an 
Installation Operation

To install StorNext using the options specified on the Configuration 
Menu, perform an installation operation.

1 On the Main Menu, type 2 and press <Enter>.
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The StorNext installation script runs. The script displays the current 
progress of the installation.

2 When the installation is complete, press <Enter> to return to the 
Main Menu.

3 To exit the installation script, type 4 and press <Enter>.

Note: The script displays the URL at which the MDC can be 
accessed. Make a note of this information.

4 After running the installer, source the profile on the MDC by 
running this command:

You can now access StorNext File System and Storage Manager, and run 
the Configuration Wizard. For more information, see Configuring 
StorNext Using the StorNext GUI on page 25.

Post-Installation Steps

After StorNext is installed, you are ready to configure your system. 
Quantum recommends using the StorNext Configuration Wizard, which 
walks you through the steps of configuring your system for the first 
time. For more information about logging in to StorNext and using the 
Configuration Wizard, see Using the StorNext Configuration Wizard on 
page 27.

Logging In to StorNext For instructions, see Accessing the StorNext GUI on page 26.

SSL Certificate 
Exception

When you log into StorNext for the first time, you might see a message 
warning you about a security certificate. Refer to the Quantum 
Knowledge Base for a permanent workaround to this issue. 

. /usr/adic/.profile
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For a temporary solution, create a certificate exception that will allow 
you to log into StorNext without seeing the warning message during 
subsequent logins.

Starting StorNext 
Components

When you log in to StorNext for the first time, the System Control 
screen appears. On this screen you can start StorNext File System and 
Storage Manager by clicking Start. 

Enabling and Installing Licenses

Some StorNext licenses come pre-enabled on your system, and others 
must be purchased and then enabled by installing a license key file on 
your system. If your system is using a temporary 30-day license, you 
should enter permanent licenses as soon as it is convenient. The 
following are the steps you need to take to obtain and install your 
StorNext licenses.

Converting to HA

This section describes the configuration steps necessary to convert a 
node to a primary HA server. Converting to HA consists of selecting your 
dedicated unmanaged StorNext file system for use as the controlling 
shared file system, and then instructing StorNext to convert the node to 
HA.

• The UIDs for the quantumdb and tdlm users and the adic group 
must be identical on both nodes of an HA pair. If the UIDs are not 
identical, the MySQL database will not start (due to file permission 
errors), which in turn prevents storage manager from fully starting 
up. Quantum recommends creating the UIDs for the quantumdb 
and tdlm users along with the adic group on both nodes prior to 
running install.stornext.
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HA Conversion 
Procedure

Follow these steps to configure HA:

1 Choose Tools > High Availability > Convert. The High Availability 
screen appears. 

Figure 5  Tools > HA Screen

2 At the Shared File System field, select the shared file system you 
want to use for the HA pair.

Caution: Once you convert a file system to HA you cannot undo 
the operation, so choose carefully when selecting the 
file system. 

Note: The file system should not have quotas enabled. Enabling 
quotas on the file system can interfere with the proper 
functionality of Storage Manager and the HA 
infrastructure.

3 At the MDC Address field, select one IP address to be placed in the 
ha_peer file for use in administrative operations between the MDCs 
in the HA pair.
24 StorNext and StorNext FX 4.7.x Installation Guide 



Chapter 1: StorNext Linux Server Installation/Configuration
Configuring StorNext Using the StorNext GUI
4 For non-Lattus systems ONLY: If your HA cluster also runs the 
blockpool, select Enable and then enter the virtual IP address and 
virtual netmask. (Ask your network administrator for the vIP address 
and netmask.)

5 Click Convert to convert the primary node to HA.

6 Enter the IP address of the secondary system on the same LAN, and 
then click Scan. If you do not already have licenses for the 
secondary system in the license file, you will be required to switch to 
the license page to import them before continuing. (The 
information comes from the individual license.dat files on both 
MDCs. StorNext merges the two into one file before converting the 
secondary.)

Note: Until you have performed the scan, you cannot import the 
license file for the secondary system using the StorNext 
import function. After you have performed the scan you 
can import licenses for the secondary. Following the 
conversion to HA, the license file will contain both primary 
and secondary licenses and will be present on both servers.

7 Click Convert to convert the secondary system.

Note: The secondary system will reboot, which can take 30 minutes 
or more to complete.

Configuring StorNext Using the StorNext GUI

The StorNext GUI provides access to StorNext features and displays 
system status information. Use the StorNext GUI to create and work 
with file systems. In addition, on Metadata Controllers running Storage 
Manager, you can use the StorNext GUI to configure storage devices and 
media, and to set up storage policies. 
StorNext and StorNext FX 4.7.x Installation Guide 25



Chapter 1: StorNext Linux Server Installation/Configuration
Configuring StorNext Using the StorNext GUI
Accessing the StorNext 
GUI

The StorNext GUI is browser-based and can be remotely accessed from 
any machine with access to the StorNext server. 

Use this procedure to access the StorNext GUI.

1 Open a Web browser.

Note: For a list of browsers that have been tested to work with 
StorNext, refer to the StorNext Compatibility Guide posted 
here (click the “Select a StorNext Version” menu to view 
the desired documents): 
 
http://www.quantum.com/sndocs

In the browser’s Address field, type the full address of the machine, and 
then press Enter.  
 
For example: https://<machine name>:<port number>. Use the 
name of the machine you copied when you installed the StorNext 
software. 

Note: Typically, the port number is 443. If port 443 is in use, use 
the next unused port number. (I.e., 444, 445, etc.) 

After you enter the machine name and port number, the following 
window appears:

Figure 6  StorNext Login 
Window

2 In the User ID field, type admin.

3 In the Password field, type password.

4 Click Login. The initial StorNext System Control screen appears. 
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Figure 7  System Control

5 On this screen you can determine if the StorNext File System and 
Storage Manager components are currently started. If not, click 
Start for each component to start them. (If you are logging in for 
the first time, it is likely that Storage Manager will be stopped and 
require starting.)

6 Click the home (house) icon in the upper right corner to go to the 
StorNext Home Page.

Note: When you log into StorNext for the first time, you might see a 
message warning you about a security certificate. Either click 
the option that allows you to “continue to this site,” or, for a 
temporary solution, create a certificate exception that will 
allow you to log into StorNext without seeing the warning 
message during subsequent logins.

Using the StorNext 
Configuration Wizard

The first time you log onto the StorNext GUI, the Configuration Wizard 
appears. The wizard guides you step-by-step through the process of 
configuring StorNext.
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Note: Using the Configuration Wizard to configure StorNext is 
optional. All configuration tasks can be accessed at any time 
using the StorNext Setup menu.

The Configuration Wizard is shown in Figure 8.

Figure 8  StorNext 
Configuration Wizard: Storage 
Manager

The Configuration Wizard consists of multiple steps. The wizard lets you 
navigate between steps and tracks your progress as you complete each 
step.

• To go to the next step, click Next.

• To return to a previous step, click Back (or click the step in the list).

These are the steps you’ll complete in the Configuration Wizard:

• Welcome: View disks and libraries currently available for StorNext 
usage.

• Licenses: Enter StorNext License Information.

• System: Set up the networking configuration for StorNext 
Metadata Appliances (M660, M440 and M330). This step only 
appears on the Configuration Wizard of StorNext Metadata 
Appliances.
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• Name Servers: Specify and order the machines acting as StorNext 
name servers.

• File Systems: Add a StorNext file system.

• Storage Destinations: Add a library, storage disks, and other 
storage destinations.

• Storage Policies: Add a Storage Manager or replication storage 
policy.

• Email Server: Specify an email server to handle StorNext 
notifications.

• Email Notification: Add e-mail notification recipients.

• Done: Signify that you are finished using the Configuration Wizard. 
You can also convert to a high availability (HA) system.

To see more detailed instructions for completing Configuration Wizard 
tasks, refer to “Chapter 3: The Configuration Wizard” in the StorNext 
User’s Guide.

Linux Device Mapper Multipath Support

StorNext 4.7.x supports the Linux Device Mapper (DM) Multipath driver. 
This driver provides redundancy and improved I/O performance by 
taking advantage of multiple paths to storage. If you plan to use the 
Linux DM Multipath support with StorNext, be aware of the following:

• The StorNext File System does not currently support disks managed 
through the Linux Device Mapper tools other than those which are 
managed through multipathd. Disk paths showing up under the /
dev/mapper path that are not multipathd devices will not be usable 
by StorNext due to Device Mapper taking exclusive control of the 
disk devices. See the Linux dmsetup documentation for details.

Device Mapper will release exclusive control of a disk device if all of 
the Device Mapper partition entries are removed. Some customers 
have successfully used Device Mapper devices by using dmsetup to 
remove the partition entries for a particular device before 
attempting to mount StorNext File Systems. See the Linux dmsetup 
documentation for details.
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Note: Device Mapper control on specific devices may need to be 
removed after each reboot or after a device is first presented to 
a system.

• Not all RAIDs work with the DM Multipath Driver. Check with your 
storage vendor for compatibility.

• For detailed instructions on installing and configuring the DM 
Multipath Driver, refer to the Red Hat or SUSE documentation 
provided with your version of Linux.

• For StorNext to use Linux Device Mapper Multipath devices, you 
must make two changes to the /etc/multipath.conf file.

a Set user_friendly_names to yes.

b Add the following entry to the multipath.conf blacklist section 
to prevent multipathd from managing the SNFS volume 
devices:

In addition, the use of the alias attribute in a multipath subsection 
of the multipath.conf file is not currently supported for devices 
used by StorNext. Its use can lead to mount failures.

• Using the cvpaths file and udev rules configuration files is typically 
unnecessary with Linux Device-Mapper with StorNext.

• Current versions of the Linux DM Multipath driver assign a default 
value of 1000 for rr_min_io which is too high for most 
configurations having multiple active paths to storage. Using a 
smaller value such as 32 will typically result in significantly improved 
performance. Refer to the Red Hat or SUSE documentation provided 
with your version of Linux for details on how to apply this setting.

Note: Experimentation may be required to determine the optimal 
value.

• On SUSE Linux Systems: In order to use Linux Device Mapper 
Multipath with Stornext, /etc/multipath.conf must be used 
because SUSE Linux does not install a multipath.conf, and Novell 
recommends against using it. Although SUSE Linux does not install 
a multipath.conf file by default, an example file, located at:

devnode "cvfsctl*"
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can be copied to: 

• On Red Hat Linux Systems: Red Hat does install a 
multipath.conf file. By default, Red Hat multipath.conf file 
blacklists all multipath-capable targets. This means:

must be commented out.

Third-Party Multipath 
Support

If you are using a third-party multipath driver, you may need to use a 
cvpaths file. The cvpaths file directs StorNext to the multipath devices 
for the entire lun.

/usr/share/doc/packages/multipath-tools/ 
multipath.conf.synthetic

/etc/multipath.conf

blacklist { devnode "*"}
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By default, here are the devices StorNext uses:

• linux - /dev/sd*

• aix - /dev/rhdisk*

• solaris - /dev/rdsk*

For example, the EMC Powerpath driver creates devices named  
/dev/emcpower* on Linux. If you do not tell StorNext to use the  
/dev/emcpower* devices, it will instead use the /dev/sd* devices. So in 
this example a cvpaths file must be created to specify the following: 

Other third-party multipath devices may use other path names. If you 
run the cvlabel -l command, the output will show which devices are 
being used by StorNext.

For additional information on configuring the cvpaths file, refer to the 
cvpaths man page from the command line, or the cvpaths entry in the 
MAN Pages Reference Guide.

wildcard=/dev/emcpower*[^1-9]
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The RPM installation includes only StorNext File System (not StorNext 
Storage Manager) and does not include a GUI or components required 
to use the StorNext Replication feature. This chapter describes how to 
install and configure File System-only on Linux MDCs. It also describes 
how to configure an RPM high-availability (HA) system.

This chapter covers:

• File System Requirements

• Getting Ready to Install

• Installing StorNext File System-Only from RPMs

• Configuring StorNext RPM Servers Using the Command Line

• Configuring Licenses for RPM Installations

For further information not covered in this chapter, refer to the man 
pages that reside in the directory /usr/cvfs/man.

File System Requirements

To run StorNext File System, the machine onto which you are installing 
SNFS must meet all operating system, hardware, and LAN requirements.
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Operating System 
Requirements

The operating systems, kernel versions, and hardware platforms 
supported by StorNext File System are listed in the StorNext 
Compatibility Guide posted here (click the “Select a StorNext Version” 
menu to view the desired version of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the operating system and platform 
requirements outlined in the guide, and, if necessary, update to a 
supported release or kernel version before installing StorNext.

Hardware 
Requirements

RAM and hard disk space requirements to run the StorNext File System 
are listed in the StorNext Compatibility Guide posted here (click the 
“Select a StorNext Version” menu to view the desired version of the 
guide):

http://www.quantum.com/sndocs

Make sure the MDC meets the hardware requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

LAN Requirements StorNext LAN requirements are listed in the “StorNext MDC Network 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs

Make sure the MDC meets the network requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

Other Requirements Additional requirements that must be met for the StorNext system are 
listed in the “Additional StorNext MDC and StorNext Client 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs
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Make sure the system meets the additional requirements outlined in the 
guide, and, if necessary, update the system before installing StorNext.

Getting Ready to Install

Before installing StorNext File System, complete the following tasks to 
ensure successful installation:

• Make sure the Metadata Controller (MDC) meets all operating 
system and hardware requirements (see File System Requirements 
on page 33).

• Make sure all storage devices are correctly configured and are visible 
to the MDC (see Configuring Storage Devices on page 35).

• If using LUNs larger than 1 TB, decide on a label type and install any 
necessary operating system patches (see Planning for LUNs Larger 
than 1 TB on page 36).

• Install the kernel source code (see Installing the Linux Kernel Source 
Code on page 37).

Configuring Storage 
Devices

Before installing StorNext File System, make sure that all LUNs are visible 
to the MDC. (A LUN, or logical unit number, is a logical device that 
corresponds to one or more disks, drives, or storage devices.)

If there are any connection issues, resolve them before installing 
StorNext. For assistance in configuring storage devices, refer to the 
documentation that came with the storage device, or contact the 
manufacturer.

Note: LUNs that you plan to use in the same stripe group must be the 
same size. Consider this when configuring storage devices. (For 
more information about stripe groups, see the StorNext User’s 
Guide.)
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Caution: StorNext does not support the connection of multiple 
devices through fibre channel hubs. Multiple devices must 
be connected using fibre channel switches. 

Planning for LUNs 
Larger than 1 TB

StorNext supports LUNs greater than 1 TB in size if they are allowed by 
the operating system. To enable support for 1 TB or larger LUNs, all 
StorNext LUNs must be correctly labeled according to the requirements 
of the operating system running on the MDC as well as the operating 
system running on all connected clients. Disk LUNs can have one of 
three labels: VTOC, EFI, or sVTOC (short VTOC). Before installing 
StorNext, decide what label type will be used.

Required disk LUN label settings based on operating system and LUN 
size are presented in Table 5. Before installing StorNext, install any 
required operating system patches or updates (for both MDC and client) 
as indicated in the notes for Table 5. 

Note: After labeling a disk LUN, you must reboot systems running 
Solaris before they can access the disk LUN.

Table 5  Required Disk LUN 
Labels Operating 

System
Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs  
> 2 TB

Windowsa VTOC, EFI VTOC, EFI EFI, sVTOC

Linux 2.6 
Kernel

VTOC, EFI VTOC, EFI EFI, sVTOC

Solaris 10b VTOC, EFI EFI EFI

HP-UXc VTOC, EFI VTOC, EFI EFI, sVTOC

IBM AIXd VTOC, EFI VTOC, EFI EFI, sVTOC

SGI IRIXe VTOC VTOC Not supported
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Note: For best results, Quantum recommends using persistent 
binding for disk LUNs. For more information, contact the 
vendor of your HBA (host bus adapter).

Installing the Linux 
Kernel Source Code

For management servers running Red Hat Enterprise Linux version 5 or 
6, before installing SNFS you must first install the kernel header files 
(shipped as the kernel-devel or kernel-devel-smp RPM, depending on 
your Linux distribution).

For servers running SUSE Linux Enterprise Server, you must install the 
first kernel source code (shipped as the kernel-source RPM). StorNext 
will not operate correctly if these packages are not installed. You can 
install the kernel header files or kernel source RPMs by using the 
installation disks for your operating system.

Verifying Hostname 
Length

The maximum hostname length for a StorNext server is limited to 255 
characters. Before you begin the installation, verify that the destination 
hostname is not longer than 255 characters.

Apple Xsan 
2.1.1 (MacOS 
X 10.5 
Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC

Apple Xsan 2.2 
(MacOS X 10.6 
Snow Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC

a.For Windows XP 32-bit systems only, support for LUNs larger than 2 TB is 
limited to the first 2 TB. All other supported Windows platforms 
(including Windows XP 64-bit) support LUNs greater than 2 TB.

b.Support for 2 TB or larger LUNs requires Solaris 10 Update 2 (06/06).
c.Supports only the first 2 TB of LUNs larger than 2 TB.
d.Supports only LUNs of 2.2 TB or less.
e.IRIX is not supported starting with StorNext 4.0. However, StorNext 3.5 IRIX 

clients can be used with StorNext 4.7.x MDCs.

Operating 
System

Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs  
> 2 TB
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Ensuring You Have 
Enough Space to 
Extract the Installation   
Software

The installation software files are extracted into the /tmp/stornext 
directory by default. The software, when extracted, requires 
approximately 40 MB of space. Make sure there is enough free space in 
the default directory to extract the files. If there is not sufficient space, 
you may need to specify an alternative directory with the -d option.

To specify an alternate location before beginning the installation, enter 
the following command:

where <snfs_full.bin> is the name of the Linux RPM installation file, 
and <dir> is the directory into which you want to extract the 
installation files.

Installing StorNext File System-Only from RPMs

This section describes how to install StorNext 4.7.x  using an RPM-only 
installation. To perform the install, you will need to use the correct file 
on the StorNext installation DVD or download for your operating 
system.

1 Log on to the MDC as root. For DVD installations, continue to next 
step. For installations from downloaded files, change to the 
directory containing the .bin file and continue to Step 7. If you only 
have the rpm files, continue to Step 10.

2 Mount the StorNext installation DVD and change to the DVD root 
directory.

# ./<snfs_full.bin> -d <dir>
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Note: When you mount a DVD in a Red Hat 5 or 6 system, DVDs 
are mounted by default with a noexec (non-executable) 
option which prevents you from proceeding with the 
installation. 
 
For Red Hat users only, before proceeding you must 
remount the DVD by typing: 
 
 

3 List the installation directories on the DVD. At the command 
prompt, type:

4 Change to the fs_only directory.

Note: Make sure you are in the fs_only directory and not the 
stornext_full directory. The fs_only directory installs the 
StorNext File System only.

5 List the directories in the fs_only directory. At the command 
prompt, type:

6 Identify the correct .bin file for your operating system and hardware 
platform. 

For example, for Red Hat Linux 5 running on an x86 64-bit platform, 
the file you will use is snfs_full_RedHat50AS_26x86_64.bin.

7 Launch the install script. At the command prompt, type:

mount -o remount, exec ...

ls -l

ls -l

./<file>
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where <file> is the name of the .bin file for your installation.

The End User License Agreement (EULA) displays. 

8 Read the EULA. When finished you are asked if you accept.

9 Type y to accept the EULA and continue.

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 
Installation Software on page 38). 

Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 

 
where <snfs_full.bin> is the name of the Linux server 
installation .bin file, and <dir> is the directory into which 
you want to extract the installation files.

# ./<snfs_full.bin> -d <dir>
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Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 

 
where <snfs_full.bin> is the name of the Linux 
server .bin installation file, and <dir> is the directory 
into which you want to extract the installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

10 Change to the directory into which the files were extracted. The 
following command uses the default extract location for the files 
prompt, type:

11 Display a list of the installed files. At the prompt, type:

12 Install the .rpm files. At the prompt, type:

# ./<snfs_full.bin> -d <dir>

cd /tmp/stornext

ls -l

rpm -ivh snfs-client-SuSE100ES_261621-
4.3.12838.x86_64.rpm snfs-server-SuSE100ES-
4.3.12838.x86_64.rpm snfs-SuSE100ES-
4.3.12838.x86_64.rpm
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Note: The actual filenames may be different than those shown in 
this example. In the above commands, the build 
number 4.3.12838 may be different in your extracted files. 
Use the correct file name for your files.

The files are installed in this location: /usr/cvfs. 

Configuring StorNext RPM Servers Using the 
Command Line

This section describes how to set up a StorNext 4.7.x server in an 
RPM-only installation. This section covers:

• Editing the /etc/hosts file in HA Configurations

• Configuring a Single StorNext 4.x .RPM Server or the Primary Server 
in an HA Configuration

• Configuring the Secondary StorNext 4.x .RPM Server in an HA 
Configuration

Note: For RPM installations (specifically, when there is no “HA 
shared” file system), the ha manager program /usr/cvfs/
bin/snhamgr is not functional.

Editing the /etc/hosts 
file in HA 
Configurations

SUSE Linux distributions automatically associate the FQDN of the local 
machine with the address 127.0.0.2 in the /etc/hosts file. There is no 
benefit from doing this when the machine is connected to a network 
that can resolve its name to an IP address. However, the existence of this 
entry can sometimes cause a failure of configuration synchronization 
within and between the server computers in an HA configuration. For 
this reason, the 127.0.0.2 entry should be deleted from the /etc/hosts 
file.
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Configuring a Single 
StorNext 4.x .RPM 
Server or the Primary 
Server in an HA 
Configuration

The steps for setting up a single server or the primary server in an HA 
configuration are nearly identical. The HA configuration requires a few 
extra steps, which are noted in the procedure below. If you do not have 
an HA configuration, ignore the steps marked “HA Only.”

Run the following commands on the Primary node if installing an HA 
system:

1 Install RPMs using the procedure outlined in Installing StorNext File 
System-Only from RPMs on page 38.

2 Obtain and install licenses.

3 Populate the fsnameservers file with the IP addresses of the            
fsnameserver systems by running this command:

(For more information see the fsnameservers man page.)

Note: If you add the host name instead of the IP address, the 
conversion to HA could fail. Use only the IP address when 
populating the fsnameservers file. 

4 HA Only: Create the ha_peer file by running the command below. 
This file should contain the IP address of the Secondary in the HA 
pair.

(For more information, see the ha_peer man page.)

5 Start up the fsmpm by running this command:

6 Create the .cfgx file by running this command:

# vi /usr/cvfs/config/fsnameservers

# vi /usr/cvfs/config/ha_peer

# /etc/init.d/cvfs start

# /usr/cvfs/bin/sncfgedit -n snfs1
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(For more information, see the snfs.cfgx and sncfgedit man 
pages.)

After creating the file, do the following:

a Delete first two lines at top that start with ****

b HA Only: Change the haFsType entry to HaUnmanaged. That is, 
change this:

to this:

c Fix the <diskTypes> and <stripeGroups> sections at the 
bottom. 

7 Make the file system by running this command:

8 Create the mount point by running this command:

9 Edit the file /usr/cvfs/config/fsmlist and add your file system 
name(s) that the file system services will start. To do this:

a Open the file by running this command:

b Add the name of your file system to launch:

<haFsType>HaUnmonitored</haFsType>

<haFsType>HaUnmanaged</haFsType>

# /usr/cvfs/bin/cvmkfs snfs1

# mkdir /stornext/snfs1

# vi /usr/cvfs/config/fsmlist

snfs1
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10 Configure the file system to automatically mount after reboot by 
doing the following:

a Edit the /etc/fstab file by running this command:

b Add the file system name and mount options to the end of the 
list:

Note: There are six fields in the fstab file. Spaces are used 
between the entries to delineate one field from the 
other. The fields are: 
First field: Name of the file system to be mounted. 
Second field: Mount point for the file system. 
Third field: Type of file system. 
Fourth field: Mount options. 
Fifth field: Flag that tells Linux if this file system need to 
be dumped. 
Sixth field: Determines the order in which file system 
checks are done.

11 Start and mount the file system by running this command:

Configuring the 
Secondary StorNext 4.x 
.RPM Server in an HA 
Configuration

Perform this procedure only if you have an HA configuration. Run the 
following commands on the Secondary node:

1 Install RPMs using the procedure outlined in Installing StorNext File 
System-Only from RPMs on page 38.

# vi /etc/fstab

snfs1 /stornext/snfs1 cvfs rw 0 0

# /usr/cvfs/bin/cvadmin -e 'start snfs1'

# mount /stornext/snfs1
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2 Create the fsnameservers file that contains the IP address of the 
system acting as the name servers by doing the following:

a Open the file by running this command:

b Add the IP address of the name servers.

Note: The fsnameservers file on the secondary must be the 
same as the fsnameservers file on the primary.  
 
Remember, if you add the host name instead of the IP 
address, the conversion to HA could fail. Use only the 
IP address when populating the fsnameservers file. 

3 Create the ha_peer file and add the IP address of the Primary in 
the HA pair by doing the following:

a Open the file by running this command:

b Add the IP address of the Primary:

for example:  192.168.0.2

4 Start up the fsmpm by running this command:

5 Copy the .cfgx file from the Primary to the /usr/cvfs/config 
directory on the Secondary. 

6 Edit the file /usr/cvfs/config/fsmlist and add your file 
system name(s) that the file system services will start by doing the 
following:

a Run this command:

# vi /usr/cvfs/config/fsnameservers

# vi /usr/cvfs/config/ha_peer

# /etc/init.d/cvfs start

# vi /usr/cvfs/config/fsmlist
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b Add the name of your file system to launch:

7 Configure the file system to automatically mount after reboot by 
doing the following:

a Edit the /etc/fstab file by running this command:

b Add the file system name and mount options to the end of the 
list:

8 Start and mount the file system by running this command:

Obtaining Licenses for RPM Installations

Obtaining Licenses If you need to receive license keys to enable StorNext or StorNext 
features, fill out the Quantum licensing Web page form. The following is 
required:

1 StorNext system serial number

In a new installation, the serial number will be found on a sticker on 
the box or envelope your original software came in. If you 

snfs1

# vi /etc/fstab

snfs1 /stornext/snfs1 cvfs rw 0 0

# /usr/cvfs/bin/cvadmin -e 'start snfs1'

# mount /stornext/snfs1
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downloaded StorNext, the serial number is in the Download Media 
Kit. If you own a StorNext Appliance, the serial number will also be 
printed physically on the appliance.

Serial numbers look like the following, where n is a digit, and x is 
any character:

SNnnnnn for StorNext software

FXWNnnnnnn, FXUXnnnnnn or FXLXnnnnnn for StorNext FX

CXxxxxxxxxxxxx for StorNext appliances

If you are adding to an existing StorNext installation and cannot 
locate the original software package, locate the license.dat file. The 
license.dat file can be found on the MetaData Controller, at /usr/
cvfs/config/license.dat for UNIX systems, and c:\Program 
Files\StorNext\config\license.dat for Windows systems.

Open the license.dat file. The serial number will be on a line similar 
to:

# Serial Number: SNnnnnnn

2 Existing software features licensed: You will need to have a list of 
StorNext features already licensed and enabled on your system.

3 New software features licensed: You will need to have a list of 
purchased StorNext add-on features for which you wish to enable 
licenses.

Note: You can determine the current license limits on SAN client, LAN 
client, DDM, and Storage Manager licenses in the StorNext GUI 
on the Configuration > License screen.

To to receive license keys for your StorNext license(s), enter the required 
information about your system on this Web page:

http://www.quantum.com/ServiceandSupport/License/StorNext/
Index.aspx

Note: If you cannot access the web page or need additional help 
filling out the form, contact Quantum support (see Quantum 
Technical Assistance Center on page 415)
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Configuring Licenses for RPM Installations

For File System installations, or in instances where there is no available 
StorNext GUI, StorNext license keys for the system can be installed 
manually. This section describes how to install licenses from the 
command line in those situations. 

Licenses for purchased StorNext components (such as File System) and 
features are listed in the StorNext Licensing Guide which can be found 
here (click the “Select a StorNext Version” menu to view the documents 
for the desired version of StorNext):

http://www.quantum.com/sndocs

Note: Licenses must be installed “by hand” on RPM-only installations 
because there is no GUI to lead you through the steps.

Obtaining Licenses 1 Obtain licenses for all purchased StorNext components and features 
from Quantum according to the previous section. You will receive an 
e-mail with a license.dat file containing license keys for the desired 
components.

2 Copy the new license.dat file to a temporary location.

3 Install StorNext (see Installing StorNext File System-Only from RPMs 
on page 38).

4 If the /usr/cvfs/config/license.dat file exists on the MDC, make a 
backup copy.

Installation Steps Depending on the configuration of the system you are updating, you 
will use a different set of installation steps to install the license keys for 
StorNext and components for RPM installations from the command line. 
Here are the possible installation scenarios:

• Installing StorNext License Keys on a Single-Node MDC

• Installing StorNext License Keys on HA Systems (with a Shared File 
System)
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• Installing StorNext License Keys on a Failover System (without a 
Shared File System) on page 51

Installing StorNext License Keys on a Single-Node MDC

1 From the command line of the MDC, type the following command:

2 Navigate to the temporary location where you stored the new 
license.dat file.

3 Copy the license.dat file to the /usr/cvfs/config/ directory on the 
MDC.

4 Type the following command on the MDC:

Installing StorNext License Keys on HA Systems (with a Shared File 
System)

Note: Stop the StorNext service on the secondary node of the HA 
system before stopping the StorNext service on the primary 
node.

1 From the command line of the secondary node of an HA MDC (both 
File System and Storage Manager), type:

2 From the command line of the primary node of an HA MDC, type:

3 Navigate to the temporary location where you stored the new 
license.dat file.

4 Copy the license.dat file to the /usr/cvfs/config/ directory on the 
primary node of the MDC.

service cvfs stop

service cvfs start

service cvfs stop

service cvfs stop
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Note: Start the StorNext service on the primary node of the HA 
system before starting the StorNext service on the secondary 
node.

5 From the command line of the primary node of an HA MDC, type:

6 From the command line of the secondary node of an HA MDC, 
type:

Note: Wait up to 2 minutes for the license.dat file to propagate to 
the secondary node of the MDC. After 2 minutes, verify the 
license has been propagated on the secondary node.

Installing StorNext License Keys on a Failover System (without a 
Shared File System)

Note: Stop the StorNext service on the secondary node of the HA 
system before stopping the StorNext service on the primary 
node.

1 From the command line of the secondary node of an HA MDC (both 
File System and Storage Manager), type:

2 From the command line of the primary node of an HA MDC, type:

3 Navigate to the temporary location where you stored the new 
license.dat file.

service cvfs start

service cvfs start

service cvfs stop

service cvfs stop
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4 Copy the license.dat file to the /usr/cvfs/config/ directory on the 
primary node of the MDC.

5 Copy the license.dat file to the /usr/cvfs/config/ directory on the 
secondary node of the MDC.

Note: Start the StorNext service on the primary node of the HA 
system before starting the StorNext service on the secondary 
node.

6 From the command line of the primary node of an HA MDC, type:

7 From the command line of the secondary node of an HA MDC, 
type:

service cvfs start

service cvfs start
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Windows SNFS Server 

Installation/Configuration 

This chapter describes how to install and configure StorNext File System 
(SNFS) on a Windows Metadata Controller (MDC). Since Windows 
systems do not support StorNext Storage Manager, the Windows 
installation does not include installing the StorNext Storage Manager. 

Once StorNext File System is installed, you can configure it using the 
Windows-based configuration utilities to set up server and client 
features. To configure StorNext, you enter license information and 
create one or more file systems. 

This chapter covers: 

• File System Requirements

• Getting Ready to Install

• Installing StorNext File System on Windows MDCs

• Configuring StorNext File System on Windows

• Configuring a High Availability System on Windows

• Installing Promise RAID Controller Software on Windows

• Adding or Removing StorNext Components

• Restoring a Previous Client Configuration

• Upgrading or Reinstalling StorNext on a Server
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File System Requirements

To run StorNext File System, the machine onto which you are installing 
SNFS must meet all operating system, hardware, and LAN requirements

Operating System 
Requirements

The operating systems, kernel versions, and hardware platforms 
supported by StorNext File System are listed in the StorNext 
Compatibility Guide posted here (click the “Select a StorNext Version” 
menu to view the desired version of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the operating system and platform 
requirements outlined in the guide, and, if necessary, update to a 
supported release or kernel version before installing StorNext.

Hardware 
Requirements

RAM and hard disk space requirements to run the StorNext File System 
are listed in the StorNext Compatibility Guide posted here (click the 
“Select a StorNext Version” menu to view the desired version of the 
guide):

http://www.quantum.com/sndocs

Make sure the MDC meets the hardware requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

Windows Server 2012 
SAN Disk Requirements

Windows disks on a Storage Area Network that will be used for 
StorNext, must be initialized before a StorNext volume label be written 
to the device. This involves writing a master boot record (MBR) to the 
disk according to the following:

http://technet.microsoft.com/en-us/library/cc782513(v=ws.10).aspx

This only needs to be done the first time new devices are connected to 
Windows.
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LAN Requirements StorNext LAN requirements are listed in the “StorNext MDC Network 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs

Make sure the MDC meets the network requirements outlined in the 
guide, and, if necessary, update the MDC before installing StorNext.

Other Requirements Additional requirements that must be met for the StorNext system are 
listed in the “Additional StorNext MDC and StorNext Client 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the additional requirements outlined in the 
guide, and, if necessary, update the system before installing StorNext.

Getting Ready to Install

Before installing StorNext File System, complete the following tasks to 
ensure successful installation:

• Make sure the Metadata Controller (MDC) meets all operating 
system and hardware requirements (see File System Requirements 
on page 54).

• Make sure you understand changes in licensing procedures (see If 
using LUNs larger than 1 TB, decide on a label type and install any 
necessary operating system patches (see Planning for LUNs Larger 
than 1 TB on page 56). on page 56).

• Make sure all storage devices are correctly configured and are visible 
to the MDC (see Configuring Storage Devices on page 56).

• If using LUNs larger than 1 TB, decide on a label type and install any 
necessary operating system patches (see Planning for LUNs Larger 
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than 1 TB on page 56).

Configuring Storage 
Devices

Before installing StorNext File System, make sure that all LUNs are visible 
to the MDC. (A LUN, or logical unit number, is a logical device that 
corresponds to one or more disks, drives, or storage devices.)

If there are any connection issues, resolve them before installing 
StorNext. For assistance in configuring storage devices, refer to the 
documentation that came with the storage device, or contact the 
manufacturer.

Note: LUNs that you plan to use in the same stripe group must be the 
same size. Consider this when configuring storage devices. (For 
more information about stripe groups, see the StorNext User’s 
Guide.)

Caution: StorNext does not support the connection of multiple 
devices through fibre channel hubs. Multiple devices must 
be connected using fibre channel switches.

Planning for LUNs 
Larger than 1 TB

StorNext supports LUNs greater than 1 TB in size if they are allowed by 
the operating system. To enable support for 1 TB or larger LUNs, all 
StorNext LUNs must be correctly labeled according to the requirements 
of the operating system running on the MDC as well as the operating 
system running on all connected clients. Disk LUNs can have one of 
three labels: VTOC, EFI, or sVTOC (short VTOC). Before installing 
StorNext, decide what label type will be used.

Required disk LUN label settings based on operating system and LUN 
size are presented in Table 6. Before installing StorNext, install any 
required operating system patches or updates (for both MDC and client) 
as indicated in the notes for Table 6. 

Table 6  Required Disk LUN 
Labels Operating 

System
Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs  
> 2 TB

Windowsa VTOC, EFI VTOC, EFI EFI, sVTOC
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Note: For best results, Quantum recommends using persistent 
binding for disk LUNs. For more information, contact the 
vendor of your HBA (host bus adapter).

Linux 2.6 
Kernel

VTOC, EFI VTOC, EFI EFI, sVTOC

Solaris 10b VTOC, EFI EFI EFI

HP-UXc VTOC, EFI VTOC, EFI EFI, sVTOC

IBM AIXd VTOC, EFI VTOC, EFI EFI, sVTOC

SGI IRIXe VTOC VTOC Not supported

Apple Xsan 
2.1.1 (MacOS 
X 10.5 
Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC

Apple Xsan 2.2 
(MacOS X 10.6 
Snow Leopard)

VTOC, EFI VTOC, EFI EFI, sVTOC

a. For Windows XP 32-bit systems only, support for LUNs larger than 2 TB is 
limited to the first 2 TB. All other supported Windows platforms 
(including Windows XP 64-bit) support LUNs greater than 2 TB.

b. Support for 2 TB or larger LUNs requires Solaris 10 Update 2 (06/06).
c. Supports only the first 2 TB of LUNs larger than 2 TB.
d. Supports only LUNs of 2.2 TB or less.
e. IRIX is not supported starting with StorNext 4.0. However, StorNext 3.5 

IRIX clients can be used with StorNext 4.7.x MDCs.

Operating 
System

Label for LUNs 
< 1 TB

Label for LUNs 
1–2 TB

Label for LUNs  
> 2 TB
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Installing StorNext File System on Windows MDCs

The StorNext setup wizard guides you through the process of installing 
the StorNext File System on Windows machines.

When you are ready, use the setup wizard to install StorNext (see 
Installing StorNext File System on page 58). 

If you did not install all StorNext components when you initially installed 
StorNext or wish to remove them later, you can add or remove 
components at any time (see Adding or Removing StorNext 
Components on page 121). 

(Optional) After installation, restore the previous client configuration 
(see Restoring a Previous Client Configuration on page 124). This is only 
necessary if you have performed a complete removal of StorNext. The 
StorNext client configurations are fully maintained on upgrades from 
version 3.0 and later.

As new versions of StorNext are released, you can upgrade to a new 
version or reinstall (see Upgrading or Reinstalling StorNext on a Server 
on page 124).

Note: You must log on as an Administrator to install StorNext.  
 
If you are installing on Windows Vista, answer Yes to any 
messages asking if you want to run the installation process 
with administrative privileges.

Installing StorNext File 
System

1 Copy the file named /fs_only/snfs_full_Windows_x86_64.zip from 
the installation DVD and place it on the system onto which you 
want to install it. For the SNFS-only installation, be sure to select the 
file from the fs_only directory and not the stornext_full directory. 

2 Unzip the file.

3 Double-click the file named SnfsSetup64.exe to launch the installer.

The StorNext Installation window appears (Figure 9).
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Note: For existing installations, do not use this procedure. Refer to 
the StorNext Upgrade guide for upgrading existing StorNext 

Figure 9  StorNext Installation 
Window: Install StorNext

4 Click Install StorNext to begin installation.

The StorNext File System License Agreement window appears 
(Figure 10).
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Figure 10  SNFS Setup: End-
User License Agreement 

5 Read the license. If you agree to the terms, select “I accept the terms 
in the License Agreement” and click Next to continue the install.

The StorNext setup wizard launches (Figure 11). 
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Figure 11  SNFS Setup: 
Welcome 

6 Click Next to continue.

The Customer Information window appears (Figure 12). 

Figure 12  SNFS Setup: 
Customer Information 

7 Type your name and the name of your company or organization in 
the boxes, and then click Next to continue.

The Choose Setup Type window appears, (Figure 13).
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Figure 13  SNFS Setup: Choose 
Setup Type 

8 Click one of the following installation options (to install StorNext 
File System you would click Custom or Complete):

• Client Only: Installs only the StorNext client software and help 
files in the default location (C:\Program Files\StorNext).

• Custom: Lets you choose which components to install and 
specify an installation location. When ready, click Next.

• Complete: All installable components will be installed in the 
default location (C:\Program Files\StorNext). If the system is 
capable of running the StorNext server, the StorNext server will 
also be installed.

The Ready to Install window appears (Figure 14).
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Figure 14  SNFS Setup: Ready 
to Install 

9 Click Install to continue.

Wait while the setup wizard installs StorNext. When installation is 
complete, the Finish window appears (Figure 15). (It make take 
several minutes for the installation to finish.)

Figure 15  SNFS Setup: Finish 
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10 Click Finish to close the setup wizard.

A dialog box opens letting you know that 30-day temporary licenses 
are installed and that you should install permanent licenses now 
(see Figure 16). If you choose not to install them now, you can 
install them later using the Windows Start button (Start > Licenses 
or Start > All Programs > StorNext  Licenses) or by following the 
instructions in Adding or Removing StorNext Components on 
page 121. 

Figure 16  Temporary Licenses 
Dialog Box

11 Click Yes to install permanent licenses now, or click No to install 
licenses later. If you choose to install now, complete the license 
installation screens that follow (for details, see Obtaining and 
Installing a Permanent License on page 70). 

The StorNext Installation screen displays again with choices to 
Add/Remove Components, Remove StorNext, or Configure StorNext 
(Figure 17).
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Figure 17  Client Setup: Add/
Remove Components

12 The installation is complete. Click one of the following options:

• Add/Remove Components: The components you selected 
during the install are already added, but if you changed your 
mind and want to select different components, you can do so 
now. See Adding or Removing StorNext Components on 
page 121 for details.

• Remove StorNext: Removes StorNext file system. For more 
information, see Removing StorNext Using the StorNext 
Software on page 184.

• Configure StorNext: Configures StorNext. For more 
information, see Configuring StorNext File System on Windows 
on page 65.

• Exit: Exits without making any further changes at this time (you 
can always perform configuration later).

Configuring StorNext File System on Windows

To configure StorNext File System or the StorNext client on Windows 
operating systems, use the Windows configuration utilities. The 
configuration utilities let you set up a Windows-based Metadata 
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Controller, configure a StorNext client, and work with StorNext file 
systems.

This section contains the required steps to configure StorNext, and also 
provides a description of all the other configuration utilities that 
StorNext provides. 

Once you have installed StorNext, follow these steps to configure 
StorNext. These steps are all covered in this section. 

1 Obtaining and Installing a Permanent License on page 70

2 Configuring Name Servers on page 73)

3 Labeling Disk Drives on page 74

4 Configuring a Server (Simple) on page 77 or  
Configuring a Server (Advanced) on page 80

5 Configuring the Client on page 90

This section covers the above configuration utilities plus all of the 
additional Windows configuration utilities. See:

• Available Configuration Utilities on page 66

• Accessing the Configuration Utilities on page 68 

Available Configuration 
Utilities

The following configuration utilities are accessible from the Windows 
Start menu (Start > All Programs > StorNext File System).

For more information on using these utilities, see the online help 
accessible from Start > All Programs > StorNext File System > 
StorNext Help.

• Configuring the Client on page 90: Use this utility to view and 
modify properties for the StorNext client software.

• Labeling Disk Drives on page 74: Formats hard disks so they can be 
used by StorNext.

• Configuring a Server (Advanced) on page 80: Allows you to 
configure StorNext file systems. This tool provides access to 
advanced features of StorNext File Systems. It is assumed that you 
are familiar with individual features available in the File System Cfg 
File (.cfg).

• Configuring a Server (Simple) on page 77: Allows you to quickly 
create and start a file system with a very basic configuration. The 
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tool limits you to a single stripe configuration and has very limited 
tuning options.

• Configuring the File System Startup List on page 107: Allows you to 
check StorNext file system health status while the file system is 
active. You can note changes but not commit them in read-only 
mode. You can also list all of the existing files and their pertinent 
statistics, such as inode number, size, file type and location in the 
file system. 

• Repairing a File System on page 109: Allows you to check file 
system health and repair metadata corruption. You can also list all 
of the existing files and their pertinent statistics, such as inode 
number, size, file type and location in the file system. 

• Re-initializing a File System on page 109: Allows you to re-initialize 
an existing file system or initialize a file system for the first time.

Caution: Use extreme caution when using this tool. This will 
destroy all data on the selected file system.

• Configuring the File System Startup List on page 107: Allows you to 
define which File System Manager (FSM) daemons to start.

• Retrieving the Host License Identifier on page 70: Use this utility to 
display the host license identifier. The host license identifier is 
required to obtain a permanent license for StorNext.

• Obtaining and Installing a Permanent License on page 70: Allows 
you to import StorNext licenses.

• Editing Drive Mapping on page 94: Specifies the name server(s) 
used by StorNext File System services.

• Server Administration on page 110: Allows you to look at the 
current status of file systems and to start, stop and perform basic 
file system administration tasks (similar to the cvadmin CLI). 

• Starting File System Services on page 106: Use this utility to start all 
StorNext services on an MDC or StorNext client.

• Obtaining Version Information on page 107: Use this utility to stop 
all StorNext services on an MDC or StorNext client. 

• Stopping and Removing File System Services on page 107: Use this 
utility to stop all StorNext services on an MDC or StorNext client, 
and also remove registry entries that automatically start the services 
on bootup.
StorNext and StorNext FX 4.7.x Installation Guide 67



Chapter 3: Windows SNFS Server Installation/Configuration
Configuring StorNext File System on Windows
• StorNext Help: View StorNext help for these utilities and other 
commands.

• Obtaining Version Information on page 107: View information 
about the currently installed version of the StorNext server and/or 
client software, such as the version number, build number, and 
platform.

Accessing the 
Configuration Utilities

There are two ways to access the configuration utilities:

• Using the StorNext Configuration Window

• Using the Windows Start Menu

Using the StorNext Configuration Window

As soon as you finish installing StorNext, the StorNext Installation 
window remains open (see Figure 17 on page 65). If you wish to begin 
configuring immediately, click the Configure StorNext button to open 
the StorNext Configuration window (Figure 18). 

You can return to the StorNext Configuration window at any time by 
double-clicking the file named SnfsSetup32.exe (32-bit systems) or 
SnfsSetup64.exe (64-bit systems) and then clicking the Configure 
StorNext button.
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Figure 18  StorNext 
Configuration

The StorNext Configuration window provides buttons to access several 
of the most common configuration utilities:

• Name Servers — See Editing Drive Mapping on page 94.

• Label Disk Drives — (Not available for client-only configurations.) 
See Labeling Disk Drives on page 74.

• Simple Server Configuration — (Not available for client-only 
configurations.) See Configuring a Server (Simple) on page 77.

• Import/Export Client Settings — See Restoring a Previous StorNext 
or StorNext FX Client Configuration on page 161.

• Client Configuration — See Configuring the Client on page 90.

Using the Windows Start Menu

You can access all of the configuration utilities, along with several 
others, from the Windows Start menu.

To run a configuration utility from the Windows Start menu, click Start 
> All Programs > StorNext File System, and then click the utility. 
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Retrieving the Host 
License Identifier

Use the License Identifier utility to display the host license identifier. The 
host license identifier is required to obtain a permanent license for 
StorNext.

To run the License Identifier utility, on the Windows Start menu, click All 
Programs > StorNext File System > License Identifier. A dialog box 
displays the host license identifier. Record this information.

Obtaining and 
Installing a Permanent 
License

To obtain StorNext component and feature licenses, see the “Obtaining 
Licenses” section in the StorNext Licensing Guide. After following those 
steps, you will receive a license.dat file from Quantum.

To install the license:

1 Copy the file to the C:\Program Files\StorNext\config directory. (If 
there is a temporary license file, rename the file or move it to a 
backup location.)

Note: To prevent accidentally losing a valid license, be sure to 
back up or rename any existing license.dat files. 

2 Install StorNext File System (see Installing StorNext File System on 
Windows MDCs on page 58). Licenses can be installed as part of the 
installation process or later if desired. 

3 If installing licenses after the initial install, click Start > All 
Programs > StorNext File System > Licenses. 

The StorNext License screen displays (see Figure 19). 
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Figure 19  License Import 
Screen

4 Click Import License File.

The License Import File window opens (see Figure 20).
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Figure 20  License Import File 
Window

5 Browse to the license file location and click Open.

The licenses are installed and a confirmation dialog box displays. 

6 Click OK.

The StorNext License screen displays again.

7 Close the window by clicking the X in the upper right corner.

The Installation Complete dialog box displays (see Figure 21).

Figure 21  Installation 
Complete

8 Click OK in the Installation Complete dialog box.

9 Reboot the system if instructed to do so.
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Configuring Name 
Servers

The purpose of a File System Name Server is to track the IP addresses of 
StorNext component servers, such as file system servers and gateways. 
StorNext SAN clients and LAN clients query name servers to locate 
appropriate services. The name server is a critical component for 
handing failover.

Every computer running StorNext components must have an 
fsnameservers file. The default location is: 
Program Files\StorNext\config\fsnameservers 

At least one, but preferably two of the systems that have StorNext 
Server installed must be designated as a StorNext Name Server. The 
Name Server and Metadata Controller (MDC) can be the same machine.

Note: The Name Servers configuration (including the ordering) must 
be identical on every computer running StorNext.

StorNext name servers can be added as either IP addresses or computer 
names, but when possible you should use IP addresses to avoid 
ambiguity.

Follow these steps to add a name server:

1 Access the name servers utility from the Windows Start menu (Start 
> All Programs > StorNext File System > Name Servers). 

Note: You may also access the name servers utility from the 
StorNext configuration window (see Using the StorNext 
Configuration Window on page 68). 

The StorNext Name Servers window appears (Figure 22).
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Figure 22  StorNext Name 
Servers Window

2 Enter the IP address, and then click Add. The IP address will be 
added to the list on the left side of the window.

3 If desired, manipulate the order by selecting a name server and then 
clicking Move Up or Move Down. Name servers will be used in the 
order specified.

Note: The Name Servers configuration (including the ordering) 
must be identical on all computers running StorNext.

4 To remove a name server, click the name server you want to remove 
and then click Remove. Confirm the deletion when prompted.

5 When you are finished adding name servers, click OK.

Labeling Disk Drives (Not available for client-only configurations.) The Disk Labeler lets you 
configure StorNext File System storage area network (SAN) disks. Each 
disk that is to be used in the file system must have a StorNext File 
System Label. The Disk Device Label Tool formats the disk so it can be 
used by StorNext. Use the Disk Device Labeler to create a list of disk 
labels, associated device names, and (optional) the sectors to use.
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Run the Disk Device Labeler on a system that has visibility to all disk 
devices on the SAN.

Caution: Use extreme caution when labeling your storage area 
network disk devices. Inadvertently labeling a Windows 
system disk will cause irreparable harm to your system and/
or loss of data! Only label disk devices that are intended for 
use with the StorNext File System SAN. 

The file system uses the volume labels to determine which disk drives to 
use. The label name written to a disk device must match the disk name 
specified in the Server Configuration utility (see Configuring a Server 
(Simple) on page 77 or Configuring a Server (Advanced) on page 80).

Follow these steps to label disks:

1 Access the disk labeler from the Windows Start menu (Start > All 
Programs > StorNext File System > Disk Labeler). 

Note: You may also access the disk labeler from the StorNext 
configuration window (see Using the StorNext 
Configuration Window on page 68). 

The StorNext File System Disk Labeler window appears 
(Figure 23). All disk devices are scanned for labels, and those devices 
with labels are displayed.

Note: The label type “NotVerified” is used for disks that are 
unusable or represent a secondary (passive) path to a disk 
that appears elsewhere in the list. The label type 
“TooLarge” is used for disks that have valid StorNext labels, 
but are not usable on this system without re-labeling, 
because the system SCSI driver cannot access disk blocks 
beyond block number 4294967295.
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Figure 23  File System Disk 
Labeler

2 Do one of the following:

• Click Label to write a volume label to the selected device(s) (see 
Labeling Disks below).

• Click UnLabel to remove the existing volume label from the 
selected device(s).

• Click Exit to quit the Disk Device Labeler utility.

• Click Probe Disk(s) to pulse the activity light of the selected 
device(s). Use this feature to correctly identify disks before 
labeling them.

• Click Clear Selections to deselect all devices in the list.

Labeling Disks

Follow these steps to label a disk:

1 Select the disks you wish to label. (If desired, verify that the disks 
selected are the correct ones by pressing the Probe Disk(s) button. 
The activity light on selected disks will pulse, allowing visual 
verification that the correct disk drives are selected. This procedure 
will continue until you click the Stop button.)

2 After you have verified that the correct disk devices are selected, 
press the Label button. 
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A confirmation screen appears asking if you are sure you want to 
proceed. 

3 Click OK to continue. 

4 A properties screen (Figure 24) for each disk appears, one at a time. 
This screen allows you to name the disk and assign the configured 
number of sectors to use on the disk.

Figure 24  Disk Labeler 
Properties

5 Enter the following fields:

• New Disk Label: The label you want to give the disk.

• New Sectors: The number in 512-byte sectors you will use in 
the DiskType configuration during file system configuration.

Normally you will use the default number of new sectors provided 
by the tool. However, some disks must be configured smaller than 
their actual size. For example, MPIRE video disks must be under-
configured to eliminate using the last zone of the disk.

6 Press the Create Label button to commit the label to the disk 
device. If more than one disk was selected, a properties screen for 
the next device will appear until all of the selected devices are 
completed. (Pressing Skip Disk allows you to not write a label to the 
disk and instead proceed to the next selected disk.)

Configuring a Server 
(Simple)

(Not available for client-only configurations.) The simple configuration 
tool can be used to configure a very simple, single stripe group file 
system. Only the list of disks and a few key parameters must be 
specified.
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The Simple Configuration tool does the following:

• Creates a configuration (.cfg) file

• Creates a file system (cvmkfs.exe)

• Adds the file system to the fsmlist file

• Stops the File Systems (rmsvc.exe)

• Starts the File Systems (instsvc.exe)

The Simple Configuration tool can be run only on the server where the 
File System Services are running.

Note: Before you configure the file system, you should first label disks 
as described in Labeling Disk Drives on page 74.

Follow these steps to configure a simple file system:

1 Access the simple server configuration utility from the Windows 
Start menu (Start > All Programs > StorNext File System > File 
System Cfg (Easy)). 

Note: You may also access the simple server configuration utility 
from the StorNext configuration window (see Using the 
StorNext Configuration Window on page 68). 

The StorNext File System Simple Server Configuration Setup 
window appears (Figure 25). The tool scans for any StorNext- 
labeled disk devices in the storage area network.
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Figure 25  Simple File System 
Configuration

2 Select the StorNext disks you wish to use in the configuration.

3 At the File System Name field, specify the name of the file system. 
The name is used to identify the new file system. For example, this 
name is used by the StorNext client to identify which file system to 
mount.

4 At the File System Block Size field, choose a file system block size. 
This is the minimum allocation size the file system will use.

5 At the Stripe Size in Blocks field, choose the Stripe Size. This is the 
number of blocks the file system will use before selecting the next 
disk drive in a stripe group. The stripes are selected in a round robin 
fashion. Therefore, for a 16-block stripe size, the first disk would 
contain the first 16 blocks, the second disk would contain the next 
16 blocks, and so on. When all the disks have been written, the file 
system wraps around the first drive again.

6 At the Maximum Connections field, choose the maximum 
connections that can occur to the file system. In other words, 
choose how many clients can have the file system mounted at the 
same time. This value may be overridden by values in your product 
license code.

Note: Many configuration options (such as Blocksize) cannot be 
changed once the file system has been created.

7 Click the Configure button. This will write the configuration file out 
to the configuration directory.
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8 When a DOS box appears asking if you want to proceed, type Y to 
confirm. The file system is created.

Configuring a Server 
(Advanced)

(Not available for client-only configurations.) The Advanced Server 
Configuration utility lets you view and modify properties for an MDC. 
Use this utility to create a new server configuration or modify an 
existing configuration. This tool provides access to advanced features of 
StorNext File Systems. It is assumed that you are familiar with individual 
features available in the File System Cfg File (.cfg). 

1 Access the advanced server configuration utility from the Windows 
Start menu (Start > All Programs > StorNext File System > File 
System Cfg (Advanced)). 

The File System Configuration window displays (Figure 26).

Figure 26  Configuration 
Administrator

2 Do one of the following:

• Click the Create New Configuration button to create a new 
configuration file.

• Select an existing file and click the Open Existing 
Configuration button to edit an existing configuration file. 
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The Properties window displays (see Figure 27 on page 82). This 
window includes four tabs:

• Global Settings on page 81

• Disk Types on page 84

• Disk Definitions on page 86

• Stripe Groups on page 88

3 Click a tab to view or modify StorNext File System properties. After 
making changes on one or more tabs, click OK to save the changes. 
Specify a name and a location for the *.cfg file, and then click Save.

Note: Before configuring a file system, you should label disk 
devices. For more information, see Labeling Disk Drives on 
page 74.

Global Settings

Use the Global Settings tab (Figure 27) to specify general file system 
properties. Table 7 describes the fields on the Global Settings tab.
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Figure 27  Properties: Global 
Settings

Table 7  Server Configuration: 
Global Settings Field / Button Description

Global Superuser (Optional) Select to allow a user with 
superuser privileges to have global access 
rights on the file system.

Windows Security (Optional) Select to use Windows Security 
Reference Monitor (ACLs) on Windows 
clients.

Quotas (Optional) Select to enforce file system 
quotas and track storage usage for individual 
users and groups.

Cluster File Locking (Optional) Select to send a warning when a 
user attempts to access a file that is locked or 
already in use.
82 StorNext and StorNext FX 4.7.x Installation Guide 



Chapter 3: Windows SNFS Server Installation/Configuration
Configuring StorNext File System on Windows
ABM Free Limit (Optional) Instructs the FSM how to process 
the allocation bitmap. The default value 
(deselected) tells the software to use a newer 
method for handling allocation bit map 
entries. If you select the check box, the 
method reverts to the older method, causing 
cvupdatefs to fail when a bitmap 
fragmentation threshold is exceeded. When 
that limit is exceeded, FSM memory usage 
and startup time may be excessive under the 
old method.

File Size Dynamic 
Expansion - 
Minimum*

(Deprecated) Type the minimum number (in 
blocks) to allocate when a file is created.

File Size Dynamic 
Expansion - 
Increment*

(Deprecated) Type the initial increment (in 
blocks) by which a file is expanded.

File Size Dynamic 
Expansion - 
Maximum*

(Deprecated) Type the maximum increment 
(in blocks) by which a file is expanded.

File System Block 
Size

Select the file system block size (in bytes).

Buffer Cache Size Type the amount of memory (in MB) used for 
general metadata information caching.

Journal Log Size Type the maximum size (in MB) for the 
journal log.

Inode Cache Size Type the number of entries in the inode 
cache.

Maximum Debug 
Log Size

Type the maximum size (in MB) for the debug 
log.

Thread Pool Size Type the number of threads the FSS uses 
when reading and storing files.

Field / Button Description
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Disk Types

Use the Disk Types tab (Figure 28) to define disk types used in the file 
system.

Maximum 
Connections

Type the maximum number of simultaneous 
connections (SNFS clients and Administrative 
Tap clients) allowed by the FSS.

Allocation Strategy Select the method of allocation for new disk 
blocks:
• Round: Alternate between similar stripe 

groups. (Default)
• Fill: Use the stripe group with the least 

amount of free space (that can 
accommodate the file) before using the 
stripe group with the next smallest 
amount of free space.

• Balance: Use the stripe group with the 
most free space. 

“Nobody” UID Type the Windows user ID to use when no 
user ID can be found using Active Directory.

“Nobody” GID Type the Windows group ID to use when no 
group ID can be found using Active Directory.

Default File Mode Type the permission mode to use when 
creating files.

Default Directory 
Mode

Type the permission mode to use when 
creating directories.

Use Fabricated IDs Select if the Metadata Controller is running 
on Apple MacOS X.

*File size dynamic expansion is calculated on a file-by-file basis for better 
performance. If this is not working optimally, you can use these settings 
to override the file-by-file calculations.

Field / Button Description
84 StorNext and StorNext FX 4.7.x Installation Guide 



Chapter 3: Windows SNFS Server Installation/Configuration
Configuring StorNext File System on Windows
Figure 28  Server 
Configuration: Disk Types

On the Disk Types tab, do one of the following:

• To add a new disk type, click New.

• To modify a disk type, select the disk type in the list and click Edit.

• To delete a disk type, select it in the list and click Delete.

When you add or modify a disk type, the Disk Type Editor dialog box 
appears (Figure 29). Table 8 describes the fields on the Enter New Disk 
Type dialog box.

Note: The Sectors and Sector Size fields are populated with values 
from the Disk Labeler utility. For more information, see Labeling 
Disk Drives on page 74.
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Figure 29  Server 
Configuration: Enter New Disk 
Type

Table 8  Server Configuration: 
Enter New Disk Type

Disk Definitions

Use the Disk Definitions tab (Figure 30) to create disk definitions and 
modify disk specifications. Table 9 describes the fields on the Disk 
Definitions tab.

Field / Button Description

Disk Type Type a descriptive name for the disk.

Sectors Type the number of physical sectors on the 
disk.

Sector Size Type the size of sectors on the disk.

OK Click to create the new disk type with the 
specified properties.

Cancel Click to close the Disk Type Editor dialog box 
without saving changes.
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Figure 30  Server 
Configuration: Disk Definitions

Table 9  Server Configuration: 
Disk Definitions Field / Button Description

Disks Available - 
New

Click to create a new disk definition. Type a 
name for the disk and click OK.

Disks Available - 
Delete

Click to delete the selected disk definition.

Status: Up Select to enable the selected disk definition. 
When enabled, the defined disk is available 
to the configured file system for I/O.

Disk Type Select a disk type for the selected disk 
definition. (Disk types are defined on the 
Disk Types tab.)

Device Names - 
New

Click to add a device name to the disk 
definition. Type a device name and click OK.
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Stripe Groups

Use the Stripe Groups tab (Figure 31) to define stripe groups. (A stripe 
group is a logical storage unit consisting of one or more disk drives.) 
Table 10 describes the fields on the Stripe Groups tab.

Figure 31  Server 
Configuration: Stripe Groups

Table 10  Server Configuration: 
Stripe Groups

Device Names - 
Delete

Click to delete the selected device name.

Field / Button Description

Field / Button Description

Stripe Groups 
Available - New

Click to create a new stripe group. Type a 
name for the stripe group and click OK.
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Stripe Groups 
Available - Delete

Click to delete the selected stripe group.

Status: Up Select to enable the selected stripe group. 
When enabled, the stripe group is available 
to the configured file system for I/O.

Exclusive Select to allow only file types associated with 
the affinities specified under Affinities to be 
stored on the stripe group.

MetaData Select to allow file system metadata to be 
stored on the stripe group.

Journal Select to allow the file system logging journal 
to be stored on the stripe group.

Stripe Breadth 
(Blocks)

Describes the number of file system blocks 
that are appended to a file before switching 
to the next disk in the stripe group.

Affinities - New Click to add a new affinity to the stripe 
group. Type the name of the new affinity and 
click OK. (Affinity names cannot be longer 
than eight characters.)

Affinities - Delete Click to the delete the selected affinity.

Pathing Method Select a method for how the file system 
accesses the disk:
• Rotate: Chooses an I/O path based on 

load.
• Static: Always uses the same I/O path.
• Sticky: Chooses an I/O path based on the 

identity of the target file.

Rtios Type the maximum number of disk I/O 
operations per second available to real-time 
applications using the Quality of Service 
(QOS) API.

Field / Button Description
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Caution: When adding a disk to an existing stripe group, make sure 
the disk is added to the bottom of the Drive List. If the disk 
is inserted in the middle of the list, the file system behaves 
as if files on the file system are corrupted.

Importing and 
Exporting Client 
Settings

This feature is described in Restoring a Previous StorNext or StorNext FX 
Client Configuration on page 161.

Configuring the Client In order for a client to access a StorNext file system, the file system must 
be mapped to a folder or drive letter. The Client Configuration Tool 
maps a StorNext file system to a Windows drive letter or folder and 
controls various configuration settings.

RtiosReserve Type the minimum number of disk I/O 
operations per second reserved for non-real-
time applications.

RtTokenTimeout Type the number of seconds to wait for 
clients to respond to a token callback.

Rtmb Type the maximum number of MBs per 
second available to real-time applications 
using the Quality of Service (QOS) API.

RtmbReserve Type the minimum number of MBs per 
second reserved for non-real-time 
applications.

Modify Drive List Click to add or remove disks for the selected 
stripe group. Use the left and right arrows to 
add or remove disks in the Primary Disks list, 
and then click OK.

Field / Button Description
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The values for the Client Configuration are stored in the Windows 
Registry and are referenced by StorNext when the file system is 
mounted.

Follow these steps to configure the client:

1 Access the client configuration utility from the Windows Start menu 
(Start > All Programs > StorNext File System > Client 
Configuration). 

Note: You may also access the client configuration utility from 
the StorNext configuration window (see Using the StorNext 
Configuration Window on page 68). 

The Client Configuration window appears (Figure 32). Displayed 
under the File System column heading are all file systems advertised 
by the name server, and currently mapped StorNext file systems 
found in the Windows registry. 

Figure 32  Client Configuration 
Window

The Client Configuration screen includes the following functions:

• Mapping a Drive on page 92: Map a StorNext file system to a 
folder or drive letter.
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• Unmapping a Drive on page 94: Unmap a StorNext file system 
from a folder or drive letter.

• Editing Drive Mapping on page 94: Change the drive mapping.

• Configuring Name Servers on page 94: Edit, add or remove 
name servers.

• Configuring LAN Clients and Gateway Servers on page 94

• Configuring Logging Options on page 98

• Advanced Mount Options on page 99

• Advanced Cache Options on page 103

Mapping a Drive

To map a StorNext file system to a folder or drive letter, double-click the 
desired file system (or select it and click the Map Drive icon or Tools > 
Map Drive). The Client Properties screen appears.

Use the Mount Point tab (Figure 33) to specify drive mappings. Table 11 
describes the fields on the Mount Point tab.

If your file systems are not displayed, check the status bar at the 
bottom. The most likely problems are: incorrect Name Server 
Configuration, network problems, the file system is not running, or 
StorNext Services are not running.

StorNext file systems can be mapped to a drive letter or to a folder. 
When mapping to a folder, the folder must be empty or non-existent, 
and must exist within an NTFS file system (e.g., C:\Mount\MySnfs).

Note: Make sure the host list is the same for all clients on the SAN. An 
incorrect or incomplete host list may prevent the client from 
connecting to the file system. 
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Figure 33  Client 
Configuration: Mount Point

Table 11  Client Configuration: 
Mount Point

Note: If this is a LAN client or gateway, be sure to enter the 
parameters on the Distributed LAN tab (see Configuring LAN 
Clients and Gateway Servers on page 94).

Field / Button Description

Map to Drive Letter Select Map to Drive Letter to map the drive to 
a specific drive letter.

Drive (Letter) Select the desired drive letter.

Map to Directory Instead of selecting Map to Drive Letter, 
select Map to Directory. Enter a directory 
path, or click Browse to navigate to the 
directory path.
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Unmapping a Drive

Select the file system you want to unmap and then click the Unmap 
Drive icon or select Unmap Drive from the Tools menu. You must close 
all applications (included Windows Explorer) which might be using the 
file system. If the file system is busy, you will not be allowed to unmap 
the drive.

Note: In order to unmap a drive, you must have Administrator rights 
on the local computer, and you must have read/write access to 
root of the StorNext file system.

Editing Drive Mapping

Once a file system is mapped, you can change the mapping by double-
click the file system. Alternatively, select the file system and click the 
Properties button, or select the file system and click Tools > Edit Drive 
Mapping. This opens the Properties window where you can change 
drive mapping. See Mapping a Drive on page 92 for instructions.

Configuring Name Servers

Click the Edit Name Servers icon or choose Configure Name Servers 
from the Tools menu. Follow the instructions in Configuring Name 
Servers on page 73.

Configuring LAN Clients and Gateway Servers

To configure StorNext LAN clients and gateway servers, double-click the 
desired file system (or select it and click the Properties icon). The 
Properties screen appears.

Note: Do not enable gateway functionality for MDCs, connected to 
Lattus systems.

Use the Distributed LAN tab to enable and configure StorNext LAN 
clients and gateway servers for a file system. The Enable Client and 
Enable Server radio buttons determine whether the system is a LAN 
client or gateway Server. Note that separate licensing is required for LAN 
clients.
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StorNext LAN clients provide the same functionality as StorNext SAN 
clients but do not need to be connected directly to the SAN. They 
instead send I/O via the TCP/IP network through a gateway server - a 
StorNext SAN client enabled as a gateway server. Metadata is sent over 
the TCP/IP network directly to the File System Metadata Controller 
(Server/MDC).

LAN Clients request the location of gateway servers via the Name Server.

• Gateway Server: A gateway server has direct access to data disks 
(using fibre channel) and makes the shared storage pool available to 
distributed LAN clients over a network.

• LAN Client: A StorNext LAN client does not have direct access to 
data disks and instead accesses the shared storage pool by 
connecting to a gateway server over a network. (LAN clients have 
full StorNext client functionality.)

Note: A StorNext SAN client configured as a gateway server requires a 
dedicated system. Do not run other applications or services on 
a system configured as a gateway server.

Use the Distributed LAN tab (Figure 34) to configure a gateway server 
or a LAN client. Table 12 describes the fields on the Distributed LAN 
tab.
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Figure 34  Client 
Configuration: Distributed LAN

Table 12  Client Configuration: 
Distributed LAN Field / Button Description

Disable Select this option to disable the StorNext 
client as a StorNext LAN client or gateway 
server. 

Enable Client Select to configure the StorNext client as a 
LAN client. The StorNext client will connect to 
all available gateway servers.
(If you select this check box, all other fields 
on the tab become unavailable.)

Enable Server Select to configure the StorNext SAN client as 
a gateway server. The StorNext client will 
make the disks for this file system available to 
LAN clients over the specified LAN.
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Read Timeout (sec) Specify how long the LAN client will wait for 
a read operation to complete before retrying 
it on a different gateway server.

Write Timeout (sec) Specify how long the LAN client will wait for 
a write operation to complete before retrying 
it on a different gateway server.

Number of Transfer 
Buffers

Specify the number of socket transfer buffers 
used for LAN client I/O.

Transfer Buffer Size 
(kb)

Specify the size in kilobytes of the socket 
transfer buffers used for LAN client I/O.

TCP Window Size 
(kb)

Specify the size in kilobytes of the TCP 
window used for LAN client I/O connections.

Max Threads Specify the number of kernel threads that 
will be used to service LAN client I/O 
requests.

Server Interfaces To complete gateway server configuration, 
select one or more network interfaces to be 
used for LAN client traffic.

Field / Button Description
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Configuring Logging Options

From the Client Configuration screen, select Tools Global Options. The 
Global Client Options window displays (Figure 35).

Figure 35  Global Client 
Options

Select the level of logging you want to receive and whether you want to 
display critical events on your desktop. Log information is available in 
the Windows Event Viewer.

Field / Button Description

Event Log Level Controls how many messages are inserted 
into the Windows Event Viewer. Critical 
provides the fewest messages; Debug 
provides the most. Each level includes all the 
messages in the levels listed above it.

Display Critical 
Events to Desk Top

Enables a notification of critical events to be 
sent to work station’s desktop in a message 
box. If this is not desired, clear the check box.
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Advanced Mount Options

The Mount Options tab (Figure 36) displays the mount options for the 
drive currently selected on the Drive Mappings tab. Table 12 describes 
the fields on the Distributed LAN tab.

Caution: Changing the values on the Mount Options tab can affect 
system performance and stability. Do not change mount 
options unless instructed to do so by the Quantum 
Technical Assistance Center.

Figure 36  Client 
Configuration: Advanced 
Mount Options
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Table 13  Client Configuration: 
Advanced Mount Options Field / Button Description

Mount Retransmit 
Limit

Specify the number of times the driver will 
re-transmit a message to the FSM. After a 
successful connection, this value is no longer 
used. 
The default is 1.

Hard Mount When this box is checked, the driver attempts 
to mount the file system forever. 
The default is off (Soft Mount). Quantum 
recommends that Hard Mount NOT be used 
on Windows systems.

Allow Diskless 
Mount

When this box is checked, the file system can 
be mounted and accessed without all the 
disks being accessible in the file system stripe 
groups. In this mode, file metadata can be 
viewed and changed, but no data can be 
accessed. 
The default is to not allow a file system to be 
mounted unless all disks are accessible.

Read Only When this box is checked, the file system is 
mounted in read-only mode. The default is 
off or not checked.

Restrict Pre-
allocation API

When set to yes, non-administrator users are 
unable to use the preallocation ioctl.

Number of Async  
I/O Threads

Specify the number of threads created to be 
used as asynchronous I/O threads for user 
applications. The default is 8. The allowed 
range is 4 to 32.

Number of System 
Threads

Specify the number of threads created for 
use by the file system. The default value is 16.

Message TImeout x 
1/10th Sec.

Specify (in tenths of a second) the amount of 
time before a message to the FSM is timed 
out. The default is 50 (five seconds).
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Message Retry 
Count

Specify the number of attempts to be made 
for sending a message to the File System 
Service. The default is 12.

Retry I/Os Forever
or Allow I/O 
Timeouts

Choose either Retry I/Os Forever or Allow  
I/O Timeouts, depending on whether you 
want to allow timeouts or keep trying I/O. 
The default value is to Retry I/Os Forever.

I/O Retry Time 
Seconds

When you choose Allow I/O Timouts, this 
option controls the I/O retry behavior. This 
parameter establishes the amount of time 
that may elapse during an I/O retry sequence. 
An I/O retry sequence consists of the 
following:
•  Retry an I/O request across all available 

paths that are currently present.
• Compare the current time to the 

Instantiation time of the I/O request, if at 
least <n> seconds have elapsed, return 
the I/O request in error, otherwise reset the 
paths used, and retry again.

I/O Penalty TIme 
Seconds

This option controls the Multi-Path I/O 
penalty value, where <n> is expressed in 
seconds with a minimum value of 1 and a 
maximum value of 15. 
This parameter establishes the amount of 
time a Path_In_Error will be bypassed in 
favor of an Operational Path during a Multi-
Path selection sequence. If all paths are 
currently in the Path_In_Error state, the first 
available path will be selected, independent 
of the Path_In_Error state. 
The default value is 5 seconds.

Field / Button Description
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Fast Failover 
Detection

When this box is checked, the client uses a 
more aggressive approach to detecting if the 
FSM has failed. With this option on, the client 
monitors the FSM heartbeat. If no heartbeat 
is detected within three (3) seconds, a 
failover request is initiated. 
This option is desirable for near realtime 
activities that cannot sustain more than 10 
seconds of access loss to the server. Quantum 
does not recommend enabling this option for 
normal file system operations.

Hard Reconnect When this box is checked, the file system 
attempts to reconnect to the FSM forever. If 
this option is not enabled, the file system 
attempts to reconnect to the FSM for the 
number of times specified at the Mount 
Retransmit Limit field before failing the 
request.
The default value is off.

Token Hold Seconds The QOS Token Hold Time parameter is 
applicable only when using the StorNext 
Quality of Service (QOS) feature for real-time 
IO.
This parameter determines the number of 
seconds a client stripe group holds on to a 
non-realtime I/O token during periods of 
inactivity. If no I/O is performed on a stripe 
group within the specified number of 
seconds, the token is released back to the 
FSM.
The default value is 60 seconds. The 
parameter should be specified in five-second 
increments; if the parameter is not a multiple 
of five, it will be rounded up automatically.

Field / Button Description
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Advanced Cache Options

The Data Buffer Cache keeps the file system data in memory on the local 
computer to speed up performance for small I/O operations.

The Advanced Cache Options tab (Figure 37) displays performance 
values that control how many file system lookup names are kept in 
memory.

Caution: Changing the values on the Advanced Cache Options tab 
can affect system performance and stability. Do not change 
cache parameters unless instructed to do so by the 
Quantum Technical Assistance Center.

Figure 37  Client 
Configuration: Advanced 
Cache Options
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Table 14  Client Configuration: 
Advanced Cache Options Field / Button Description

Enable Data Buffer 
Cache

When this box is not checked, the file system 
will not buffer any data. All files will be read 
directly into the application's memory using 
DMA. Requests that are not properly aligned 
will be read into temporary buffers, then 
copied to the application's buffer.
If Buffer Cache is disabled, the remaining 
Data Buffer Cache options are ignored.

Individual Buffer 
Size

This option sets the size of each cache buffer. 
This determines the I/O transfer size used for 
the buffer cache. To determine optimal 
performance, try different sizes or contact 
your RAID vendor.
This size must be divisible by the file system 
block size. The maximum value allowed is 
512K and the minimum value allowed is the 
file system block size. The value default is 
64K.

Minimum Total 
Cache Size

This value controls the amount of memory 
used to cache data from the file system. This 
parameter is shared by all file systems with 
the same block size.

Auto-DMA Read/
Write Sizes

Buffer Cache Auto DMA Read Length and 
Buffer Cache Auto DMA Write Length control 
the minimum I/O size for DMA transfers. That 
is, any smaller transfer will always go 
through the buffer cache. 
The default value is 1MB.

Number of Read-
ahead Buffers

This option controls the size of the read-
ahead window used by the buffer cache. 
The default value is 16 buffers with a 
maximum of 100. Using a value of 0 disables 
read-ahead.
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Number of Threads This option controls the number of dedicated 
background threads used by the buffer cache 
for performing I/O. 
The default value is 8, with a minimum of 1 
and a maximum of 100. Using a larger value 
can increase I/O concurrency in the buffer 
cache and therefore improve performance.

Seconds for Shared/ 
Non-Shared

The Attribute Flush Time parameters control 
the length of time attributes are held on the 
client before they are flushed back to the 
FSM (unless there is an explicit attribute 
request from the FSM). 
The default values are 30 seconds for non-
shared files (Attribute Flush Time, non 
shared), and 2 seconds for shared files 
(Attribute Flush Time, shared).
Setting these parameters lower will greatly 
increase the amount of metadata traffic 
between clients and the FSM. However, in 
circumstances where files are frequently 
shared on the SAN, setting the Attribute 
Flush Time Shared can result in other clients 
seeing size updates more frequently if a file is 
being written on one client and read on 
another. 

A value of zero is invalid, and will result in 
using the default setting.

Delay Atime 
Updates

When this box is checked, the file system 
delays Atime (access time) updates when 
reading a file to the time when the file is 
closed. This cuts down on FSM metadata 
updates at the expense of coherency.

Field / Button Description
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Starting File System 
Services

The Start File System Services utility starts all StorNext services on an 
MDC or StorNext client.

The StorNext services must be running on the MDC for file systems to be 
active and available. In addition, the StorNext services must be running 
to use the StorNext configuration utilities and to mount file systems 
using the client software.

To start StorNext File System services, on the Windows Start menu, click 
All Programs > StorNext File System > Services Start. 

Stopping File System 
Services

The Stop File System Services utility stops all StorNext services on an 
MDC or StorNext client.

To stop StorNext File System services, on the Windows Start menu, click 
All Programs StorNext File System Services Stop. 

To start the StorNext services again, reboot the system or use the Start 
File System Services utility. For more information, see Starting File 
System Services.

Low Water Mark Metadata Caches contain non-data 
information such as file names, sizes, update 
times, etc. 
Tuning the low and high water marks and the 
frequency of purge passes can help certain 
large mix applications.

High Water Mark

Max. Entries

Purge Period 
(Seconds)

Minimum Directory 
Cache Size

This option sets the size of the directory 
cache. Directory entries are cached on the 
client to reduce client-FSM communications 
during directory reads. 
The default value is 10 MB.

Field / Button Description
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Stopping and 
Removing File System 
Services

The Stop and Remove File System Services utility stops all StorNext 
services on an MDC or StorNext client, and also removes registry entries 
that automatically start the services on bootup.

To stop and remove StorNext File System services, on the Windows Start 
menu, click All Programs > StorNext File System > Services Stop and 
Remove. 

To start the StorNext services again, you must use the Start File System 
Services utility. Rebooting the system will not restart services. For more 
information, see Starting File System Services on page 106.

Obtaining Version 
Information

The Version Information utility displays information about the currently 
installed version of the StorNext server and/or client software, such as 
the version number, build number, and platform.

To run the Version Information utility, on the Windows Start menu, click 
All Programs > StorNext File System > Version Information. A dialog 
box displays version information for the StorNext server and/or client 
software installed on your system.

Configuring the File 
System Startup List

The File System Startup List utility lets you modify the File System 
Manager (FSM) services list and set file system priority.

The File System Manager is a process that manages the name space, 
allocations, and metadata coherency for a file system. Each file system 
uses its own FSM process. When there are multiple file systems (and 
therefore multiple FSM processes), the FSM services list controls which 
FSM processes are run when the server starts up, and also sets the 
priority for each file system (for failover configurations).

To run the File System Startup List utility, on the Windows Start menu, 
click All Programs > StorNext File System > File System Startup List. 
The File System Startup Editor opens (Figure 38).

Select a file system do any of the following. When finished making 
changes, select File > Save to save your changes.
StorNext and StorNext FX 4.7.x Installation Guide 107



Chapter 3: Windows SNFS Server Installation/Configuration
Configuring StorNext File System on Windows
Figure 38  File System Startup 
List

Action Description

Action  Toggle 
Startup Type

Allows you to choose if the file system will 
start up automatically upon server startup. 
This action toggles the startup type 
between automatic and manual. 

Action  Priority (Optional) Select the priority for the 
selected file system. This priority is used for 
failover configurations. 0 is highest priority 
and 9 is lowest priority. 
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Re-initializing a File 
System

The Re-initialize a File System utility allows you to initialize an existing 
file system. Initializing a file system prepares it for use.

Caution: Use extreme caution when using this tool. This will destroy 
all data on the selected file system.

To initialize a file system, on the Windows Start menu, click All 
Programs > StorNext File System > Re-initialize a File System. Type 
the number that corresponds to the file system you want to re-initialize, 
and then press <Enter>.

Checking a File System 
(Read-Only)

The File System Check (Read-Only) utility allows you to check a StorNext 
file system for metadata corruption (due to a system crash, bad disk, or 
other failure). Run the utility on an MDC that contains the file system 
you want to check.

To check a file system, on the Windows Start menu, click All Programs 
> StorNext File System > File System Check (Read-Only). Type the 
number that corresponds to the file system you want to check, and then 
press <Enter>.

Because the file system check is run in read-only mode, any problems 
that exist are not repaired. If the utility identifies errors or corruption in 
metadata, you must repair the file system (see Repairing a File System 
on page 109).

Repairing a File System The File System Check (Repair) utility lets you repair corrupted metadata 
on a file system. Repair a file system if errors were identified when 
checking the file system (see Checking a File System (Read-Only) on 
page 109).

The file system must be inactive in order to be repaired. To stop a file 
system, see Stopping File System Services on page 106.

To repair a file system, on the Windows Start menu, click All Programs 
> StorNext File System > File System Check (Repair). Type the 
number that corresponds to the file system you want to repair, and then 
press <Enter>.
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Note: Multiple repair passes may be needed to fully fix a damaged 
file system. Run the repair utility repeatedly until no problems 
are reported by the utility.

Server Administration The Server Administration utility lets you view and modify stripe group 
properties and set quotas. A stripe group is a logical storage unit made 
up of one or more disks. A quota is a space limit that is set for specified 
users or groups.

To run the Server Administration utility:

1 On the Windows Start menu, click All Programs > StorNext File 
System > Server Administration.

A Connect to dialog box opens (Figure 39).   

Figure 39  Server 
Administration Connect to 
Dialog Box

2 Enter the host name or IP address and click OK. 

3 The Administrator window appears (Figure 40). The left pane 
shows file systems running on the currently connected MDC. 
Expand a file system to see stripe groups, quotas, and other 
properties.
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Figure 40  Server 
Administration

On the Administrator window, do one of the following:

• To connect to an MDC, click File > Connect to. Type the host name 
and click OK. File systems on the server appear in the left pane.

• To start a file system, click it in the left pane. Click File > Start File 
System, and then click Start.

• To activate a file system, click it in the left pane. Click File > 
Activate File System, and then click Activate.

• To stop a file system, click it in the left pane. Click File > Stop File 
System, and then click Stop.

• To update the list of file systems in the left pane, click View  
Refresh.

For more information about viewing and modifying file system 
properties and quotas, see the following sections:

• File System Properties on page 112

• Stripe Group Properties on page 113

• Quota Properties on page 115

• Quality of Service Information on page 116

• Clients Information on page 116

Note: Do not change settings on the Debug Settings dialog box 
unless directed to do so by the Quantum Technical Assistance 
Center.
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File System Properties

To view or change file system properties, click a file system in the left 
pane, and then click the file system name in the right pane. The File 
System Properties dialog box appears (Figure 41). Table 15 describes 
the fields on the File System Properties dialog box.

After making changes, click OK. (Not all fields can be modified on this 
dialog box.)

Figure 41  Server 
Administration: File System 
Properties

Table 15  Server 
Administration: File System 
Properties

Field / Button Description

Active Clients The number of active clients on the file 
system.

Msg Buffer Size The size of the message buffer.

Fs Block Size The file system block size.

Disk Devices The number of disk devices in the file system.

Stripe Groups The number of stripe groups in the file 
system.

File System Quotas Select to enable file system quotas.
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Stripe Group Properties

To view or change stripe group properties, expand a file system in the 
left pane, click Stripe Groups, and then click the stripe group name in 
the right pane. The Stripe Group Properties dialog box appears 
(Figure 42). Table 16 describes the fields on the Stripe Group 
Properties dialog box.

After making changes, click OK. (Not all fields can be modified on this 
dialog box.)

Distributed Locking Indicates if distributed locking is enabled or 
disabled.

Windows Security Indicates if Windows security is enabled or 
disabled.

Global Superuser Indicates if the global superuse is enabled or 
disabled.

Quality-of-Service Indicates if Quality of Service is enabled or 
disabled.

Usage Displays the amount of used and free storage 
space in the file system.

Field / Button Description
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Figure 42  Server 
Administration: Stripe Group 
Properties

Table 16  Server 
Administration: Stripe Group 
Properties

Field / Button Description

Stripe Group Name The name of the stripe group.

Status Shows the current status of the stripe group. 
Click Up to make the stripe group active or 
click Down to make the strip group inactive.

Stripe Breadth The number of file system blocks to write 
before switching to the next disk in the stripe 
group.

Stripe Depth The number of disks in the stripe group.

Exclusive Indicates if only specified file types 
(associated with the stripe group affinities) 
can be stored on the stripe group.

Metadata Indicates if file system metadata can be 
stored on the stripe group.

Journal Indicates if the file system logging journal 
can be stored on the stripe group.

Realtime (no longer supported)
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Quota Properties

Quotas define the amount of storage space a specified user or group is 
allowed to own. You can set hard or soft quota limits.

To view or change quota properties, expand a file system in the left 
pane, and then click Quotas. The Quota Properties dialog box appears 
(Figure 43). There are two tabs:

• Set quotas for users on the User Quotas tab.

• Set quotas for groups on the Group Quotas tab.

Table 17 describes the fields on the User Quotas and Group Quotas 
tabs. After making changes, click OK. (Not all fields can be modified on 
this dialog box.)

Figure 43  Server 
Administration: Quota 
Properties

Multi-Path Method Indicates the method the file system uses to 
access the disk: round, static, or sticky.

Usage Displays the amount of used and free storage 
space in the stripe group.

Field / Button Description
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Table 17  Server 
Administration: Quota 
Properties

Quality of Service Information

To view Quality of Service (QOS) information for a file system, expand a 
file system in the left pane, and then click QOS. Quality of Service 
information appears in the right pane, including stripe group, real-time 
limit, non-real-time reserve, committed RTIO, and the number of non-
real-time clients.

Clients Information

To view information about clients connected to the file system, expand a 
file system in the left pane, and then click Clients. Information about 
the currently connected clients appears in the right pane, including 
client ID, type, location, up time, and when the client license expires.

Field / Button Description

User Name / Group 
Name

Type the name of the user or group to set a 
quota for.

Usage Displays the percentage of the quota that has 
been used.

Hard Limit Specify an amount in B, KB, MB, GB, or TB, or 
EB. This is the maximum amount of space the 
specified user or group can use.

Soft Limit Specify an amount in B, KB, MB, GB, or TB, or 
EB. Once the user or group uses this amount 
of space, a warning is sent. (Typically this is 
80% of the hard limit.)

Time Limit Specify the amount of time it takes for the 
soft limit to turn into a hard limit.

Get Quota Click to get quota settings for the specified 
user or group.

Set Quota Click to set a quota for the specified user or 
group using the current settings.
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Configuring a High Availability System on Windows

Follow these steps to configure a High Availability (HA) system on 
Windows:

1 Install StorNext if not already installed (see Installing StorNext File 
System on Windows MDCs on page 58).

2 Obtain and install StorNext licenses, which must include at least 
Maintenance, Server and Failover licenses for both MDCs (see 
Obtaining and Installing a Permanent License on page 70).

3 If this is an existing configuration with clients, it is recommended 
that you stop StorNext services on all StorNext clients to avoid the 
clients hanging (see Stopping File System Services on page 106).

4 Verify that configuration files are correct and identical on both 
MDCs.

a The *.cfg files should be identical on both computers.

b The fsnameservers files should be identical on both 
computers.

c The fsmlist files should be identical on both computers.

5 Create the ha_peer file in the configuration directory of each MDC 
(C:\Program Files\StorNext\config\ha_peer). The ha_peer file on 
each MDC must contain the numerical IP address of its redundant-
peer MDC, which enables intra-MDC communication for HA 
functionality.

6 Enable High Availability (HA) on both redundant-peer MDCs by 
doing the following:

Caution: If you do not perform these steps on both MDCs your 
metadata could become corrupted.

a After installing StorNext, on each MDC run: Start > All 
Programs > StorNext > File System Cfg (Advanced).

The File System Configuration window displays (Figure 44).
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Figure 44  Configuration 
Administrator

b On the Tools menu, click HA Configuration.

c Click Enable High Availability (HA). Note that you cannot 
enable HA if there are no file systems configured.

7 High Availability is now configured. You may now test the HA reset 
functionality by running the following command on either MDC:

The MDC will immediately stop and reboot. Clients for any StorNext 
file systems that were being served by active FSMs on the reset MDC 
will trigger elections that will result in the activations of 
corresponding FSMs on the redundant HA MDC. This can be 
observed by running the following command on the redundant 
MDC both before and after resetting its peer MDC:

8 Restart services on any clients that you stopped earlier (see Starting 
File System Services on page 106).

cvadmin -e "hamon smith"

cvadmin –e "select"
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Note: Restarting StorNext faster than once per three minutes can 
trigger a startup delay of three minutes. The delay slows 
down looping HA resets so that an administrator can 
correct any configuration problems that are causing the 
resets.

Installing Promise RAID Controller Software on 
Windows

If you are using Promise RAID controllers on a Windows Server 2008 64-
bit system, you must install Promise’s PerfectPath software. If you do 
not install this software you can still access (read from and write to) 
your RAIDs, but the controller will not be able to fail over.

Promise is working on a solution to this problem, but in the meantime 
they have provided the following workaround.

1 Install the PerfectPath software on your Windows Server 2008 64-bit 
system.

2 Restart your system. 

The login prompt will not appear after you restart. Instead, the 
Windows Boot Manager screen appears showing an error 
message: “Windows cannot verify the digital signature for this file” 
(\Windows\system32\DRIVERS\ perfectpathdsm.sys)
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Figure 45  Windows Boot 
Manager Screen 1

3 From the Windows Boot Manager screen, press Enter to continue. 
A second Windows Boot Manager screen appears, asking you to 
choose an operating system or specify an advanced option. 

Figure 46  Windows Boot 
Manager Screen 2

4 On the second Windows Boot Manager screen, press F8 to specify 
advanced options. The Advanced Boot Options screen appears.
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Figure 47  Advanced Boot 
Options Screen

5 On the Advanced Boot Options screen, use the arrow keys to 
choose the option Disable Driver Signature Enforcement. 
Choosing this option will cause the system to display the login 
prompt normally after you reboot.

6 Restart your system.

Adding or Removing StorNext Components

After installing StorNext File System, you may wish to add or remove 
components. Specifically, you can add or remove the online help files, 
the StorNext client, and the StorNext server. 

1 If you just completed installing StorNext, the StorNext Installation 
window displays (Figure 48). The components you selected during 
the install are already added, but if you changed your mind and 
want to select different components, you can do so now. 
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Figure 48  StorNext Installation 
Window: Add/Remove 
Components 

If you previously installed StorNext and would like to add or remove 
components, display the StorNext Installation window by double-
clicking the file named SnfsSetup64.exe (64-bit systems). Note that 
the screen is slightly different from Figure 48 above: instead of Add/
Remove Components, the button you need to click is called 
Upgrade/Reinstall StorNext (see Figure 49). 

Figure 49  StorNext Installation 
Window: Upgrade/Reinstall 
StorNext

2 Click Add/Remove Component or Upgrade/Reinstall StorNext, 
depending on which screen you are looking at. 
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The Component Selection screen appears (Figure 50). 

Figure 50  Component 
Selection

3 Select the check boxes of the components you want to add. Clear 
the check boxes of the components you want to remove. Click Next 
to proceed. 

Note: The Install Licenses option allows you to import your 
StorNext licenses onto the StorNext server, if you have not 
already done so. You may also install licenses later using 
this screen or the Windows Start button (Start > Licenses 
or Start > All Programs > StorNext > Licenses).

The StorNext End User License Agreement (EULA) appears (Figure 10 
on page 60). 

4 Read and accept the EULA by selecting “I accept the terms in the 
License Agreement” and clicking Next.

It make take several minutes for the selected components to finish 
being added or removed. 

5 When a message informs you that the process is complete, click OK.

6 Click Exit.
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Restoring a Previous Client Configuration

For information about this feature, please see Restoring a Previous 
StorNext or StorNext FX Client Configuration on page 161.

Upgrading or Reinstalling StorNext on a Server

The Upgrade/Reinstall button allows you to upgrade to a new version 
of StorNext or reinstall the current version. You might want to reinstall if 
you accidentally removed some components and need to get them 
back. During an upgrade/reinstall, the old software is removed and the 
new software is installed. Your previous configuration settings remain 
intact. 

Note: If you are upgrading a Windows 3.x high-availability system to 
StorNext 4.7.x, additional steps are required. Follow the 
instructions in the StorNext 4.7.x Upgrade Guide.

1 Copy the file named /fs_only/snfs_full_Windows_x86_64.zip from 
the installation DVD and place it on the system onto which you 
want to install it. Be sure to select the file from the fs_only directory 
and not the stornext_full directory. 

2 Unzip the file.

3 Double-click the file named SnfsSetup64.exe to launch the installer. 

The StorNext Installation screen appears (Figure 51).
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Figure 51  StorNext Installation 
Window: Upgrade/Reinstall 
StorNext

4 Click Upgrade/Reinstall StorNext to begin installation.

The StorNext Component Selection window appears (Figure 52).

Figure 52  Component 
Selection
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5 Select the check boxes of the components you want to include in 
the upgrade. Clear the check boxes of the components you want to 
exclude. Click Next to proceed.

The StorNext EULA appears (see Figure 10 on page 60). 

6 Read the EULA. If you accept, select “I accept the terms in the 
License Agreement” and then click Next to continue the install.

It make take several minutes for the selected components to finish 
being added or removed. 

7 When a message informs you that the installation is finished, click 
OK.
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StorNext and StorNext FX Client 

Installation/Configuration 

This chapter describes how to perform a StorNext and StorNext FX 
client-only installations (without StorNext File System or StorNext 
Storage Manager) on supported platforms. StorNext and StorNext FX 
client software lets you mount and work with StorNext and Xsan file 
systems, respectively.

To ensure successful operation, make sure the StorNext or StorNext FX 
client system meets all operating system and hardware requirements 
(see StorNext and StorNext FX Client System Requirements on 
page 128).

Note: Before installing the StorNext or StorNext FX client software 
you must install and configure your StorNext or Xsan MDC, 
activate StorNext with a license key, and create necessary File 
Systems. For Xsan MDCs consult your Apple Xsan 
documentation for information on configuring the MDC.

This chapter covers:

• StorNext and StorNext FX Client System Requirements

• Downloading StorNext Client Software

• Downloading StorNext FX Client Software

• Installing StorNext and StorNext FX Client Software on Linux or Unix

• Installing StorNext and StorNext FX Client Software on Windows

• Configuring the StorNext and StorNext FX Client on Windows
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StorNext and StorNext FX Client System Requirements

To run the StorNext and StorNext FX client software, the client system 
must meet all operating system and hardware requirements.

Operating System 
Requirements

The operating systems, kernel versions, and hardware platforms 
supported by StorNext File System are listed in the StorNext 
Compatibility Guide posted here (click the “Select a StorNext Version” 
menu to view the desired version of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the operating system and platform 
requirements outlined in the guide, and, if necessary, update to a 
supported release or kernel version before installing StorNext.

StorNext and StorNext 
FX Client Hardware 
Requirements

RAM, hard disk, and CPU requirements to run the StorNext and StorNext 
FX clients are listed in the “StorNext Client and StorNext FX RAM, Disk 
and CPU Requirements” section of the StorNext Compatibility Guide 
posted here (click the “Select a StorNext Version” menu to view the 
desired version of the guide):

http://www.quantum.com/sndocs

Make sure the system to be used as a StorNext or StorNext FX client 
meets the hardware requirements outlined in the guide, and, if 
necessary, update the system before installing StorNext.

StorNext and StorNext 
FX Client File System 
Buffer Cache 
Requirements

File System Buffer cache requirements for the StorNext and StorNext FX 
clients are listed in the “StorNext Client and StorNext FX File System 
Buffer Cache” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs
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Make sure the system to be used as a StorNext or StorNext FX client 
meets the hardware requirements outlined in the guide, and, if 
necessary, update the system before installing StorNext.

Ensuring You Have 
Enough Space to 
Extract the Installation   
Software

The Linux/Unix StorNext and StorNext FX client installation software files 
are extracted into the /tmp/stornext directory by default. The software, 
when extracted, requires approximately 40 MB of space. Make sure 
there is enough free space in the default directory to extract the files. If 
there is not sufficient space, you may need to specify an alternative 
directory with the -d option.

To specify an alternate location before beginning the installation, enter 
the following command:

where <archive name> is the name of the client software file you 
downloaded, and <dir> is the directory into which you want to extract 
the installation files.

Other Requirements Additional requirements that must be met for the StorNext system are 
listed in the “Additional StorNext MDC and StorNext Client 
Requirements” section of the StorNext Compatibility Guide posted here 
(click the “Select a StorNext Version” menu to view the desired version 
of the guide):

http://www.quantum.com/sndocs

Make sure the system meets the additional requirements outlined in the 
guide, and, if necessary, update the system before installing StorNext.

Downloading StorNext Client Software

StorNext client software can be downloaded from the StorNext 
installation DVD, the Web, or from a StorNext Metadata Controller 

# ./<archive name> -d <dir>
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(MDC) running the StorNext GUI. You can only download client software 
from a StorNext MDC if you have SNFS and SNSM installed and are 
running the StorNext GUI.

This section covers:

• Locating StorNext Client Software on the Installation DVD, ftp Site

• Downloading StorNext Client Software from the StorNext MDC GUI 

Note: If you are using StorNextFX clients in your environment, see 
Downloading StorNext FX Client Software on page 132.

Locating StorNext 
Client Software on the 
Installation DVD, ftp 
Site

If your StorNext MDC is not running the StorNext GUI, you must 
download client software from the installation DVD or the Web.

If you have the installation DVD, retrieve the client software from the 
fs_only directory on the DVD. If you are obtaining software from the 
FTP site, download the client software from the fs_only directory. 

The names of the client install files begin with snfs_client_<system>, 
where <system> is the name of the operating system for which the 
install file is intended. Copy the appropriate install file to an accessible 
location on your computer and proceed to the installation instructions. 

Downloading StorNext 
Client Software from 
the StorNext MDC GUI

To download the StorNext client software from the StorNext MDC GUI, 
the client system must have network access to the MDC.

Note: StorNext FX client downloads are not supported from an Xsan 
MDC.

1 From a web browser, access the URL (host name and port number) 
of the StorNext MDC. For example, http://servername:81

Use one of the web browsers supported by StorNext to access the 
MDC (make sure pop-up blockers are turned off). For a list of 
currently-supported browsers, see the StorNext Compatibility Guide 
(click the “Select a StorNext Version” menu to view documents for a 
given release):

http://www.quantum.com/sndocs
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2 When prompted, type the username and password for the MDC, 
and then click OK. (The default username is admin, and the default 
password is password.)

The StorNext home page appears.

3 Choose Client Download from the Tools menu. The Tools > Client 
Download screen appears. 

Figure 53  Client Download 
Screen

4 Select from the Platform list the desired operating system. 

5 Select from the OS Version list the desired operating system version 
corresponding to the platform you selected. 

6 When a window appears containing a link to the client software 
download location, click the link to begin downloading.

Figure 54  StorNext and 
StorNext FX Client Download 
Link
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7 Click Download to begin the process. 

8 When prompted, choose the Save to Disk option, and then click 
OK.

9 Browse to the location where you want to save the file, and then 
click Save. 

10 After the client package has been saved, click Done. 

11 Continue with the installation procedure for your operating system 
as described in this StorNext Installation Guide or the online help:

• Installing StorNext and StorNext FX Client Software on Linux or 
Unix on page 132

• Installing StorNext and StorNext FX Client Software on Windows 
on page 149.

Downloading StorNext FX Client Software

Locating StorNext FX 
Client Software on the 
Quantum Web Site

If you are using StorNext FX clients in your environment, you must 
download client software from the StorNext FX location on the 
Quantum web site:

http://www.quantum.com/SNFXdownloads

Note: StorNext FX client downloads are not supported from an Xsan 
MDC.

Installing StorNext and StorNext FX Client Software on 
Linux or Unix

After downloading the StorNext or StorNext FX client software from the 
MDC or installation DVD, first make sure you have enough space to 
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extract the software files by following the instructions in Ensuring You 
Have Enough Space to Extract the Installation Software on page 129. 
Then install the software on the StorNext or StorNext FX client system 
using the correct procedure for your operating system:

• Installing StorNext and StorNext FX Client Software on Red Hat or 
SUSE Linux on page 133

• Installing StorNext and StorNext FX Client Software on Debian Linux 
on page 137

• Installing StorNext Client Software on Sun Solaris on page 140

• Installing StorNext Client Software on HP-UX on page 143

• Installing StorNext Client on IBM AIX on page 146

Note: Regardless of the operating system platform onto which you 
are installing, you must view and accept the StorNext end user 
license agreement (EULA) before you can install StorNext.

Installing StorNext and 
StorNext FX Client 
Software on Red Hat or 
SUSE Linux

To run the StorNext or StorNext FX client software on Red Hat Linux or 
SUSE Linux Enterprise, first install the client software package, and then 
configure the client.

Caution: Before installing the StorNext or StorNext FX client 
software, you must install the kernel source code. You can 
install the kernel source code by using the installation disks 
for your operating system.

Note: Client software is extracted by default to the directory /tmp/
stornext.

1 Log on to the StorNext or StorNext FX client system as root.

2 Change to the directory where the client software archive file you 
downloaded is located.

3 Run the client software binary. At the command prompt, type:

./<archive name>
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where <archive name> is the name of the client software archive 
file you downloaded. (For example, the file for RH5 is 
snfs_client_RedHat50AS_26x86_64.bin.)

4 When you are presented with the StorNext End User License 
Agreement (EULA), press <ENTER> to read the EULA. After reading 
the EULA enter y to accept the EULA, or enter any other key to 
decline. 

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 
Installation Software on page 129). 

Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 
 

 
where <archive name> is the name of the client software 
archive file you downloaded, and <dir> is the directory 
into which you want to extract the installation files.

# ./<archive name> -d <dir>
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Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 

 
where <archive name> is the name of the client 
software archive file you downloaded, and <dir> is 
the directory into which you want to extract the 
installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

5 Change directories to /tmp/stornext (or to the alternate directory if 
you specified one in the step above).

6 List the packages extracted from the software archive file. At the 
command prompt, type:

Identify the correct package to install. The correct package begins 
with snfs-client and ends with the .rpm file name extension.

Note: The file that ends with .rpm.md5sum is a checksum file, 
not the client software package.

7 Install the client software package and the snfs rpms. At the 
command prompt, type:

# ./<archive name> -d <dir>

ls -l

rpm -ivh <package_name> <snfs-client package>
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where <package_name> is the name of the client software package 
you identified in Step 6. 

8 Configure the boot order for system services. Do one of the 
following:

• For Red Hat Linux, at the command prompt, type:

• For SUSE Linux Enterprise, at the command prompt, type:

9 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP 
address of the MDC to which the StorNext or StorNext FX client will 
connect.

The fsnameservers file on the client must be exactly the same as on 
the MDC. If the fsnameservers file does not exist, use a text editor to 
create it.

Note: The fsnameservers file needs to contain only the IP address 
of the MDC.

10 For StorNext FX clients ONLY, copy the .auth_secret file from the 
Xsan MDC to /usr/cvfs/config/.auth_secret on the client system.

11 Create a mount point for the file system. At the command prompt, 
type:

where <mount point> is the directory path where you want the file 
system to be mounted. For example: /stornext/snfs1

12 Configure the file system to automatically mount after reboot. To do 
this, edit the /etc/fstab file so that it contains the following line:

chkconfig --level 345 cvfs on

chkconfig -s raw 235

chkconfig -s cvfs 345

mkdir -p <mount point>

chmod 777 <mount point>
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where <file system> is the name of the StorNext file system and 
<mount point> is the directory path created in Step 11.

13 Reboot the StorNext or StorNext FX client system.

After reboot, the StorNext file system is mounted at the mount 
point you specified.

Note: To manually mount a file system, at the command prompt, 
type: 
 
 

 
where <file system> is the name of the StorNext file system 
and <volume> is the name of the Xsan volume you will use, 
and <mount point> is the directory path where you want the 
file system to be mounted.

Installing StorNext and 
StorNext FX Client 
Software on Debian 
Linux

To run the StorNext or StorNext FX client software on Debian Linux, first 
install the client software package, and then configure the StorNext or 
StorNext FX client.

To install the client software package:

1 Log on to the StorNext or StorNext FX client system as root.

2 Change to the directory where the client software archive file you 
downloaded is located.

3 Unbundle the snfs_client_Debian60_26x86_64.bin package.

4 When you are presented with the StorNext End User License 
Agreement (EULA), press <ENTER> to read the EULA. After reading 
the EULA enter y to accept the EULA, or enter any other key to 
decline. 

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 

<file system> <mount point> cvfs rw 0 0

mount -t cvfs <file system/volume> <mount point>
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Installation Software on page 129). 

Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 

 
where <archive name> is the name of the client software 
archive file you downloaded, and <dir> is the directory 
into which you want to extract the installation files.

Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 

 
where <archive name> is the name of the client 
software archive file you downloaded, and <dir> is 
the directory into which you want to extract the 
installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

5 From the /tmp/stornext directory, install the client and common 
software pacakges:

Example:

# ./<archive name> -d <dir>

# ./<archive name> -d <dir>
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6 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP 
address of the MDC to which the StorNext or StorNext FX client will 
connect.

The fsnameservers file on the client must be exactly the same as on 
the MDC. If the fsnameservers file does not exist, use a text editor to 
create it.

Note: The fsnameservers file needs to contain only the IP address 
of the MDC.

7 For StorNext FX clients ONLY, copy the .auth_secret file from the 
Xsan MDC to /usr/cvfs/config/.auth_secret on the client system.

8 If this is a SAN client, check to make sure LUNs are visible. At the 
command prompt, type:

9 Create a mount point.

Example:

Where <snfs1> is the name of the StorNext File System/Xsan 
volume you are using on your system.

10 Edit the /etc/fstab to add the client mount options.

Example:

Where <snfs1> is the name of the StorNext File System/Xsan 
volume you are using on your system.

dpkg -i snfs-client-4.7.0-3xxxx.Debian60.x86_64.deb

dpkg -i snfs-common-4.7.0-xxxxx.x84_64.deb

/usr/cvfs/bin/cvlabel -l

/stornext/<snfs1>

<snfs1> /stornext/snfs1 cvfs rw 0 0
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11 Start the file system service. At the command prompt, type:

12 Verify file systems are mounted.

Installing StorNext 
Client Software on Sun 
Solaris

To run the StorNext Client software on Sun Solaris, first install the client 
software package, and then configure the client.

1 Log on to the StorNext Client system as root.

2 Change to the directory where the client software archive file you 
downloaded is located.

3 Run the client software binary. At the command prompt, type:

where <archive name> is the name of the client software archive 
file you downloaded. (For example, the file for RH5 is 
snfs_client_RedHat50AS_26x86_64.bin)

4 When you are presented with the StorNext End User License 
Agreement (EULA), press <ENTER> to read the EULA. After reading 
the EULA enter y to accept the EULA, or enter any other key to 
decline. 

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 
Installation Software on page 129). 

service cvfs start

./<archive name>
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Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 
 

 
where <archive name> is the name of the client software 
archive file you downloaded, and <dir> is the directory 
into which you want to extract the installation files.

Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 

 
where <archive name> is the name of the client 
software archive file you downloaded, and <dir> is 
the directory into which you want to extract the 
installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

5 Change to the /tmp/stornext directory.

6 Install the client software package. At the command prompt, type:

# ./<archive name> -d <dir>

# ./<archive name> -d <dir>

pkgadd -d .
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7 Type 1 to select the ADICsnfs package.

8 Type y to confirm installation of the ADICsnfs package. When 
installation is complete, type q to quit the installation program.

9 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP 
address of the MDC to which the client will connect.

The fsnameservers file on the client must be exactly the same as on 
the MDC. If the fsnameservers file does not exist, use a text editor to 
create it.

Note: The fsnameservers file needs to contain only the IP address 
of the MDC. For example, if the IP address for the MDC is 
192.168.143.1, then the fsnameservers file should contain 
a single line with 192.168.143.1

10 Create a mount point for the file system. At the command prompt, 
type:

where <mount point> is the directory path where you want the file 
system to be mounted. For example: /stornext/snfs1

11 Configure the file system to automatically mount after a reboot. To 
do this, edit the /etc/vfstab file so that it contains the following line:

where <file system> is the name of the StorNext file system and 
<mount point> is the directory path created in Step 10.

While a reboot is not required at this time, in the future, a reboot of 
the client will mount the StorNext file system at the mount point 
you specified.

12 Restart StorNext services on the solaris client. To restart the services, 
type:

mkdir -p <mount point>

chmod 777 <mount point>

<file system> - <mount point> cvfs 0 auto rw
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Note: To manually mount a file system, at the command prompt type: 
 
 

 
where <file system> is the name of the StorNext file system/
Xsan volume you will use, and <mount point> is the directory 
path where you want the file system to be mounted.

Installing StorNext 
Client Software on HP-
UX

To run the StorNext Client software on HP-UX, first install the client 
software package, and then configure the client.

1 Log on to the StorNext Client system as root.

2 Change to the directory where the client software archive file you 
downloaded is located.

3 Run the client software binary. At the command prompt, type:

where <archive name> is the name of the software archive file you 
downloaded from the MDC. (For example, the file for RH5 is 
snfs_client_RedHat50AS_26x86_64.bin)

4 When you are presented with the StorNext End User License 
Agreement (EULA), press <ENTER> to read the EULA. After reading 
the EULA enter y to accept the EULA, or enter any other key to 
decline. 

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 
Installation Software on page 129). 

/usr/cvfs/bin/cvfs stop and /usr/cvfs/bin/cvfs 
start

mount -F cvfs <file system/volume> <mount point>

./<archive name>
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Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 

 
where <archive name> is the name of the client software 
archive file you downloaded, and <dir> is the directory 
into which you want to extract the installation files.

Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 
 

 
where <archive name> is the name of the client 
software archive file you downloaded, and <dir> is 
the directory into which you want to extract the 
installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

5 Change directories to /tmp/stornext.

6 List the packages extracted from the software archive file. At the 
command prompt, type:

# ./<archive name> -d <dir>

# ./<archive name> -d <dir>

ls -l
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Identify the correct package to install. The correct package begins 
with snfs-client and ends with the .depot file name extension.

7 Install the client software package. At the command prompt, type:

where <package path and name> is the full path and name of the 
client software package you identified in Step 6.

8 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP 
address of the MDC to which the client will connect.

The fsnameservers file on the client must be exactly the same as on 
the MDC. If the fsnameservers file does not exist, use a text editor to 
create it.

Note: The fsnameservers file needs to contain only the IP 
address(es) of the MDC(s).

9 Create a mount point for the file system. At the command prompt, 
type:

where <mount point> is the directory path where you want the file 
system to be mounted. For example: /stornext/snfs1

10 Configure the file system to automatically mount after reboot. To do 
this, edit the /etc/fstab file so that it contains the following line:

where <mount point> is the directory path created in Step 9, and 
<file system> is the name of the StorNext file system.

swinstall -s <package path and name> -x 
mount_all_filesystems=false \*

mkdir -p <mount point>

chmod 777 <mount point>

<mount point> <mount point> cvfs rw,fsname=<file 
system> 0 0
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11 Reboot the client system.

After reboot, the StorNext file system is mounted at the mount 
point you specified.

Note: To manually mount a file system, at the command prompt, 
type: 
 
 

 
where <mount point> is the directory path where you want the 
file system to be mounted.

Installing StorNext 
Client on IBM AIX

To run the StorNext Client software on IBM AIX, first install the client 
software package, and then configure the client.

1 Log on to the StorNext Client system as root.

2 Change to the directory where the client software archive file you 
downloaded is located.

3 Run the client software binary. At the command prompt, type:

where <archive name> is the name of the software archive file you 
downloaded. (For example, the file for RH5 is 
snfs_client_RedHat50AS_26x86_64.bin .)

4 When you are presented with the StorNext End User License 
Agreement (EULA), press <ENTER> to read the EULA. After reading 
the EULA enter y to accept the EULA, or enter any other key to 
decline. 

After you accept the EULA, the client software is extracted to  
/tmp/stornext (or to another directory if you specified an alternate 
location; see Ensuring You Have Enough Space to Extract the 
Installation Software on page 129). 

mount -F cvfs <mount point> <mount point>

./<archive name>
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Note: If the directory into which the files are being extracted does 
not have enough space, the installation will fail and you 
will receive an error message. You will need to identify an 
alternate location into which to extract the files by entering 
the following command:  
 
 

 
where <archive name> is the name of the client software 
file you downloaded, and <dir> is the directory into which 
you want to extract the installation files.

Caution: If the directory into which the files are being extracted 
already exists, you will receive a warning message. If 
this occurs, either remove the directory and try the 
installation again, or change the installation directory 
by entering the following command:  
 
 

 
where <archive name> is the name of the client 
software file you downloaded, and <dir> is the 
directory into which you want to extract the 
installation files.  
 
It is NOT recommended that you force using an existing 
directory (by using the -f command) because this 
could lead to additional problems installing the .rpm 
files.

5 Change directories to /tmp/stornext.

6 List the packages extracted from the software archive file. At the 
command prompt, type:

# ./<archive name> -d <dir>

# ./<archive name> -d <dir>

ls -l
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Identify the correct package to install. The correct package begins 
with snfs and ends with the .bff file name extension.

7 Install the client software package. At the command prompt, type:

where <package name> is the name of the client software package 
you identified in Step 6.

8 Edit the /usr/cvfs/config/fsnameservers file for the IP address of the 
MDC to which the client will connect.

The fsnameservers file on the StorNext Client must be exactly the 
same as on the MDC. If the fsnameservers file does not exist, use a 
text editor to create it.

Note: The fsnameservers file needs to contain only the IP 
address(es) of the MDC(s).

9 Create a mount point for the file system. At the command prompt, 
type:

where <mount point> is the directory path where you want the file 
system to be mounted. For example: /stornext/snfs1

10 Configure the file system to automatically mount. At the command 
prompt, type:

installp -ac -d <package name> all

mkdir -p <mount point>

chmod 777 <mount point>

crfs -v cvfs -d <file system> -a verbose=yes -a 
type=cvfs -A yes -m <mount point>
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where <file system> is the name of the StorNext file system and 
<mount point> is the directory path created in Step 9.

The StorNext file system is mounted at the mount point you 
specified.

Note: To manually mount a file system, at the command prompt, 
type: 
 
 

 
where <mount point> is the directory path where you want the 
file system to be mounted.

11 Start the new StorNext client software. At the command prompt, 
type:

Alternatively, you can reboot the system.

Installing StorNext and StorNext FX Client Software on 
Windows

The StorNext setup wizard guides you through the process of installing 
the StorNext and StorNext FX client software on Windows machines.

If you did not install all StorNext components when you initially installed 
StorNext or wish to remove them later, you can add or remove 
components at any time (see Adding or Removing StorNext 
Components on page 159). 

(Optional) After installation, restore the previous client configuration 
(see Restoring a Previous StorNext or StorNext FX Client Configuration 
on page 161). This is only necessary if you have performed a complete 

mount <mount point>

/etc/rc.cvfs start
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removal of StorNext. The StorNext and StorNext FX client configurations 
are fully maintained on upgrades from version 3.0 and later.

As new versions of StorNext are released, you can upgrade to a new 
version or reinstall (see Upgrading or Reinstalling StorNext and StorNext 
FX Clients on page 164).

Note: You must log on as an Administrator to install StorNext.  
 
If you are installing on Windows Vista, answer Yes to any 
messages asking if you want to run the installation process 
with administrative privileges.

To Install the StorNext or StorNext FX client on Windows:

1 Download the StorNext or StorNext FX client software from the 
MDC as described in Downloading StorNext Client Software on 
page 129 or Downloading StorNext FX Client Software on 
page 132.

Note: If you are running SNFS-only on a Windows machine or have an 
Xsan MDC, you cannot download the StorNext nor StorNext FX 
client software from the MDC. Instead, you will need to obtain 
the StorNext or StorNext FX client software from the StorNext 
installation DVD. Copy one of the following files from the DVD 
and place it in an accessible location on the client system, then 
proceed to the next step. 

• fs_only/snfs_client_Windows_i386.zip (for 32-bit systems)

• fs_only/snfs_client_Windows_x86_64.zip (for 64-bit systems)

2 If necessary, unzip the client software file you downloaded. 

3 Open the unzipped folder and double-click the client software 
installer file. This file is named SnfsSetup.exe.

The StorNext Installation window appears (Figure 55).
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Figure 55  StorNext Installation 
Window: Install StorNext

4 Click Install StorNext to begin installation.

The StorNext File System License Agreement window appears.

5 Read the license. If you agree to the terms, select “I accept the terms 
in the License Agreement” and click Next to continue the install.

The StorNext setup wizard launches (Figure 56). 

Figure 56  Client Setup: Setup 
Wizard

6 Click Next to continue.
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The Customer Information window appears (Figure 57). 

Figure 57  Client Setup: 
Customer Information

7 Type your name and the name of your company or organization in 
the boxes, and then click Next to continue.

The Choose Setup Type window appears (Figure 58).

Figure 58  Client Setup: Choose 
Setup Type 
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8 Click one of the following installation options. Since this is a client-
only install, you should select Client Only or Custom.

• Client Only: Installs the StorNext client software and help files 
in the default location (C:\Program Files\StorNext).

• Custom: Lets you choose which components to install and 
specify an installation location. When ready, click Next.

• Complete: All installable components will be installed in the 
default location (C:\Program Files\StorNext). Since this is a 
client-only install, only the client software and help files will be 
installed (the same as if you selected the Client Only option).

The Ready to Install window appears (Figure 59).

Figure 59  Client Setup: Ready 
to Install 

9 Click Install to continue.

Wait while the setup wizard installs StorNext. When installation is 
complete, the Finish window appears (Figure 60). (It may take 
several minutes for the installation to finish.)
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Figure 60  Client Setup: Finish 

10 Click Finish to close the setup wizard.

The Installation Complete dialog box opens (see Figure 61).

Figure 61  Client Setup: 
Installation Complete

11 Click OK in the Installation Complete dialog box.

The StorNext Installation screen displays again with choices to 
Add/Remove Components, Remove StorNext, or Configure StorNext 
(Figure 62).
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Figure 62  Client Setup: Add/
Remove Components

12 The installation is complete. Click one of the following options:

• Add/Remove Components: The components you selected 
during the install are already added, but if you changed your 
mind and want to select different components, you can do so 
now. See Adding or Removing StorNext Components on 
page 159 for details.

• Remove StorNext: Removes StorNext file system. For more 
information, see Removing StorNext Using the StorNext 
Software on page 184.

• Configure StorNext: Configures the StorNext or StorNext FX 
client. For more information, see Configuring the StorNext and 
StorNext FX Client on Windows on page 156. 

• Exit: Exits without making any further changes at this time (you 
can always perform configuration later).
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Configuring the StorNext and StorNext FX Client on 
Windows

Configuring StorNext and StorNext FX clients on Windows is similar to 
configuring a StorNext File System, but with more limited configuration 
options.

Note: For StorNext or StorNext FX clients on Windows, copy the 
.auth_secret file from the Xsan MDC to the following directory 
on the Windows system: 
 
c:/Program Files/StorNext/config/.auth_secret

To configure the StorNext or StorNext FX client software on Windows 
operating systems, use the Windows configuration utilities.

The following tools are provided with the StorNext Configuration utility, 
which is accessible from the StorNext Installation program:

• Name Servers: Configure StorNext name servers.

• Import/Export Client Settings: Import or export StorNext registry 
settings from or to a file.

• Client Configuration: Configure drive mappings and other 
StorNext client options.

Additional tools are accessible from the Windows Start menu (see 
Additional Windows Configuration Utilities on page 158).

Important StorNext FX 
Client-only Procedure

For StorNext FX clients ONLY, copy the .auth_secret file from the Xsan 
MDC to c:/Program Files/StorNext/config/ on the client system.

Accessing the 
Configuration Utility

1 Open the StorNext Installation window by double-clicking the file 
named SnfsSetup32.exe (32-bit systems) or SnfsSetup64.exe (64-
bit systems).

The StorNext Installation window displays appears (Figure 63).
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Figure 63  StorNext Installation 
Window: Upgrade/Reinstall 
StorNext

2 Click Configure StorNext. 

The StorNext Configuration screen appears (Figure 64).

Figure 64  StorNext 
Configuration
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3 Click one of the following options:

• Name Servers: This feature is described in Configuring Name 
Servers on page 73.

• Import/Export Client Settings: This feature is described in 
Restoring a Previous StorNext or StorNext FX Client 
Configuration on page 161.

• Client Configuration: This feature is described in Configuring 
the Client on page 90.

Additional Windows 
Configuration Utilities

The following additional configuration utilities are accessible from the 
Windows Start menu (Start > All Programs > StorNext File System).

For instructions on using any of these utilities, see the online help 
accessible from Start > All Programs > StorNext File System > 
StorNext Help.

• License Identifier: Use this utility to display the host license 
identifier. The host license identifier is required to obtain a 
permanent license for StorNext. For details, see Retrieving the Host 
License Identifier on page 70.

• Services Start: Use this utility to start all StorNext services on an 
MDC or StorNext client. For details, see Starting File System Services 
on page 106.

• Services Stop: Use this utility to stop all StorNext services on an 
MDC or StorNext client. For details, see Stopping File System 
Services on page 106.

• Services Stop and Remove: Use this utility to stop all StorNext 
services on an MDC or StorNext client, and also remove registry 
entries that automatically start the services on bootup. For details, 
see Stopping and Removing File System Services on page 107.

• StorNext Help: View StorNext help for these utilities and other 
commands.

• Version Information: View information about the currently 
installed version of the StorNext server and/or client software, such 
as the version number, build number, and platform. For details, see 
Obtaining Version Information on page 107.
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Adding or Removing 
StorNext Components

After installing the StorNext or StorNext FX client, you may wish to add 
or remove components. If you installed the client only, you can add or 
remove the online help files or the StorNext or StorNext FX client.

1 If you just completed installing the client, the StorNext Installation 
window displays (Figure 65). The components you selected during 
the install are already added, but if you changed your mind and 
want to select different components, you can do so now. 

Figure 65  StorNext Installation 
Window: Add/Remove 
Components 

If you previously installed StorNext and would like to add or remove 
components, display the StorNext Installation window by double-
clicking the file named SnfsSetup32.exe (32-bit systems) or 
SnfsSetup64.exe (64-bit systems). Note that the screen is slightly 
different from Figure 65 above: instead of Add/Remove 
Components, the button you need to click is called Upgrade/
Reinstall StorNext (see Figure 66). 
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Figure 66  StorNext Installation 
Window: Upgrade/Reinstall 
StorNext

2 Click Add/Remove Component or Upgrade/Reinstall StorNext, 
depending on which screen you are looking at. 

The Component Selection screen appears (Figure 67). 

Figure 67  Component 
Selection

3 Select the check boxes of the components you want to add. Clear 
the check boxes of the components you want to remove. Click Next 
to proceed.

The StorNext EULA appears. 
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4 Read and accept the EULA by selecting “I accept the terms in the 
License Agreement” and clicking Next.

It make take several minutes for the selected components to finish 
being added or removed. 

5 When a message informs you that the process is complete, click OK.

6 Click Exit.

Restoring a Previous 
StorNext or StorNext FX 
Client Configuration

StorNext and StorNext FX client configuration files are automatically 
saved when you remove StorNext, or can be manually saved for backup 
purposes.

If you want to restore a saved a client configuration file, you can import 
it using the StorNext Installation tool. This configures StorNext using the 
settings from a previous installation.

1 Start the StorNext installation tool if it is not already running by 
double-clicking the file named SnfsSetup32.exe (32-bit systems) or 
SnfsSetup64.exe (64-bit systems). (See Step 1 and Step 2 of 
Installing StorNext and StorNext FX Client Software on Windows on 
page 149.)

The StorNext Installation window appears (Figure 68).

Figure 68  StorNext Installation 
Window: Configure StorNext

2 Click Configure StorNext.
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The StorNext Configuration window appears (Figure 69).

Figure 69  StorNext 
Configuration Window

3 Click Import/Export Client Settings.

The Import/Export Client Configuration window appears 
(Figure 70).
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Figure 70  Import/Export Client 
Configuration Window

4 Under Import, click Browse. Locate the client configuration (*.reg) 
file to import, and then click Open.

Client configuration files saved during removal of a previous version 
of StorNext are located in the following directory by default:

C:\Program Files\StorNext\config\ 

5 Click an option for handling current configuration settings:

• Merge with current configuration: The imported 
configuration is merged with the current configuration settings. 
Imported mount information is added to, or overwrites, existing 
information.

• Replace current configuration: The current mount information 
is completely removed and replaced by the imported 
configuration.

6 Click Import, and then click Yes to confirm.
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A message appears informing you the configuration settings were 
successfully added to the registry.

7 Click OK, and then click Quit to close the Import/Export Client 
Configuration window.

Upgrading or 
Reinstalling StorNext 
and StorNext FX Clients

The Upgrade/Reinstall button allows you to upgrade to a new version 
of StorNext or StorNext FX client software, or reinstall the current 
version. You might want to reinstall if you accidentally removed some 
components and need to get them back. During an upgrade/reinstall, 
the old software is removed and the new software is installed. Your 
previous configuration settings remain intact. 

1 To upgrade or reinstall a StorNext or StorNext FX client after the 
initial installation, download the new client software from the MDC 
as described in Downloading StorNext Client Software on page 129. 

Exception: If you are running SNFS-only on a Windows machine, 
you cannot download the client software from the MDC. Instead, 
you will need to obtain the client software from the StorNext 
installation DVD. Copy one of the following files from the DVD and 
place it in an accessible location on the client system, then proceed 
to the next step. 

• fs_only/snfs_client_Windows_i386.zip (for 32-bit systems)

• fs_only/snfs_client_Windows_x86_64.zip (for 64-bit systems)

2 If necessary, unzip the client software file you downloaded. 

3 Open the unzipped folder and double-click the client software 
installer file. This file is named SnfsSetup32.exe (32-bit systems) or 
SnfsSetup64.exe (64-bit systems). 

The StorNext Installation screen appears (Figure 71).
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Figure 71  StorNext Installation 
Window: Upgrade/Reinstall 
StorNext

4 Click Upgrade/Reinstall StorNext.

The StorNext Component Selection window appears (Figure 72). 

Figure 72  Component 
Selection

5 Select the check boxes of the components you want to include in 
the upgrade. Clear the check boxes of the components you want to 
exclude. Click Next to proceed.

The StorNext EULA appears. 

6 Read and accept the EULA by selecting “I accept the terms in the 
License Agreement” and then clicking Next.

It make take several minutes for the selected components to finish 
being added or removed. 
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7 When a message informs you that the installation is finished, click 
OK.
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Configuring LAN Clients and 

Gateway Servers

Linux or Windows StorNext clients can be configured as LAN (local area 
network) clients or gateway servers (including the StorNext G300 
Gateway Appliance and the M660 Metadata Appliance). The StorNext 
G300 is a dedicated gateway server. The M660 is a meta-data controller 
(MDC) that can be configured as a gateway server (in non-Lattus 
systems only).

Traditional StorNext SAN clients access data storage (hard disk drives) in 
the SAN using a high throughput, low-latency fibre channel connection. 
In addition to this fibre channel connection, StorNext also provides 
access for LAN clients through a StorNext G300 or M660, or SAN client 
configured as a gateway for those LAN clients. In this environment, 
StorNext LAN clients access data disks over a network instead of directly 
accessing disks on the SAN.

A StorNext client running on Linux or Windows can be configured as a 
LAN client or a gateway. (This is a licensed feature.)

• Gateway: A gateway is a StorNext client which has direct access to 
data disks (using fibre channel) on the SAN and makes the shared 
storage pool available to LAN clients over a LAN connected to that 
gateway.

• LAN Client: A LAN client does not have direct access to data disks 
and instead accesses the shared storage pool by connecting to a 
gateway over a network. (LAN clients have full StorNext client 
functionality.)
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Note: A StorNext client configured as a gateway requires a dedicated 
system. Do not run other applications or services on a system 
configured as a gateway.

Note: Do not enable gateway functionality for MDCs connected to 
Lattus systems. While there are no functional issues in enabling 
the LAN gateway functionality within a Lattus environment, 
observed throughput when moving data to Lattus through the 
10GbE ports will be slower than expected if this feature is 
enabled.

This chapter covers:

• Configuring a StorNext LAN Client on Linux

• Configuring a Gateway Server on Linux

• Linux LAN Clients or Gateway Servers in HA Environments

• Configuring LAN Clients or Gateway Servers on Windows

• Configuring Gateway Functionality on an MDC

Configuring a StorNext LAN Client on Linux

To configure a StorNext client as a StorNext LAN client, edit mount 
options in the /etc/fstab file.

1 Stop the StorNext client. At the command prompt, type:

2 Configure the client to mount a file system as a LAN client. To do 
this, edit the /etc/fstab file so that it contains the following line:

/etc/init.d/cvfs stop

<file_system> <mount_point> cvfs 
rw,diskproxy=client 0 0
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where <file_system> is the name of the StorNext file system and 
<mount_point> is the directory path where the file system is 
mounted.

3 Start the StorNext client. At the command prompt, type:

Configuring a Gateway Server on Linux

To configure a StorNext SAN client as a gateway server, edit mount 
options in the /etc/fstab file, and then configure gateway server 
options.

Note: The StorNext G300 and M660 come pre-configured as 
gateways. Do not use these commands to configure those 
systems.

1 Stop the StorNext SAN client. At the command prompt, type:

2 Configure the client to mount a file system as a gateway. To do this, 
edit the /etc/fstab file so that it contains the following line:

where <file_system> is the name of the StorNext file system and 
<mount_point> is the directory path where the file system is 
mounted.

3 Change to the /usr/cvfs/bin/ directory.

4 Launch the StorNext gateway configuration utility. At the command 
prompt, type:

/etc/init.d/cvfs start

/etc/init.d/cvfs stop

<file_system> <mount_point> cvfs 
rw,diskproxy=server 0 0
StorNext and StorNext FX 4.7.x Installation Guide 169



Chapter 5: Configuring LAN Clients and Gateway Servers
Configuring a Gateway Server on Linux
Note: To get help for the sndpscfg utility, at the command 
prompt, type: ./sndpscfg -h

The gateway configuration utility appears (Figure 73).

Figure 73  sndpscfg 
Configuration Utility

5 Edit the default gateway configuration:

• (Required) Uncomment (delete the # next to) the line that 
corresponds to the network interface used by the gateway server 
when connecting to LAN clients. (For best performance, do not 
choose the network used for metadata.)

• (Optional) To change a tunable parameter from the default value, 
uncomment the parameter, and then specify a new value. Table 18 
describes the tunable parameters.

Note: The gateway configuration utility uses the default text 
editor. If a default text editor has not been specified, the 
utility uses the vi editor.

./sndpscfg -e
170 StorNext and StorNext FX 4.7.x Installation Guide 



Chapter 5: Configuring LAN Clients and Gateway Servers
Configuring a Gateway Server on Linux
Table 18  Gateway Parameters

6 When you are done making edits, type :x to save and close the 
configuration file.

The configuration is saved in the file dpserver in the /user/cvfs/
config/ directory.

Note: To edit this file at a later date, you can run the sndpscfg 
utility again or edit the dpserver file directly.

7 Start the StorNext SAN client, which is now functioning as a 
gateway server. At the command prompt, type:

Creating an Override Configuration

By default, the settings specified in the dpserver configuration file are 
used for all file systems mounted by the gateway server. To use different 

Field / Button Description

tcp_window_size_kb The TCP window size (in KB) used by the 
gateway server. (Default: 64)

transfer_buffer_size_
kb 

The transfer buffer size (in KB) used by the 
gateway server. A larger buffer may 
increase performance for larger files. 
(Default: 256)

transfer_buffer_coun
t

The number of transfer buffers used by the 
gateway server. This parameter is used only 
by Windows servers and clients. Linux 
servers pass the value of this parameter to 
Windows clients. (Default: 16)

server_buffer_count The number of I/O buffers allocated for 
each network interface on the gateway 
server. This parameter is used only by Linux 
servers. (Default: 8)

daemon_threads The maximum number of daemon threads 
used by the gateway server. (Default: 8)

/etc/init.d/cvfs start
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settings for a file system, create an override configuration file for that 
file system. At the command prompt, type:

where <file_system> is the name of the file system to which the 
override settings apply. Edit the configuration file, and then save and 
exit. A new configuration file with the name dpserver. <file_system> 
is created in the /user/cvfs/config/ directory.

Using LAN Client and Server Commands

Use the cvadmin commands described in Table 19 to see information 
about gateway servers and LAN clients. (For more information about 
using cvadmin commands, see the MAN Pages Reference Guide.)

Table 19  LAN Client and 
Gateway Server Commands

/usr/cvfs/bin/sndpscfg -E <file_system>

Command Description

proxy Lists all gateway servers for the 
currently selected file system.

proxy long Lists all gateway servers for the 
currently selected file system, as well 
as tunable parameters and attached 
disks.

proxy who 
<LAN_client>

Lists gateway servers connected to 
the specified LAN client, as well as 
current I/O statistics.

proxy who 
<gateway_server>

Lists LAN clients connected to the 
specified gateway server, as well as 
current I/O statistics.
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Linux LAN Clients or Gateway Servers in HA 
Environments

When a StorNext High Availability (HA) configuration is used and the 
StorNext LAN Client/Gateway Server feature is configured on the HA 
server nodes, each node in the HA pair should be configured separately 
and independently. This allows for the best and highest availability of 
the LAN client capability.

Ideally, each node in the HA pair should have the same number of 
network interfaces and be on the same networks. The dpserver 
configuration should be done before converting an MDC pair into an HA 
pair.

When deduplication/replication is enabled, Virtual IPs (VIPs) are 
configured and applied to the active blockpool server. In such a setting, 
the network interface(s) with VIP configured can potentially have more 
than one IP addresses (physical and virtual IPs). If such an interface is 
also used for a LAN client, use the interface with the physical IP address 
to specify the network interface.

Configuring LAN Clients or Gateway Servers on 
Windows

To configure a Windows client as a gateway server or a LAN client, use 
the Windows Client Configuration utility (see Configuring LAN Clients 
and Gateway Servers on page 94).
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Configuring Gateway Functionality on an MDC

The StorNext M660 Metadata Appliance and appropriately provisioned 
Metadata Controllers (MDCs) can be configured to also operate as a 
LAN gateway. The following instructions describe the steps to configure 
gateway functionality on MDCs.

Note: Do not enable gateway functionality for M662s connected to 
Lattus systems. While there are no functional issues in enabling 
the LAN gateway functionality within a Lattus environment, 
observed throughput when moving data to Lattus through the 
10GbE ports will be slower than expected if this feature is 
enabled.

Enabling Gateway 
Functionality on an 
MDC

To enable gateway functionality:

1 Log on to the primary and, if applicable, secondary nodes using as 
the “stornext” user with the default password of password.

2 Run the sudo rootsh command to gain root access.

3 At the command prompt, type:

4 Select an appropriate interface and set tuning parameters.This 
creates or updates /usr/cvfs/config/dpserver.

Note: This must be done on both the primary and secondary nodes, if 
applicable. This file is not synchronized from the primary to the 
secondary node.

5 For HA pairs, update the /usr/cvfs/config/sngateway_config file so 
that both files include the IP address of both MDC nodes.

6 On the primary node, edit the /etc/fstab file. Add the following to 
the mount option on the file system to be used as the gateway:

/usr/cvfs/bin/sndpscfg -e
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For example, the file system mount option:

Becomes:

Note: If the file system being configured is a managed file system, 
stop the TSM processes before unmounting the file system. At 
the command prompt, type: 
 
 

7 On the primary node, un-mount and re-mount the file system.

At the command prompt, type:

8 If Gateway functionality is being configured on a single-node MDC 
continue to Step 12. Otherwise continue on with the next steps to 
complete the configuration on the secondary MDC node.

9 On the secondary node, wait for the /etc/fstab change to 
synchronize with the primary node. It should take less than two 
minutes for the change to appear in this file.

10 When you see diskproxy=server change in the fstab file on the 
secondary, un-mount and re-mount the file system on the 
secondary.

diskproxy=server

snfs1 /stornext/snfs1 cvfs rw 0 0

snfs1 /stornext/snfs1 cvfs rw,diskproxy=server 0 0

TSM_control stop

umount /stornext/snfs1

mount snfs1
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11 Run the mount command with no parameters on both the primary 
and secondary nodes. Verify that the file system is mounted and 
that the diskproxy=server mount option is present.

Example output:

12 If the TSM processes were stopped, restart the TSM process from 
the primary MDC. At the command prompt, type:

/dev/cvfsctl2_snfs1 on /stornext/snfs1 type cvfs 
(rw,diskproxy=server,sparse=yes)

TSM_control start
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Disabling Gateway 
Functionality on an MDC

To disable gateway functionality on these devices:

1 Log into the primary MDC node, and, if applicable, the secondary 
MDC node as root.

2 On the primary node, edit the /etc/fstab file. Remove the following 
from the mount option on the file system to be used as the 
gateway:

For example, the file system mount option:

Becomes:

Note: If the file system being configured is a managed file system, 
stop the TSM processes before unmounting the file system. At 
the command prompt, type: 
 
 

3 On the primary node, un-mount and re-mount the file system.

At the command prompt, type:

4 If Gateway functionality is being removed from a single-node MDC 
continue to Step 8. Otherwise continue on with the next steps to 
complete the configuration on the secondary MDC node.

diskproxy=server

snfs1 /stornext/snfs1 cvfs rw,diskproxy=server 0 0

snfs1 /stornext/snfs1 cvfs rw 0 0

TSM_control stop

umount /stornext/snfs1

mount snfs1
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5 On the secondary node, wait for the /etc/fstab change to 
synchronize with the primary node. It should take less than two 
minutes for the change to appear in this file.

6 When you see diskproxy=server removed from the fstab file on the 
secondary, un-mount and re-mount the file system on the 
secondary.

7 Run the mount command with no parameters on both the primary 
and secondary nodes. Verify that the file system is mounted and 
that the diskproxy=server mount option has been removed.

Example output:

8 If the TSM processes were stopped, restart the TSM process from 
the primary MDC. At the command prompt, type:

/dev/cvfsctl2_snfs1 on /stornext/snfs1 type cvfs 
(rw,sparse=yes)

TSM_control start
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Appendix A
Uninstalling StorNext

If you no longer need to use StorNext, uninstall the software to remove 
it from your system. To uninstall StorNext, use the appropriate method 
for your operating system:

• Uninstalling StorNext on Linux on page 179

• Uninstalling StorNext on Windows on page 184

Uninstalling StorNext on Linux

To uninstall StorNext on a Metadata Controller (MDC), use the 
installation script (see Uninstalling SNSM and SNFS on page 179).

To uninstall the StorNext client software, use the appropriate method 
for your operating system (see Uninstalling the StorNext Client Software 
on page 181).

Uninstalling SNSM and 
SNFS

To uninstall StorNext File System and Storage Manager on an MDC 
running Unix or Linux, run the installation script with the -remove or  
-removeall option. To launch the script, access the folder for your 
operating system on the StorNext installation DVD.
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1 Log on to the MDC as root.

2 Mount the StorNext installation DVD and change to the DVD root 
directory.

Note: When you mount a DVD in a Red Hat 5 system, DVDs are 
mounted by default with a noexec (non-executable) option 
which prevents you from proceeding with the installation. 
 
For Red Hat users only, before proceeding you must 
remount the DVD by typing  
 
 

3 List the installation directories on the DVD. At the command 
prompt, type:

4 Identify the correct installation directory for your operating system 
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 5 running on an x86 64-bit platform, 
change to the RedHat50AS_26x86_64 directory.

5 Do one of the following steps:

• (Recommended) Completely uninstall StorNext and return the 
system to a pristine state. At the command prompt, type:

• Uninstall StorNext binaries but leave files that are useful if you 
are going to perform an HA upgrade (such as license files, some 
configuration files, and log files). At the command prompt, 
type:

mount -o remount, exec ...

ls -l

./install.stornext -removeall

./install.stornext -remove
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The installation script runs (Figure 74).

Figure 74  StorNext Remove 
Main Menu

6 Type 2 and press <Enter>.

Uninstalling the 
StorNext Client 
Software

To uninstall the StorNext client software, unmount all file systems and 
stop StorNext software. Then remove the client software package using 
the appropriate command for your operating system.

Note: This procedure removes the client software only. To uninstall 
StorNext File System and Storage Manager, see Uninstalling 
SNSM and SNFS on page 179.

1 Unmount all file systems. To unmount a file system, at the 
command prompt, type:

umount <mount_point>

where <mount_point> is the location where the file system is 
mounted.

2 Stop the StorNext client software. At the command prompt, type:

• HP-UX:

• IBM AIX:

/sbin/init.d/cvfs fullstop

/etc/rc.cvfs fullstop
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• Solaris:

• Others:

3 Remove the StorNext software package using the correct commands 
for your operating system.

• Linux:

where <package_name> is the name of the client software 
package that was installed.

• Solaris:

• HP-UX:

• IBM AIX:

where <package_name> is the name of the client software 
package that was installed.

/usr/cvfs/bin/cvfs fullstop

/etc/init.d/cvfs fullstop

rpm -e <package_name>

pkgrm ADICsnfs

swremove –x mount_all_filesystems=false 
snfsclient

installp –u <package_name>
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• SGI IRIX:

Note: If you do not know the package name, you can download 
the client software for your operating system and check the 
package name (see Downloading StorNext Client Software 
on page 129).

Uninstalling a StorNext 
RPM Server (SNFS 
server-only)

To uninstall the SNFS-only Server install, unmount all file systems and 
stop the SNFS software. Then remove the SNFS software package using 
the rpm command.

Note: This procedure only removes the RPM software. To uninstall 
StorNext File System with Storage Manager, see Uninstalling 
SNSM and SNFS on page 179.

1 Unmount all SNFS file systems using the following at the command 
prompt:

where <mount_point> is the location where the file system is 
mounted.

2 Stop the StorNext client software. At the command prompt, type:

3 Remove the StorNext software package using the following 
commands:

Inst

remove cv_base

remove cv_clnt

go

umount <mount_point>

/etc/init.d/cvfs fullstop
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where <package_name> is the name of the client software package 
that was installed

Uninstalling StorNext on Windows

There are two ways to uninstall StorNext (server or client) on Windows:

• Removing StorNext Using the StorNext Software

• Uninstalling Via the Windows Control Panel 

Either way will remove all installed StorNext components from your 
system, but will save the previous client configurations, debug file, and 
RAS files. All of the saved files are located in:

C:\Program Files\StorNext\config\ 

Note: Systems prior to StorNext 3.0 used the default directory 
C:\SNFS\config\.

Removing StorNext 
Using the StorNext 
Software

To remove StorNext using the StorNext software:

1 Start the StorNext installation tool if it is not already running by 
double-clicking the file named SnfsSetup32.exe (32-bit systems) or 
SnfsSetup64.exe (64-bit systems). 

The StorNext Installation window appears (Figure 75).

rpm -e <package_name>
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Figure 75  StorNext Installation 
Window: Remove StorNext

2 Click Remove StorNext.

3 Click OK to confirm you want to remove StorNext and all of its 
components.

A dialog box informs you that the current client configuration has 
been saved and lists the location. You can use this to restore the 
client configuration later if you wish.

4 Note the name and location of the saved configuration file, and 
then click OK.

5 If prompted, click Yes to continue, and then click OK to finish the 
removal.

6 When the removal is complete, you will be notified that you must 
reboot for the change to take effect. Click Yes to reboot the system 
immediately, or No to reboot later.

Uninstalling Via the 
Windows Control Panel

To uninstall StorNext (server or client) on a Windows system, use the 
Add or Remove Programs feature located on the Windows Control 
Panel. (On Windows Vista, Windows Server 2008 and later, the Control 
Panel feature is called Programs and Features.)

1 Open the Windows Control Panel.

2 Double-click Add or Remove Programs (or Programs and 
Features on Windows Vista or Windows Server 2008 and later).
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The Add or Remove Programs (or Programs and Features) 
window appears.

3 In the list of currently installed programs, click StorNext File 
System, and then click Remove.

4 Click Yes to confirm the removal.

5 After the uninstall process is complete, reboot the system.
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Use the following information to perform specific file system 
configuration tasks that do not apply to a typical StorNext set up.

This appendix covers:

• Sharing a Library Between Applications (Linux Only)

• Manually Modifying Storage Manager Configuration

• Connecting Xsan Clients to StorNext MDCs

• Viewing a Fibre Channel Device

• StorNext Log Rolling Administration

• Avoiding Poor System Performance

Sharing a Library Between Applications (Linux Only)

If two or more software applications (on one or multiple machines), are 
configured to use the same library, then you must use the following 
procedure to enable the library to be shared and to prevent media being 
overwritten when these applications are used. This task must be 
performed when the Configuration Wizard (CW) is run during initial 
StorNext setup and configuration. For more information on using the 
CW, see Using the StorNext Configuration Wizard on page 27.
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Caution: Quantum strongly recommends using library partitioning 
features to present each application using the library with 
its own virtual library. Unless partitioning is used, two 
applications sharing the robot arm, drives and slots may 
over-write each others data.  
 
Use the following instructions only if library partitioning is 
not an option. 

Note: For library sharing to be effective, the steps in the following 
procedure must be performed in the order in which they are 
presented.

You must have root privileges to perform this task.

1 When you match hardware devices to their correct slots on the 
Matched Devices With Slots screen (you will see this screen during 
the execution of Step 4 of the Configuration Wizard, Add Tape 
Drive), only configure the tape drives that your software application 
will use. You do not need to configure all tape drives listed as part of 
the library. 

2 Once the tape drives are added and configured in Step 4 of the CW 
(Add Tape Drive), but before continuing to Step 5 of the CW (Add 
Media), go to a Metadata Controller and perform these steps:

a Change directory to the config directory. Type:

cd /usr/adic/MSM/internal/config

b List all files in the config directory. Type: 

ls -l

c Using a text editor, edit the media_file_<library_name> file. 
For example:

vi media_file_<library_name>

The media_file contains a filter for barcode labels that are read 
by StorNext. This action is performed by using regular 
expressions. (A regular expression provides a mechanism to 
select strings from a set of character strings. In the above 
example, the character strings refer to the barcode labels.) In 
the example above, <library_name> is the library that was 
configured in Step 3, Add Library, of the CW. 
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d Set up the pattern matching of the media file.

Multiple entries may exist in the media file. Read the examples 
in the file to learn how to set up pattern matching. 

These are examples of pattern matching:

scsi_archive 1111.. (brings in all media with the 1111 prefix)

scsi_archive AB9... (brings in all six-character media labels with 
the AB9 prefix)

scsi_archive CLN1.. (brings in all media that have the CLN1 
prefix)

3 Continue to the Add Media section of the Configuration Wizard.

Caution: After this procedure is done, StorNext will not use other 
media, but other applications may try to overwrite 
StorNext media. To avoid data loss, be sure you configure 
the other application to prevent overwriting StorNext data.

Manually Modifying Storage Manager Configuration

StorNext employs global parameters that define the Storage Manager 
configuration. Although the default values in these files are sufficient 
for most installations, you can edit the files to customize the StorNext 
software for your specific installation. This section provides a procedure 
that can be used to modify the following StorNext configuration files:

• /usr/adic/TSM/config/fs_sysparm_override

• /usr/adic/TSM/config/filesize.config

• /usr/adic/TSM/logs/log_params

fs_sysparm_override 
Configuration File

The fs_sysparm_override configuration file is used to tune items 
related to system administration, drives and media, media manager 
interface, and other miscellaneous items. For more information about 
the parameters that can be placed into the fs_sysparm_override 
configuration file, refer to the fs_sysparm.README file.
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Caution: Incorrect modification of the fs_sysparm_override 
configuration file can cause a serious, adverse effect on 
StorNext functionality. Before modifying this file, Quantum 
recommends that you contact Quantum Global Services.

Caution: If you have files larger than 100GB and are using LTO2 
media, the MED_SEG_OVER_LTO parameter may be 
modified to a value less than or equal to 190G to reduce 
file fragmentation. This has the adverse effect of reducing 
the potential for parallel I/O for multiple file segments. 
Setting the MED_SEG_OVER_LTO parameter to a value 
larger than 190GB may result in allocation failures that 
prevent file movement to tape.

filesize.config 
Configuration File

The filesize.config configuration file is used to control the file steering 
feature and has these characteristics:

• Allows the placement of files on different media types, based on the 
size of the files

• Specifies which drive pool a policy class should use when storing 
data

• Contains specific syntax and usage information

• Enables the system administrator to make changes without 
recycling the Tertiary Manager software

log_params 
Configuration File

The log_params configuration file is used to control various levels of 
trace logging. The file specifies each log level and how to enable and/or 
disable it.

Use the following procedure to modify the fs_sysparm_override, 
filesize.config, or log_params configuration files.

1 Use a text editor to open one of the following configuration files:

• /usr/adic/TSM/config/fs_sysparm_override

• /usr/adic/TSM/config/filesize.config
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• /usr/adic/TSM/logs/log_params

2 Locate the parameter you want to modify and replace the setting 
with a new, valid value. 

When editing a file, be sure to follow the format used by entries in 
the file. For example, in the fs_sysparm_override and 
filesize.config files, all entries must be in the format: name=value;

3 Restart the Tertiary Manager software.

a Stop the software by typing TSM_control stop

b Restart the software by typing TSM_control start

Connecting Xsan Clients to StorNext MDCs

Requirements In order to connect Xsan Clients to StorNext MDCs, ensure the 
following:

• StorNext MDCs and Xsan clients must be connected to the same 
SAN and be able to see the same LUNs

• StorNext MDCs must have license.dat file in the configuration 
directory of the system. 
 
For Linux MDCs, the configuration directory is: 
 
Library/Preferences/Xsan 
 
For Windows MDCs, the configuration directory is: 
 
C:\Program Files\ StorNext\config\

• If the system configuration includes both Xsan and StorNext MDCs, 
and Xsan clients, ALL machines in the configuration must have the 
identical .auth_secret file. However, if the only MDC in use is a 
StorNext MDC, the .auth_secret file can be removed from the Xsan 
and StorNext FX clients.

• The fsnameservers file must be identical on all StorNext MDCs, 
StorNext and StorNext  FX clients, and Xsan clients.
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Mounting the StorNext 
File System on Xsan 2.3 
and Later Clients

To connect Xsan 2.3 and later clients to StorNext MDCs:

Note: Make sure the Xsan clients are not part of an existing Xsan 
MDC cluster. If they are, remove the clients using the Xsan 
Admin tool on the Xsan MDC. In addition, make sure your Xsan 
client does not have an .auth_secret file in the Xsan config 
directory.

1 Connect the Apple computer to the SAN's metadata Ethernet and 
fibre channel networks.

2 Create a /Library/Preferences/Xsan/config.plist file using the xml 
template below:

Note: Items in red indicate data you should enter which applies 
to your configuration. Do not enter the literal red text 
shown in the template.  
For example, for <stringMy IP Address</string you would 
enter your system metadata IP address or the regular 
system IP address, not the words “My IP Address.”

<?xml version=”1.0” encoding=”UTF-8”?>
<!DOCTYPE plist PUBLIC “-//Apple//DTD PLIST 1.0//EN”
“http://www.apple.com/DTDs/PropertyList-1.0.dtd”>
<plist version=”1.0”>
<dict>

<key>computers</key>
<array/>
<key>metadataNetwork</key>
<string>My IP Address</string>
<key>ownerEmail</key>
<string>me@mycompany.com</string>
<key>ownerName</key>
<string>My Name</string>
<key>role</key>
<string>CLIENT</string>
<key>sanName</key>
<string>My SAN name</string>
<key>serialNumbers</key>
<array>

<dict>
<key>license</key>
<string>xsan client license number</string>
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<key>organization</key>
<string>organization name</string>
<key>registeredTo</key>
<string>registered to name</string>

</dict>
</array>

</dict>
</plist>

3 From the StorNext MDC copy the fsnameservers file to /Library/
Preferences/Xsan on the Macintosh client.

On Unix: the fsnamerservers file is located at /usr/cvfs/config/.

On Windows: the fsnamerservers file is located at 
\%cvfsroot%\config\ (where %cvfsroot% is the directory where the 
StorNext software is installed). This directory is usually located in 
C:\Program Files\Stornext\config\.

Note: The content of the fsnameservers file should be an IP 
address, not a machine name or fully qualified domain 
name (FQDN).

4 Run the following in Terminal to update Xsan with the new file 
system information: 

Note: You can use the Preference Pane to disable and re-enable 
Xsan.

5 Run cvadmin to verify the file systems are present.

6 Run cvlabel -l to verify the all the luns used for file systems are 
displayed.

7 In the Terminal type Xsanctl mount <fsname>.

Where <fsname> is the file system name displayed in cvadmin.

8 Verify the /Library/Preferences/Xsan/automount.plist file is 
created.

9 Verify the StorNext file system is now mounted on the Mac OS X 
computer.

launchctl unload /System/Library/LaunchDaemons/com.apple.xsan.plist
launchctl load /System/Library/LaunchDaemons/com.apple.xsan.plist
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1 Connect the Apple computer to the SAN's metadata Ethernet and 
fibre channel networks.

2 Install Xsan 2 software on the Apple computer. (Xsan 2 is supported 
only by the Leopard operating system.)

3 Create the file /etc/systemserialnumbers/xsan using that 
Macintosh’s Xsan serial number.

You must create the directory /etc/systemserialnumbers if it 
doesn’t already exist. If an Xsan serial number has information 
printed for <Licensed to> and <Organization>, these must be 
part of the serial number string separated by a vertical bar or “pipe” 
character on two lines. For example: 

XSAN-020-XXX-X-XXX-XXX-XXX-XXX-XXX-XXX-X 
<Licensed to|<Organization>

Note: The file does not have a trailing return on the last line. Use 
the following: 
 

cat  /etc/systemserialnumbers/xsan  
 
and end with ^D^D (where ^D^D is Command-D 
Command-D)

Note: If you are unable to browse to the systemserialnumbers 
directory, use the cat or echo commands to insert 
information into the Xsan file under that directory.

4 Create a /Library/FileSystems/Xsan/config/config.plist file using 
the xml template below:

Note: Note: Items in red indicate data you should enter which 
applies to your configuration. Do not enter the literal red 
text shown in the template.  
For example, for <stringMy IP Address</string you would 
enter your system metadata IP address or the regular 
system IP address, not the words “My IP Address.”

<?xml version=”1.0” encoding=”UTF-8”?>
<!DOCTYPE plist PUBLIC “-//Apple//DTD PLIST 1.0//EN”
“http://www.apple.com/DTDs/PropertyList-1.0.dtd”>
<plist version=”1.0”>
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<dict>
<key>computers</key>
<array/>
<key>metadataNetwork</key>
<string>My IP Address</string>
<key>ownerEmail</key>
<string>me@mycompany.com</string>
<key>ownerName</key>
<string>My Name</string>
<key>role</key>
<string>CLIENT</string>
<key>sanName</key>
<string>My SAN name</string>
<key>serialNumbers</key>
<array>

<dict>
<key>license</key>
<string>xsan client license number</string>
<key>organization</key>
<string>organization name</string>
<key>registeredTo</key>
<string>registered to name</string>

</dict>
</array>

</dict>
</plist>

5 From the StorNext MDC, copy the fsnameservers file to the /
Library/Filesystems/Xsan/config/ directory on the Macintosh client. 
This file should contain the IP addresses of the name server 
machines.

On Unix: the fsnamerservers file is located at /usr/cvfs/config/.

On Windows: the fsnamerservers file is located at 
\%cvfsroot%\config\ (where %cvfsroot% is the directory where the 
StorNext software is installed). This directory is usually located in 
C:\Program Files\Stornext\config\.

Note: The content of the fsnameservers file should be an IP 
address, not a machine name or fully-qualified domain 
name (FQDN).

6 Run RegisterSeRV in Terminal to ensure that the serial number is 
recognized.
StorNext and StorNext FX 4.7.x Installation Guide 195



Appendix B: Administration Tasks
Connecting Xsan Clients to StorNext MDCs
7 Run the following in Terminal to update Xsan with the new file 
system information: 

Note: If you are using Xsan 2.3, you can use the Preference Pane 
to disable and re-enable Xsan.

8 Run cvadmin to verify the file systems are present.

9 Run cvlabel -l to verify the all the luns used for file systems are 
displayed.

10 In the Terminal type Xsanctl mount <fsname>.

Where <fsname> is the file system name displayed in cvadmin.

11 Verify the /Library/Filesystems/Xsan/config/automount.plist file is 
created.

12 Verify the StorNext file system is now mounted on the Xsan client.

Xsan 2.3 and later There are notable differences between earlier Xsan version 2.2 and Xsan 
2.3 or later. Before performing the procedures in these section you 
should determine which Xsan version you have and make adjustments 
as appropriate.

For example, file locations differ between earlier Xsan versions and Xsan 
2.3 or later, as noted in the following table:

Table 20  Xsan File Locations

launchctl unload /System/Library/LaunchDaemons/com.apple.xsan.plist
launchctl load /System/Library/LaunchDaemons/com.apple.xsan.plist

Xsan File Type Xsan 2.2 File Locations Xsan 2.3 and later File Locations

Bin Files /Library/Filesystems/Xsan/bin /System/Library/Filesystems/
acfs.fs/Contents/bin

And a symlink to /usr/sbin/

Config Files /Library/Filesystems/Xsan/
config

/Library/Preferences/Xsan 
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Other Xsan 2.3 and later Changes

Xsan 2.3 or later is built into the Macintosh operating system. 
Consequently, for 2.3 there is no serial number and nothing additional 
to install. (However, a StorNext Server license is still required for a 
StorNext Metadata Controller.)

Viewing a Fibre Channel Device

Use this procedure to add a fibre channel (FC) device. Before adding a 
FC device, first configure the Host Bus Adapter (HBA) card so you can 
view the device. Use the fs_scsi -p command to make sure you can view 
your devices over FC. FC devices include tape libraries, individual drives, 
or RAID disk.

1 Type the /usr/cvfs/bin/fs_scsi -p command to make sure that the 
necessary devices can be viewed over FC.

• To view tape libraries, access the StorNext GUI to view your tape 
libraries.

• To view individual drives or RAID LUNs, access either the StorNext or 
SNFS GUI.

Debug Logs /Library/Filesystems/Xsan/
debug

Xsan Debug logs are can be viewed 
via Console in this location: 
/Library/Logs/Xsan/debug

Man Pages /Library/Filesystems/Xsan/man /System/Library/Filesystems/
acfs.fs/Contents/man

RAS Logs /Library/Filesystems/Xsan/ras Xsan RAS logs are can be viewed via 
Console in this location: 
/Library/Logs/Xsan/ras

Xsan File Type Xsan 2.2 File Locations Xsan 2.3 and later File Locations
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To add a disk, see Chapter 6, “Managing the File System,” in the 
StorNext User’s Guide. To add a tape drive to a configured library, see 
Chapter 8, “Managing Drives and Disks,” in the StorNext User’s Guide.

StorNext Log Rolling Administration

Use the following procedures to configure StorNext log rolling options.

Changing Log Rolling 
Times

Use this procedure to change the frequency of rolling the StorNext logs. 
This process requires that you edit the tldm crontab to set log times. 
Use this procedure to edit tdlm crontab.

1 Log on as root.

2 Edit the tdlm crontab and update the sn_log_update script.

Below is an example crontab:

0 1,7,13,19 * * * /usr/adic/guib/bin/cmdwrap /usr/adic/util/
sn_log_update /usr/adic

where 0 1,7,13,19 * * * designates the times when logs run.

Log Rolling Options You can change these options to optimize log rolling.

• -s: This option sets the directory where logs are saved (copied) to as 
they are rolled. This directory is typically a managed directory. For 
example:

sn_log_update [-s <dir>] 

where <dir> is the directory where you want the logs to reside.

• $DEF_SIZE = 2000000: This is the default size at which logs are 
rolled. Edit this entry in the /usr/adic/util/sn_log_update.cfg file if 
you want the log sizes to be larger or smaller.

• $DEF_LOGS = 28: This is the default number of logs that are saved 
before they are deleted. Edit this entry in the /usr/adic/util/
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sn_log_update.cfg file if you want to save less than 28 logs or are 
saving the logs to a managed directory.

Avoiding Poor System Performance

Most systems run administrator scripts to rebuild namespace databases 
and/or to remove certain files. Unfortunately, running these scripts can 
degrade StorNext performance. It is recommended that you review 
administrator scripts to determine if they may adversely affect your 
StorNext installation and its performance.

For example, many UNIX systems have a find command in the root 
crontab that traverses the entire directory hierarchy while searching for 
old temporary and core files. Typically, the find commands are 
configured only to run on the local file system. However by default, 
these commands do not skip StorNext file systems because they are 
considered to be local, even though the file system manager may be 
running remotely. StorNext performance can be dramatically degraded 
when these commands visit a StorNext file system if the system contains 
a large number of files.

If StorNext performance is degraded to an unacceptable level due to the 
operation of administrator scripts, you can modify them to skip 
StorNext file systems. A sample command (original and modified is 
shown below:

On IRIX, by default, the root crontab contains the following find 
command:  

find / -local -type f '(' -name core -o -name dead.letter ')' -atime 
+7 -mtime + 7 -exec rm -f '{}' ';'

To prevent the find command from searching in StorNext file systems, 
modify it as shown:

'(' -type d -fstype cvfs -prune ')' -o

The modified find command looks like this:

find / -local '(' -type d -fstype cvfs ')' -o -type f '(' -name core -o -
name dead.letter ')' -atime +7 –mtime +7 -exec rm -f '{}' ';'
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StorNext creates a series of files that are used and modified to configure 
a file system. This section includes an expanded configuration file, a 
cluster-wide central control file, and a listing of the most commonly 
used StorNext files with descriptions and locations for each.

Example FSM Configuration File

On Linux, the StorNext configuration file uses an XML format (.cfgx). On 
Windows, the configuration file uses a text format (.cfg). However, the 
values contained in both files are similar.

You can locate an example StorNext configuration file in the following 
directory:

• Linux - /usr/cvfs/examples/example.cfgx

• Windows - C:\Program Files\Stornext\config\example.cfg

If you installed StorNext in a location other than the default 
installation directory, the example configuration file is located in 
C:\<install_directory>\config\example.cfg

For additional information about the snfs.cfgx and snfs.cfg files, refer to 
the “snfs_config” entry in the Man Pages Reference Guide.
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Linux Example 
Configuration File

Below are the contents of the StorNext example configuration file for 
Linux (example.cfgx):

<?xml version=”1.0” encoding=”UTF-8”?>
<configDoc xmlns=”http://www.quantum.com/snfs” version=”1.0”>

<config configVersion=”0” name=”example” fsBlockSize=”16384” 
journalSize=”16777216”>

<globals>
<abmFreeLimit>false</abmFreeLimit>
<allocationStrategy>round</allocationStrategy>
<haFsType>HaUnmonitored</haFsType>
<bufferCacheSize>33554432</bufferCacheSize>
<cvRootDir>/</cvRootDir>
<storageManager>false</storageManager>
<dataMigrationThreadPoolSize>128</dataMigrationThreadPoolSize>
<debug>00000000</debug>
<dirWarp>true</dirWarp>
<extentCountThreshold>49152</extentCountThreshold>
<enableSpotlight>false</enableSpotlight>
<enforceAcls>false</enforceAcls>
<fileLocks>false</fileLocks>
<fileLockResyncTimeOut>20</fileLockResyncTimeOut>
<forcePerfectFit>false</forcePerfectFit>
<fsCapacityThreshold>0</fsCapacityThreshold>
<globalSuperUser>true</globalSuperUser>
<inodeCacheSize>32768</inodeCacheSize>
<inodeExpandMin>0</inodeExpandMin>
<inodeExpandInc>0</inodeExpandInc>
<inodeExpandMax>0</inodeExpandMax>
<inodeDeleteMax>0</inodeDeleteMax>
<inodeStripeWidth>0</inodeStripeWidth>
<maxConnections>32</maxConnections>
<maxLogs>4</maxLogs>
<remoteNotification>false</remoteNotification>
<reservedSpace>true</reservedSpace>
<fsmRealTime>false</fsmRealTime>
<fsmMemLocked>false</fsmMemLocked>
<opHangLimitSecs>180</opHangLimitSecs>
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<perfectFitSize>131072</perfectFitSize>
<quotas>false</quotas>
<restoreJournal>false</restoreJournal>
<restoreJournalDir/>
<restoreJournalMaxHours>0</restoreJournalMaxHours>
<restoreJournalMaxMb>0</restoreJournalMaxMb>
<stripeAlignSize>0</stripeAlignSize>
<trimOnClose>0</trimOnClose>
<threadPoolSize>32</threadPoolSize>
<unixDirectoryCreationModeOnWindows>644</
unixDirectoryCreationModeOnWindows>
<unixIdFabricationOnWindows>false</unixIdFabricationOnWindows>
<unixFileCreationModeOnWindows>755</unixFileCreationModeOnWindows>
<unixNobodyUidOnWindows>60001</unixNobodyUidOnWindows>
<unixNobodyGidOnWindows>60001</unixNobodyGidOnWindows>
<windowsSecurity>true</windowsSecurity>
<eventFiles>true</eventFiles
<eventFileDir/>
<allocSessionReservation>false</allocSessionReservation>

</globals>
<diskTypes>

<diskType typeName="MetaDrive" sectors="99999999" sectorSize="512"/>
<diskType typeName="JournalDrive" sectors="99999999" sectorSize="512"/>
<diskType typeName="VideoDrive" sectors="99999999" sectorSize="512"/>
<diskType typeName="AudioDrive" sectors="99999999" sectorSize="512"/>
<diskType typeName="DataDrive" sectors="99999999" sectorSize="512"/>

</diskTypes>
<stripeGroups>

<stripeGroup index="0" name="MetaFiles" status="up" 
stripeBreadth="262144" read="true" write="true" metadata="true" 
journal="false" userdata="false" realTimeIOs="200" 
realTimeIOsReserve="1" realTimeMB="200" realTimeMBReserve="1" 
realTimeTokenTimeout="0" multipathMethod="rotate">

<disk index="0" diskLabel="CvfsDisk0" diskType="MetaDrive"/>
</stripeGroup>
<stripeGroup index="1" name="JournFiles" status="up" 
stripeBreadth="262144" read="true" write="true" metadata="false" 
journal="true" userdata="false" realTimeIOs="0" realTimeIOsReserve="0" 
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realTimeMB="0" realTimeMBReserve="0" realTimeTokenTimeout="0" 
multipathMethod="rotate">

<disk index="0" diskLabel="CvfsDisk1" diskType="JournalDrive"/>
</stripeGroup>
<stripeGroup index="2" name="VideoFiles" status="up" 
stripeBreadth="4194304" read="true" write="true" metadata="false" 
journal="false" userdata="true" realTimeIOs="0" realTimeIOsReserve="0" 
realTimeMB="0" realTimeMBReserve="0" realTimeTokenTimeout="0" 
multipathMethod="rotate">

<affinities exclusive="true">
<affinity>Video</affinity>

</affinities>
<disk index="0" diskLabel="CvfsDisk2" diskType="VideoDrive"/>
<disk index="1" diskLabel="CvfsDisk3" diskType="VideoDrive"/>
<disk index="2" diskLabel="CvfsDisk4" diskType="VideoDrive"/>
<disk index="3" diskLabel="CvfsDisk5" diskType="VideoDrive"/>
<disk index="4" diskLabel="CvfsDisk6" diskType="VideoDrive"/>
<disk index="5" diskLabel="CvfsDisk7" diskType="VideoDrive"/>
<disk index="6" diskLabel="CvfsDisk8" diskType="VideoDrive"/>
<disk index="7" diskLabel="CvfsDisk9" diskType="VideoDrive"/>

</stripeGroup>
<stripeGroup index="3" name="AudioFiles" status="up" 
stripeBreadth="1048576" read="true" write="true" metadata="false" 
journal="false" userdata="true" realTimeIOs="0" realTimeIOsReserve="0" 
realTimeMB="0" realTimeMBReserve="0" realTimeTokenTimeout="0" 
multipathMethod="rotate">

<affinities exclusive="true">
<affinity>Audio</affinity>

</affinities>
<disk index="0" diskLabel="CvfsDisk10" diskType="AudioDrive"/>
<disk index="1" diskLabel="CvfsDisk11" diskType="AudioDrive"/>
<disk index="2" diskLabel="CvfsDisk12" diskType="AudioDrive"/>
<disk index="3" diskLabel="CvfsDisk13" diskType="AudioDrive"/>

</stripeGroup>
<stripeGroup index="4" name="RegularFiles" status="up" 
stripeBreadth="262144" read="true" write="true" metadata="false" 
journal="false" userdata="true" realTimeIOs="0" realTimeIOsReserve="0" 
realTimeMB="0" realTimeMBReserve="0" realTimeTokenTimeout="0" 
multipathMethod="rotate">
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<disk index="0" diskLabel="CvfsDisk14" diskType="DataDrive"/>
<disk index="1" diskLabel="CvfsDisk15" diskType="DataDrive"/>
<disk index="2" diskLabel="CvfsDisk16" diskType="DataDrive"/>
<disk index="3" diskLabel="CvfsDisk17" diskType="DataDrive"/>

</stripeGroup>
</stripeGroups>

</config>
</configDoc>

Windows Example 
Configuration File

Below are the contents of the StorNext example configuration file for 
Windows (example.cfg):
# Globals

ABMFreeLimit no
AllocationStrategy Round
HaFsType HaUnmonitored
FileLocks No
BrlResyncTimeout 20
BufferCacheSize 32M
CvRootDir /
DataMigration No
DataMigrationThreadPoolSize 128
Debug 0x0
DirWarp Yes
ExtentCountThreshold 48K
EnableSpotlight No
ForcePerfectFit No
FsBlockSize 16K
GlobalSuperUser Yes
InodeCacheSize 32K
InodeExpandMin 0
InodeExpandInc 0
InodeExpandMax 0
InodeDeleteMax 0
InodeStripeWidth 0
JournalSize 16M
MaxConnections 32
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MaxLogs 4
PerfectFitSize 128K
RemoteNotification No
ReservedSpace Yes
FSMRealtime No
FSMMemlock No
OpHangLimitSecs 180
Quotas No
RestoreJournal No
RestoreJournalMaxHours 0
RestoreJournalMaxMB 0
StripeAlignSize -1
TrimOnClose 0
ThreadPoolSize 32
UnixDirectoryCreationModeOnWindows 0755
UnixIdFabricationOnWindows No
UnixFileCreationModeOnWindows 0644
UnixNobodyUidOnWindows 60001
UnixNobodyGidOnWindows 60001
WindowsSecurity Yes
EventFiles Yes
AllocSessionReservation No
# Disk Types

[DiskType MetaDrive]
Sectors 99999999
SectorSize 512
[DiskType JournalDrive]
Sectors 99999999
SectorSize 512
[DiskType VideoDrive]
Sectors 99999999
SectorSize 512
[DiskType AudioDrive]
Sectors 99999999
SectorSize 512
[DiskType DataDrive]
Sectors 99999999
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SectorSize 512
# Disks

[Disk CvfsDisk0]
Type MetaDrive
Status UP
[Disk CvfsDisk1]
Type JournalDrive
Status UP
[Disk CvfsDisk2]
Type VideoDrive
Status UP
[Disk CvfsDisk3]
Type VideoDrive
Status UP
[Disk CvfsDisk4]
Type VideoDrive
Status UP
[Disk CvfsDisk5]
Type VideoDrive
Status UP
[Disk CvfsDisk6]
Type VideoDrive
Status UP
[Disk CvfsDisk7]
Type VideoDrive
Status UP
[Disk CvfsDisk8]
Type VideoDrive
Status UP
[Disk CvfsDisk9]
Type VideoDrive
Status UP
[Disk CvfsDisk10]
Type AudioDrive
Status UP
[Disk CvfsDisk11]
Type AudioDrive
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Status UP
[Disk CvfsDisk12]
Type AudioDrive
Status UP
[Disk CvfsDisk13]
Type AudioDrive
Status UP
[Disk CvfsDisk14]
Type DataDrive
Status UP
[Disk CvfsDisk15]
Type DataDrive
Status UP
[Disk CvfsDisk16]
Type DataDrive
Status UP
[Disk CvfsDisk17]
Type DataDrive
Status UP
# Stripe Groups

[StripeGroup MetaFiles]
Status Up
StripeBreadth 256K
Metadata Yes
Journal No
Exclusive Yes
Read Enabled
Write Enabled
Rtmb 0
Rtios 0
RtmbReserve 0
RtiosReserve 0
RtTokenTimeout 0
MultiPathMethod Rotate
Node CvfsDisk0 0

[StripeGroup JournFiles]
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Status Up
StripeBreadth 256K
Metadata No
Journal Yes
Exclusive Yes
Read Enabled
Write Enabled
Rtmb 0
Rtios 0
RtmbReserve 0
RtiosReserve 0
RtTokenTimeout 0
MultiPathMethod Rotate
Node CvfsDisk1 0

[StripeGroup VideoFiles]
Status Up
StripeBreadth 4M
Metadata No
Journal No
Exclusive No
Read Enabled
Write Enabled
Rtmb 0
Rtios 0
RtmbReserve 0
RtiosReserve 0
RtTokenTimeout 0
MultiPathMethod Rotate
Node CvfsDisk2 0
Node CvfsDisk3 1
Node CvfsDisk4 2
Node CvfsDisk5 3
Node CvfsDisk6 4
Node CvfsDisk7 5
Node CvfsDisk8 6
Node CvfsDisk9 7
Affinity Video
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[StripeGroup AudioFiles]
Status Up
StripeBreadth 1M
Metadata No
Journal No
Exclusive No
Read Enabled
Write Enabled
Rtmb 0
Rtios 0
RtmbReserve 0
RtiosReserve 0
RtTokenTimeout 0
MultiPathMethod Rotate
Node CvfsDisk10 0
Node CvfsDisk11 1
Node CvfsDisk12 2
Node CvfsDisk13 3
Affinity Audio

[StripeGroup RegularFiles]
Status Up
StripeBreadth 256K
Metadata No
Journal No
Exclusive No
Read Enabled
Write Enabled
Rtmb 0
Rtios 0
RtmbReserve 0
RtiosReserve 0
RtTokenTimeout 0
MultiPathMethod Rotate
Node CvfsDisk14 0
Node CvfsDisk15 1
Node CvfsDisk16 2
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Node CvfsDisk17 3

Cluster-Wide Central Control

The purpose of this feature is to provide cluster-wide central control. 
(Currently the central control file is supported on the Linux platform 
only.) A central control file called nss_cctl.xml provides a way to restrict 
the behavior of SNFS cluster nodes (fsm, file system client, cvadmin 
client) from a central place: an NSS server. 

This feature currently supports the following controls that allow you to 
specify:

1 Whether a client is allowed to mount as a proxy client.

2 Whether a client is allowed to mount as read/write or read-only.

3 Whether a user (especially a local administrator on Windows 
clients,) is allowed to take ownership of a file or directory on a 
StorNext file system.

4 Whether cvadmin running on a certain client is allowed to have 
super admin privilege to run destructive commands such as starting/
stopping the file system, refreshing disks, changing quota settings, 
and so on.

5 Whether cvadmin running on certain client is allowed to connect to 
other fsms via the -H option.

6 Whether binary executable files on the StorNext file system are 
allowed to be executed.

7 Whether the setuid bit of a file is allowed to take effect.

The control file is in xml format and has a hierarchical structure. The top 
level element, snfsControl, contains control elements with the 
securityControl label for certain file systems. If you have different 
controls for different file systems, each file system should have its own 
control definition. A special virtual file system, #SNFS_ALL#, is used as 
the default control for file systems not defined in this control file. It is 
also used to define the cvadmin-related control on clients. 

Note: You cannot have a file system named #SNFS_ALL#.
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Each file system-related element (indicated by the label 
securityControl) has a list of controlEntry items. Each controlEntry 
item defines the client and the controls. The client type can be either 
host or netgrp. A host can be the IP address or the host name. (Both IP 
V4 and IP V6 are supported.) Netgrp specifies a group of consecutive IP 
addresses and has a network IP address (either IP V4 or V6,) and 
network mask bits. It is possible for there to be overlapping in IP address 
between an individual host and netgrp, but the individual host should 
be defined before the netgrp. If a client node has more than one IP 
address, then define the controls for each IP address.

The following controls are currently supported:

1 mountReadOnly: Control whether a client should mount as read-
only. The default is read/write.

2 mountDlanClient: Control whether a client can mount as a proxy 
client. The default is not allowed.

3 takeOwnership: Control whether users on a Windows client are 
allowed to take ownership of a file or directory in a StorNext file 
system.

4 snfsAdmin: Controls whether cvadmin running on a host is 
allowed to have super admin privilege to run privileged commands 
such as start/stop fs.

5 snfsAdminConnect: Controls whether cvadmin running on a client 
is allowed to connect to other fsm via the -H option.

6 exec: Controls whether binary executable files on the file system are 
allowed to be executed. The default value is “true” (that is, the 
execution is allowed).

7 suid: Controls whether the setuid bit is allowed to take effect. (The 
default value is “true”.)

If no match is found for a given client's IP address, the client has no 
privileges. If a file system has been defined but the client is not defined 
in that file system’s control section (securityControl), the client has no 
access privileges to the specified file system.

Cluster-Wide Control 
File Example

The control file called nss_cct1.xml provides a feature overview and 
describes how to configure the central control file. The values entered in 
the following sample file are for example purposes only and should not 
necessarily be entered in your own control files.
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<?xml version="1.0" encoding="UTF-8"?>

<!-- Cluster-Wide Central Control File -->

<!-- The nss_cctl.xml file provides a way to restrict the behavior of -->
<!-- SNFS cluster nodes (fsm, file system client, cvadmin client) from -->
<!-- a central place, i.e on nss server. As for SNFS 3.5, we support -->
<!-- the following controls:  -->
<!-- 1. Whether a client is allowed to mount as a proxy client -->
<!-- 2. Whether a client is allowed to mount as read/write or read-only. -->
<!-- 3. Whether a user especially local admin on windows is allowed to -->
<!--    take ownership of file or directory on a Stornext file system. -->
<!-- 4. Whether cvadmin running on certain client is allowed to have -->
<!--    super admin privilege to run destructive commands such as -->
<!--    start/stop file system, refresh disks, and change quota setting, -->
<!-- etc.  -->
<!-- 5. whether cvadmin running on certain client is allowed to connect -->
<!--    to other fsm via "-H" option. -->
<!-- 6. whether an executable file on the file system can be executed.  -->
<!-- 7. whether to allow set-user-identifier bit to take effect. -->
 
<!-- The control file is in xml format and has hierarchical structure. -->
<!-- The top level element is "snfsControl", it contains control element -->
<!-- "securityControl" for certain file system. If you have different -->
<!-- controls for different file systems, then each file system should -->
<!-- has its own control definition. A special virtual file system  -->
<!-- "#SNFS_ALL#" is used as the default control for file systems not -->
<!-- defined in this control file. It is also used to define the cvadmin -->
<!-- related control on clients. Note: you cannot have a real file -->
<!-- system named as "#SNFS_ALL#". -->

<!-- Each file system related control element (securityControl) has a --> 
<!-- list of "controlEntry", each "controlEntry" defines the client and -->
<!-- the controls. A client can be of type "host" or "netgrp". A "host" -->
<!-- can be ip address or host name. Both IP V4 and IP V6 are supported. -->
<!-- "netgrp" specifies a group of consecutive ip addresses. It has  -->
<!-- network ip address (either IP V4 or V6) and network mask bits. It -->
<!-- is possible that there is overlapping in ip addresses between  -->
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<!-- individual host and netgrp, but the individual host should be  -->
<!-- defined before the netgrp. In this case, the netgrp control is -->
<!-- considered to be generic case, while the controls for individual is -->
<!-- considered to be special case. A special case takes precedence. -->

<!-- Currently there are seven controls supported: -->
<!-- 1. mountReadOnly: control whether a client should mount as -->
<!--    readonly. The default is read/write.-->
<!-- 2. mountDlanClient: control whether a client can mount as proxy -->
<!--    client, the default is "mount not allowed".-->
<!-- 3. takeOwnership: control whether users on a windows client is -->
<!--    allowed to take ownership of file or directory of a stornext-->
<!--    file system. The default is "take ownership not allowed".-->
<!-- 4. snfsAdmin: whether cvadmin running on a host is allowed to have-->
<!--    super admin privilege to run privileged commands such as -->
<!--    start/stop fs. The default is that super admin privilege is not-->
<!--    honored. -->
<!-- 5. snfsAdminConnect: whether cvadmin running on a client is allowed-->
<!--    to connect to other fsm via "-H" option. The default is "-H" is-->
<!--    not allowed. -->
<!-- 6. exec: whether binary files on the file system is allowed to-->
<!--    be executed. -->
<!-- 7. suid: whether set-user-identifier bit is allowed to take effect.-->

<!-- If no match is found for a given client's ip address, then the-->
<!-- client has no privilege to access a SNFS cluster. If a file system-->
<!-- has been defined but the client is not defined in that file -->
<!-- system's control (securityControl), then the client has no access-->
<!-- privilege to the specified file system.-->

<!-- Currently only Linux platform is supported to be a nss server-->
<!-- capable of parsing this xml file.-->

<!-- The following is an example to define the nss_cctl.xml. It defines-->
<!-- the control of file system "snfs", and also the special virtual-->
<!-- file system "#SNFS_ALL#".  -->

<snfsControl xmlns="http://www.quantum.com/snfs/cctl/v1.0">
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    <securityControl fileSystem="snfs">
<controlEntry>
    <client type="host">

<hostName value="192.168.230.132"/>
    </client>
    <controls>

<mountReadOnly value="true"/>
<mountDlanClient value="true"/>
<takeOwnership value="false"/>
<exec value="true"/>
<suid value="false"/>

    </controls>
</controlEntry>
<controlEntry>
    <client type="netgrp">

<network value="192.168.1.0"/>
<maskbits value="24"/>

    </client>
    <controls>

<takeOwnership value="true"/>
<mountReadOnly value="true"/>

    </controls>
</controlEntry>

    </securityControl>
    <securityControl fileSystem="#SNFS_ALL#">

<controlEntry>
    <client type="host">

<hostName value="linux_ludev"/>
    </client>
    <controls>

<snfsAdmin value="true"/>
<snfsAdminConnect value="true"/>

    </controls>
</controlEntry>

    </securityControl>
</snfsControl>
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Quality of Service Guide

This appendix describes how to configure and use the StorNext File 
System (SNFS) Quality of Service (QOS) feature. QOS allows real-time 
applications to reserve some amount of bandwidth on the storage 
system. This is known as real-time I/O (RTIO). SNFS gates (that is, 
throttles) non-real-time applications so their I/O accesses do not 
interfere with the real-time application.

QOS is a passive implementation in that it does not actively monitor a 
process’ activity and then schedule the process so that it receives the 
bandwidth it has requested. It is up to real-time applications to gate 
their own I/O requests to the desired rate. SNFS QOS provides a “get out 
of the way” gating for non-real-time I/O requests so they do not hinder 
the real-time requests.

The remainder of this document explains the client and server 
configuration settings for QOS; describes the use of tokens and 
callbacks for gating non-real-time I/O; describes setting real-time I/O on 
a file; and discusses the performance monitoring tools that are available 
for diagnosis.
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QOS is stripe-group centric; all configuration and operations act on a 
specific stripe group. This allows stripe groups with differing access 
characteristics to use different real-time settings. When a client requests 
a certain amount of real-time I/O, the FSM informs all connected clients 
of the amount remaining and available for non-real-time I/O accesses.

This information is encapsulated in a token. Think of the token as a 
capability that enables the client to perform I/O without contacting the 
FSM. When the amount of real-time I/O on a stripe group changes, the 
FSM informs all connected clients about the change via a callback. 

In both the client and the server, QOS is implemented as a state 
machine. Each state has a set of events and allowable actions. In this 
document, the term state thusly refers to the internal state machine.

Active vs. Passive QOS is a passive, not active implementation of real-time I/O. In an active 
implementation guaranteed rate I/O known as GRIO), the scheduler is 
tightly coupled with the I/O subsystem. The qualities of the disk 
subsystem are well known so the scheduler can guarantee that a 
process will be scheduled such that it will receive the required amount 
of bandwidth. Since SNFS is a cross-platform file system that does not 
have hooks in the operating system scheduler, it cannot provide such a 
guarantee.

In a passive implementation, a real-time process gates its I/O according 
to some outside metric (such as a frame rate for specific video formats). 
The file system then gates all other non-real-time I/O so they do not 
interfere.

It is very important that the differences between Active and Passive OoS 
operation are understood by the user. It is a misconception to think that 
QOS, despite its name, guarantees a specific amount of real-time I/O to 
a process.

Supported Platforms QOS has been tested on Windows XP, Linux, and Solaris. In Windows, an 
application gets a handle to a file to perform I/O, usually via the Win32 
CreateFile() API. In UNIX, an application receives a file descriptor (fd) 
218 StorNext and StorNext FX 4.7.x Installation Guide 



Appendix D: Quality of Service Guide
Overview
via the open(2) system call. In this document, “handle” is synonymous 
with fd.

Non-Realtime 
Operation

Beginning with StorNext release 3.5, QOS has been enhanced to reserve 
bandwidth for non-realtime I/O clients. Differentiating between realtime 
and non-realtime I/O clients should result in better bandwidth 
utilization and overall performance. 

During the mounting process, there is now provision to specify the 
amount of bandwidth to be reserved. Applications that do not have 
awareness of the external API can leverage the bandwidth amount. 
Also, clients with different load characteristics can be differentiated.

Non-realtime I/O support is provided through a central configuration file 
on the FSM server side, which defines the bandwidth reservation for 
non-realtime I/O requests on certain clients. This bandwidth reservation 
(RVIO) has higher priority than normal non-realtime clients, but lower 
priority over the realtime application (RTIO). FSM will always attempt to 
first satisfy realtime requests, and then follow the bandwidth 
reservation request. The remaining bandwidth is evenly distributed to all 
active non-realtime clients (excluding RVIO reserved clients).

To summarize, bandwidth priority is allocated in the following order:

• Realtime applications (RTIO)

• Bandwidth reservation (RVIO)

• Non-realtime I/O requests

Note: If there is not sufficient bandwidth to accommodate the 
bandwidth reservation request (RVIO), the client receives 
whatever bandwidth remains after RTIO requests have been 
granted. If there are multiple RVIO clients, then each client is 
allocated a RVIO bandwidth directly proportional to their 
requested bandwidth.
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The primary configuration for QOS is in the FSM configuration file. No 
client configuration is required, although there is a QOS tuning 
parameter that can be specified when the file system is mounted.

Unit of I/O Real-time I/O is based on well-formed I/O. This means that for the 
purposes of determining bandwidth rates, well-formed I/O is 
characterized as being a stripe width in size. This makes the best 
utilization of the disks in the stripe group and maximizes the transfer 
rate. Internally, non-real-time I/O is tracked by number of I/O operations 
per second. An I/O operation is a minimum of a file system block size, 
and a maximum of the file system block size multiplied by the stripe 
breadth.

(FsBlocksize * StripeBreadth).

FsBlockSize <= I/O <= (FsBlocksize * StripeBreadth)

Converting MB/sec to I/
O/sec

Typically, it is easier to qualify an I/O subsystem in terms of MB/sec that 
can be sustained. However, internally the file system tracks everything 
on an I/O/sec basis. Note that the file system tracks only non-real-time I/
O (that is, it gates only non-real-time I/O). An I/O is a minimum of the 
file system block size, and is typically the point at which the file system 
hands the request off to the disk driver (IoCallDriver in Windows, or a 
strategy call in UNIX). 

The file system counts the number of I/Os that have taken place during a 
given second. If the number exceeds that which is allotted, the request 
is pended until I/O becomes available (typically in the next second). I/O is 
honored in FIFO fashion; no priority is assigned.

To convert between I/Os and MB/sec, SNFS uses a somewhat unique 
formula that quantifies I/O as well-formed. The rationale behind this is 
due to the way in which many video applications make real-time I/O 
requests. To optimize the disk subsystem, real-time I/Os are well-formed 
so they saturate the disks. In SNFS terminology, this would be an I/O 
that covers all of the disks in a stripe. 
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This can be expressed as follows:

ios_sec = mb_sec /

(stripe_breadth * stripe_depth *fs_blocksize)

For example, with a file system blocksize of 4k, a stripe_breadth of 384, 
and a stripe_depth of four, the equivalent number of I/Os/sec for each 
well-formed I/O would be 216 Mb/sec / (384 * 4 * 4k). This is equivalent 
to 221184 k/sec / 6144k= 36 I/O/sec.

Server Configuration

All storage subsystems are different, so users must qualify the I/O 
subsystem and determine the maximum amount of I/O bandwidth 
available. SNFS relies on the correct setting in the configuration file; if 
the storage system changes (for example, because of a new disk array,) 
the user must re-qualify the I/O subsystem to determine the amount of 
bandwidth available. This amount will be specified in the FSM 
configuration file. The user can also specify the minimum amount of 
bandwidth to be provided to non-real-time applications.

There are five keywords controlling QOS that can be specified in the 
stripe group section of the FSM configuration file. Not all keywords 
need be present. Typically, the user specifies the RTIO bandwidth in 
terms of either number of I/O operations per second (rtios) or 
megabytes per second (rtmb). Keywords are not case sensitive.

For a minimum configuration, only the real-time limit (either rtios or 
rtmb) need be specified. All other configuration variables default to 
reasonable values.

Table 21  QOS Configuration 
Keywords Name Description Default

Rtios The maximum number of real-
time I/Os allowed in a stripe 
group during any one-second 
period.

0 (no real-
time)

Rtmb Maximum amount of real-time 
MB/sec allowed on the stripe 
group during any one-second 
period.

0 (no real-
time)
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RTIO Upper Bound

The limit will be specified in terms of I/Os per second (parameter Rtios) 
or in terms of MB/sec (parameter Rtmb). Case is not sensitive. Note that 
I/Os per second are I/Os of any size to the disk subsystem. Either or both 
may be specified. If both are specified, the lower limit is used to throttle 

I/O. If neither is specified, no real-time I/O is available on the stripe 
group. These parameters are applied to a stripe group definition.

Example (Linux)

Example (Windows)

RtiosReserve Amount of reserve in I/Os/sec 
from the maximum allowed 
for non-real-time I/Os. Must be 
greater than the equivalent to 
1MB/sec or the amount that 
can be transferred to a single 
stripe line.

Equivalent to 
1MB/sec

RtmbReserve Amount to reserve in MB/sec 
from the maximum allowed 
for non-real-time I/O. 

Must be 
greater than 1.
1MB/sec

RtTokenTimeout Time in seconds to wait for 
clients to respond to a token 
callback.

1.5 seconds

<stripeGroup> index="1" name="MyStripeGroup" 
realTimeIOs="2048" realTimeMB="10"

</stripeGroup>

[StripeGroup MyStripeGroup]

Rtios 2048

Rtmb 10

Name Description Default
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The above example specifies that the storage system can support a 
maximum of 2048 I/Os per second at any instant, aggregate among all 
the clients, or 10 MB/sec, whichever is lower.

Most real-time I/O requests will be a stripe line at a time to maximize 
performance. Non-real-time I/Os will be a minimum of a file system 
block size. 

Note: It is important to realize that the rtios and rtmb settings refer 
to the total amount of sustained bandwidth available on the 
disk subsystem. Any I/O, either real-time or non-real-time, will 
ultimately be deducted from this overall limit. The calculations 
of available real-time and non-real-time are discussed later. 
 
Specifying rtmb in the FSM configuration file is only 
recommended if all I/Os are well formed (that is, a full stripe 
width). Otherwise, the conversion between MB/sec and I/Os/sec 
using the well-formed I/O calculation could lead to unexpected 
results.

Reserve

To prevent deadlock, the QOS implementation never allows zero I/O/sec 
for non-real-time I/O. Otherwise, a system could block with many critical 
file system resources held waiting for I/O to become available. This is 
especially true via flush-on-close I/O via the buffer cache. It becomes 
extremely difficult to diagnose system hangs because no I/O is available. 
For this reason, QOS always reserves some amount of I/O for non-real-
time I/O.

The minimum amount of non-real-time I/O reserved for non-real-time 
applications is one MB/sec. This can be changed via the stripe group 
section parameters (again, case is not sensitive). If both are specified, 
the lower of the two amounts is chosen. This amount is shared by all 
non-real-time applications on each client.

Example (Linux)

<stripeGroup> index="1" name="MyStripeGroup" 
realTimeIOsReserve="256" realTimeMBReserve="2"

</stripeGroup>
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Example (Windows)

Token Timeouts

The RtTokenTimeout parameter controls the amount of time the FSM 
waits for clients to respond to callbacks. In most normal SANs, the 
default two-second setting is sufficient. This value may need to be 
changed for a SAN that has a mixture of client machine types (Linux, 
Windows NT, etc.) that all have different TCP/IP characteristics. Also, 
large numbers of clients (greater than 32) may also require increasing 
the parameter.

For example, if the FSM should ever fail, the clients will attempt to 
reconnect. When the FSM comes back online, the amount of time the 
clients take to re-establish their TCP/IP connection to the FSM can differ 
wildly. To avoid unnecessary timeouts, the RtTokenTimeout parameter 
can be increased, meaning the FSM waits longer for callback responses.

If a client times out on a token retraction, the original requestor receives 
an error from the FSM that includes the IP address of the offending 
client. This error is logged to syslog, and alternatively to the desktop on 
Windows clients. This can help in diagnosing reconnect failures, and in 
determining if the token time value should be increased.

Client Configuration

When a client obtains a non-real-time I/O token from the FSM, the token 
allows the client a specific amount of non-real-time I/O. If the client is 
inactive for a period of time, the token is relinquished and the non-real-
time I/O released back to the FSM for distribution to other clients. The 
timeout period is controlled by the nrtiotokenhold mount option on 
UNIX platforms, and the QOS Token Hold Time parameter in the mount 
options tab of the SNFS control panel on Windows platforms. The 
default is sixty (60) seconds. 

This means that after sixty seconds without non-real-time I/O on a stripe 
group, the non-real-time token for that stripe group is released. The 

[StripeGroup MyStripeGroup]

RtiosReserve 256

RtmbReserve 2
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parameter should be specified in five (5) second increments. If it is not, 
it will be silently rounded up to the next five-second boundary. If the 
syslog level is set to debug, the file system dumps out its mount 
parameters so the value can be seen.

Real-time I/O

A process requests real-time (ungated) I/O by using the SNFS External 
API SetRtio call (F_SETRIO ioctl). A library function is included in the 
External API sample source code that provides all the required cross-
platform handling.

As an example, assume that a video playback application requires a 
constant rate of 186 MB/sec to correctly display images without 
dropping any frames. The application gates itself; that is, it requests I/O 
at a rate to satisfy the requirements of correctly displaying an image. 
QOS provides a mechanism so other I/O requests do not perturb the 
real-time display.

In the following example, assume the I/O subsystem has been qualified 
at 216 MB/sec. The file system block size is 4k. The disk subsystem is 
actually a large RAID array that internally maps many drives to a single 
LUN. There are four LUNs in the stripe group; each LUN is optimized for 
a 1.5 MB transfer. This corresponds to the following in the fsm 
configuration file:
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Example (Linux)

Example (Windows)

Also, assume there is only one stripe group for user data in the file 
system. As recommended by Quantum, there may be other stripe 
groups for metadata and journal that are not shown.

SetRtio Initially, all stripe groups in the file system are in non-real-time mode. 
Clients make their requests directly to the I/O subsystem without any 
gating. In our example, the process requires 186 MB/sec and the system 
designers know there will never be a need to support more than one 
stream at 186 MB/sec.

<stripeGroup index="1" name="MyStripeGroup" 
stripeBreadth="384" realTimeMB="216">

<disk index="0" diskLabel="CvfsDisk0" 
diskType="VideoDrive"/>

<disk index="0" diskLabel="CvfsDisk1" 
diskType="VideoDrive"/>

<disk index="0" diskLabel="CvfsDisk2" 
diskType="VideoDrive"/>

<disk index="0" diskLabel="CvfsDisk3" 
diskType="VideoDrive"/>

</stripeGroup>

[StripeGroup MyStripeGroup]

StripeBreadth 384

  Node CvfsDisk0 0

  Node CvfsDisk1 1

  Node CvfsDisk2 2

  Node CvfsDisk3 3

  Rtmb 216
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The SetRtio request has a number of flags and parameters to control its 
operation. These are all documented in the external_api.pdf file that 
describes the external API in detail. For this example, set the handle for 
the indicated stripe group using the RT_SET parameter. 

Oversubscription In most cases, system designers ensure that the amount of RTIO is not 
oversubscribed. This means that processes will not ask for more RTIO 
than is specified in the configuration file. However, it is possible to 
request more RTIO than is configured. The API uses the RT_MUST flag 
to indicate that the call must succeed with the specified amount. If the 
flag is clear, the call allocates as much as it can. In both cases, the 
amount allocated is returned to the caller. 

Handles The SetRtio call accepts two different types of handles. The first is a 
handle to the root directory. In this mode the stripe group is put into 
real-time mode, but no specific file handle is tagged as being ungated. 
Real-time I/O continues on the stripe group until it is explicitly cleared 
with a SetRtio call on the root directory that specifies the RT_CLEAR 
flag; the file system is unmounted; or the system is rebooted. It is up to 
the application to make a subsequent call to EnableRtio 
(F_ENABLERTIO) on a specific handle.

If the handle in the SetRtio call refers to a regular file, it is the 
equivalent of a SetRtio call on the root directory followed by an 
EnableRtio call. The file handle will be ungated until it is closed, cleared 
(RT_CLEAR in a SetRtio call), or disabled (DisableRtio). When the 
handle is closed, the amount of real-time I/O is released back to the 
system. This causes the FSM to readjust the amount of bandwidth 
available to all clients by issuing a series of callbacks. 

The client automatically issues a call to the FSM with the RT_CLEAR flag 
specifying the amount of real-time I/O set on the file. If multiple handles 
are open on the file—each with a different amount of real-time I/O—
only the last file close triggers the releasing action; all aggregate RTIO 
are released.

This automatic clearing of real-time I/O is carried out in the context of 
the process that is closing the file. If the FSM cannot be reached for 
some reason, the request is enqueued on a daemon and the process 
closing the file is allowed to continue. In the background, the daemon 
attempts to inform the FSM that the real-time I/O has been released.
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Different processes can share the same file in real-time and non-real-
time mode. This is because the level of gating is at the handle level, not 
the file level. This allows a real-time process to perform ingest of 
material (video data) at the same time as non-real-time processes are 
performing other operations on the file.

Figure 76  Sharing Access to 
Files

In Figure 76, Process A has ungated access to file foo. Processes B and C 
also are accessing file foo, but the client gates their I/O accesses. If 
multiple handles are open to the same file and all are in real-time mode, 
only the last close of the handle releases the real-time I/O back to the 
system. This is because on most platforms the file system is informed 
only on the last close of a file.

Ungated files It is also possible to denote using the RT_NOGATE flag that a handle 
should not be gated without specifying any amount of real-time I/O. 
This is useful for infrequently accessed files (such as index files) that 
should not be counted against the non-real-time I/O. System designers 
typically allow for some amount of overage in their I/O subsystem to 
account for non-gated files.

Calculating Available 
RTIO

When the FSM receives a request for RTIO, it takes the amount reserved 
into consideration. The reserve amount functions as a soft limit beyond 
which the FSM will not traipse. The calculation for RTIO is as follows:

available_rtio = (rtio_limit) - (rtio_current) - (rtio_reserve)
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In the above calculation, rtio_limit is the stripe group’s maxmimum 
number of IOs (the value of parameter Rtios), rtio_current is the total 
number of currently reserved real-time IOs, and rtio_reserve is the 
minimum IOs reserved for non-realtime IOs (the value of RtiosReserve).

All internal calculations are done in terms of I/O/sec.

Non-Realtime I/O Configuration

In order to reserve bandwidth for non-realtime I/O (RVIO) operations on 
certain clients, you must specify the amount in the QOS central 
configuration file. This file is located under $CVFSROOT/config/ (for 
example, /usr/cvfs/config). The configuration file name consists of the 
file system name and the suffix _rvio.opt. For example, the central 
configuration file name for a file system called fs1 would be 
fs1_rvio.opt. 

The configuration doesn't affect the normal RTIO requests; it affects only 
the bandwidth allocation to non-RTIO requests. Note the following 
characteristics of RVIO:

1 RTIO has higher priority and is always satisfied first. RVIO uses 
whatever bandwidth is left.

2 RVIO reservation is not guaranteed. Instead, it is adjusted 
dynamically. When there are new RVIO or RTIO requests, the 
bandwidth reserved for clients with previous RVIO requests is 
readjusted. Each RVIO client will get the RVIO bandwidth reserved 
proportional to its request amount.

3 The RVIO bandwidth allocated for a client is the total bandwidth for 
non-RTIO requests on the client. The bandwidth (token) will not 
return like a normal non-RTIO client does if it's been idle for a hold 
time. Non-RTIO requests on clients with an RVIO reservation is 
subject to the same throttling mechanism as non-RTIO requests on 
normal clients.

4 Other active non-RTIO clients equally share the bandwidth left over 
after the possible RTIO and RVIO allocations. If no bandwidth is left, 
the minimal reserved bandwidth (defined in the stripe group section 
of the file system configuration file) is used.
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A central configuration file has multiple entries, and each entry defines 
the RVIO reservation for a client. Following are the fields of an entry:

host bw-type sg=yy,[sg=yy]

• host is the host name, IP address (either V4 or V6), or FQDN, etc. of 
the client. The host name should be able to be resolved (converted 
to a valid IP address) by the FSM server. If there are multiple IPs on 
the host, use the IP that is used to communicate with the FSM.

• bw-type is the type of bandwidth to be specified. There are two 
bandwidth type options:

• qosmb means the subsequent value for bandwidth reservation 
uses MB/s (megabytes per second) as the unit of measure. 

• qosios means the subsequent value for bandwidth reservation 
uses IOs/s (inputs/outputs per second) as the unit of measure.

• sg stands for stripe group. You may specify a stripe group by 
entering the stripe group name, or by stripe group number starting 
from 0 for the first stripe group. If you'd like to specify the same 
RVIO bandwidth reservation for all eligible stripe groups, you can 
use the asterisk wildcard in the format *=yy.

Any line in the configuration file starting with the pound sign (#) is 
considered a comment line and is not executed.

For additional information about entering the configuration file for 
QOS, see the man page called qos_config.1. 

Configuration File 
Examples

Following are some example configuration file entry examples:

box1.xyz.com qosios 2=200,4=50,sg5=45

10.10.1.8     qosmb *=60
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Callbacks

The cornerstones of the communications between the FSM and the 
client are callbacks and tokens. A callback is an unsolicited message 
from the FSM to the client requesting that the client adjust its real-time 
I/O parameters. The callback contains a token that specifies the amount 
of non-real-time I/O available on a stripe group.

Initially, all stripe groups in a file system are in non-real-time (ungated) 
mode. When the FSM receives the initial request for real-time I/O, it first 
issues callbacks to all clients informing them that the stripe group is 
now in real-time mode. The token accompanying the message specifies 
no I/O is available for non-real-time I/O. Clients must now obtain a non-
real-time token before they can do any non-real-time I/O.

After sending out all callbacks, the FSM sets a timer based on the 
RtTokenTimeout value, which by default is set to 1.5 seconds. If all 
clients respond to the callbacks within the timeout value the RTIO 
request succeeds, and a response is set to the requesting client.

Figure 77  Callback Flow for 
Initial RTIO Request
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In the above diagram, a process on client A requests some amount of 
RTIO in Step 1. Since this is the first request, the FSM issues callbacks to 
all connected clients (Steps 2-5) informing them that the stripe group is 
now in real-time mode. The clients respond to the FSM in Steps 6-9. 
After all the clients have responded, the FSM responds to the original 
requesting client in Step 10.

If the timer expires and one or more clients have not responded, the 
FSM must retract the callbacks. It issues a response to the requesting 
client with the IP number of the first client that did not respond to the 
callback. This allows the requesting client to log the error with the IP 
number so system administrators have a chance of diagnosing the 
failure. It then sends out callbacks to all the clients to which it first sent 
the callbacks, retracting them to the original state. In our example, it 
would set the stripe group back to non-real-time mode.

After sending out the callbacks, the FSM waits for a response using the 
RtTokenTimeout value as before. If a client again does not respond 
within the timeout value, the callbacks are retracted and sent out again. 
This repeats until all clients respond. During this time of token 
retractions, real-time requests cannot be honored and will only be 
enqueued.

Callback Failures The FSM must handle a case where a client does not respond to a 
callback within the specified timeout period (RtTokenTimeout). If a 
client does not respond to a callback, the FSM must assume the worst: 
that it is a rogue that could wreak havoc on real-time I/O. It must retract 
the tokens it just issued and return to the previous state.

As mentioned earlier, the original requestor will receive an error 
(EREMOTE) and the IP address of the first client that did not respond to 
the callback. The FSM enters the token retraction state, and will not 
honor any real-time or token requests until it has received positive 
acknowledgement from all clients to which it originally sent the 
callbacks.
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Figure 78  Callback Retraction 
Example

In Figure 78, Client A requests some amount of RTIO as in Figure 77. 
However, assume that Client C did not respond to the initial callback in 
time (step 7). The FSM will return a failure to Client A for the initial RTIO 
request, then send out callbacks to all clients indicating the stripe group 
is no longer real-time (steps 11-14). In the example, Client C responds to 
the second callback, so the FSM will not send out any more callbacks. 
The stripe group is back in non-real-time mode.

Note that this can have interesting repercussions with file systems that 
are soft mounted by default (such as Windows). When the caller times 
out because other clients are not responding and then gives up and 
returns an error to the application, if at some point the FSM is able to 
process the RTIO request it may result in the stripe group being put into 
real-time mode after the original caller has received an error code. Both 
the FSM and clients log their actions extensively to syslog, so if this 
situation arises it can be detected.

In Figure 78, if the stripe group were already in real-time mode the FSM 
would only send out callbacks to those clients that already have tokens. 
Once all clients responded to the token callbacks, the stripe group 
would be back in its original state.

Tokens A token grants a client some amount of non-real-time I/O for a stripe 
group. Tokens are encapsulated in callback messages from the FSM. 
Initially, no tokens are required to perform I/O. Once a stripe group is 
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put into real-time mode, the FSM sends callbacks to all clients informing 
them that they will need a token to perform any non-real-time I/O. The 
first I/O after receiving the callback will then request a non-real-time I/O 
token from the FSM.

The FSM calculates the amount of non-real-time bandwidth using the 
following formula:

In the above calculation, rvio_current is the total bandwidth reserved 
by current RVIO clents. The amount of existing real-time I/O 
(rtio_current) has already been adjusted with the reserve parameter. As 
each client requests a non-real-time I/O token, the number of clients 
increases (current_num_nonrtio_clients in the above formula) and the 
amount of available non-real-time I/O decreases.

Each time there is a change in the amount of non-real-time I/O available, 
the FSM sends callbacks to the clients with tokens. It is important to 
note that unlike the initial set of callbacks where the FSM sent callbacks 
to all connected clients, it is now only necessary to send callbacks to 
those clients that have an existing token.

Once a client has a token, it can perform as much I/O per second as is 
allowed by that token. It does not need to contact the FSM on every I/O 
request. The FSM will inform the client whenever the token changes 
value.

available_nrtio =
(rtio_limit) - (rtio_current) - (rvio_current)

(current_num_nrtio_clients) + 1
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Figure 79  Non-Real-time Token 
Adjustments

In Figure 79, assume the stripe group is already in real-time mode as a 
result of an RTIO request from client A. Clients B and D are doing non-
real-time I/O to the stripe group and have a token that specifies the 
amount of non-real-time I/O available. Client C then requests a non-real-
time I/O token in Step 1. The FSM calls back to Clients B and D and 
specifies the new token amount in Steps 2-3. The clients respond in 
Steps 4-5, acknowledging the new token amount. The FSM then 
responds to Client C with the new token in Step 6.

Failure Semantics There are two major failures that affect QOS: FSM crashes and client 
crashes. These can also be loss of communication (network outages). 
For client and server failures, the system attempts to readjust itself to 
the pre-failure state without any manual intervention.

FSM Failures If the FSM crashes or is stopped, there is no immediate affect on real-
time (ungated) I/O. As long as the I/O does not need to contact the FSM 
for some reason (attribute update, extent request, etc.), the I/O will 
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continue. From the standpoint of QOS, the FSM being unavailable has 
no affect.

Non-real-time I/O will be pended until the FSM is re-connected. The 
rationale for this is that since the stripe group is in real-time mode, 
there is no way to know if the parameters have changed while the FSM 
is disconnected. The conservative design approach was taken to hold off 
all non-real-time I/O until the FSM is reconnected.

Once the client reconnects to the FSM, the client must re-request any 
real-time I/O it had previously requested. The FSM does not keep track 
of QOS parameters across crashes; that is, the information is not logged 
and is not persistent. Therefore, it is up to the clients to inform the FSM 
of the amount of required RTIO and to put the FSM back into the same 
state as it was before the failure.

In most cases, this results in the amount of real-time and non-real-time 
I/O being exactly the same as it was before the crash. The only time this 
would be different is if the stripe group is oversubscribed. In this case, 
since more RTIO had been requested than was actually available, and 
the FSM had adjusted the request amounts, it is not deterministically 
possible to re-create the picture exactly as it was before. Therefore, if a 
deterministic picture is required across reboots, it is advisable to not 
over-subscribe the amount of real-time I/O.

The process of each client re-requesting RTIO is exactly the same as it 
was initially; once each client has reestablished its RTIO parameters, the 
non-real-time I/O is allowed to proceed to request a non-real-time 
token. It may take several seconds for the SAN to settle back to its 
previous state. It may be necessary to adjust the RtTokenTimeout 
parameter on the FSM to account for clients that are slow in 
reconnecting to the FSM.

Client Failures When a client disconnects either abruptly (via a crash or a network 
partition,) or in a controlled manner (via an unmount), the FSM releases 
the client's resources back to the SAN. If the client had real-time I/O on 
the stripe group, that amount of real-time I/O is released back to the 
system. This causes a series of callbacks to the clients (all clients if the 
stripe group is transitioning from real-time to non-real-time,) informing 
them of the new amount of non-real-time I/O available.

If the client had a non-real-time I/O token, the token is released and the 
amount of non-real-time I/O available is recalculated. Callbacks are sent 
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to all clients that have tokens informing them of the new amount of 
non-real-time I/O available.

Client Token Releases While it is not a failure case, the handling of a client token release is 
exactly the same as in the case where the client disconnected. All clients 
retain non-real-time tokens for a fixed amount of time. The default is 60 
seconds. This can be controlled via the nrtiotokentimeout mount 
option. After the specified period of inactivity (i.e., no non-real-time I/O 
on the stripe group), the client will release the token back to the FSM. 
The FSM will re-calculate the amount of non-real-time bandwidth 
available, and send out callbacks to other clients.

Therefore, if a situation exists where a periodic I/O operation occurs 
every 70 seconds, it would be beneficial to set the nrtiotokentime 
mount option to something greater than or equal to 70 seconds to cut 
down on system and SAN overhead.

Monitoring

The current real-time statistics are available via the cvadmin utility. The 
show long command has been enhanced to provide information as to 
the current limit, the minimum amount reserved for non-real-time I/O, 
the number of active clients, the amount currently committed, and the 
amount a non-real-time application could hope to get when requesting  
I/O.

Whenever the stripe group status changes (such as from non-real-time 
to real-time mode), an event is logged to syslog (system event log on 
Windows platforms).

On the NT platform, real-time performance is also available via the 
perfmon utility. There are counters for both the client (SNFS Client) and 
FSM (SNFS File System Server [FSS]). In the client, a number of rtio_xxx 
counters are available to track the number of real-time I/Os/sec, number 
of non-real-time I/O requests, non-real-time I/O starvation, and other 
counters. A full explanation of each counter is provided with the 
perfmon utility by clicking Explain. In the FSM, information about the 
number of outstanding non-real-time clients, available RTIO, and other 
QOS information is available.
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Performance counters are not enabled by default in the client. To enable 
them, you must execute cvdb -P ; this toggles the state of collection. To 
turn off the perfmon counters, do another cvdb -P. To re-enable, again 
do cvdb -P, and so on. To clear all client counters to zero, disable, then 
re-enable the counters with cvdb -P.

Sharing Disk Resources

As a final example, consider the case of a full-featured disk subsystem 
(Redundant Array of Very Expensive Disks, or RAVED) using a very high 
speed interconnect. Many clients can share these disk arrays, but it is 
sometimes desirable to limit a client's access to the array. QOS provides 
a mechanism for political bandwidth management so that no one client 
can consume all the bandwidth of the channel interconnects.

In such a scenario, the stripe group would always be in real-time mode. 
Each client would have a token specifying the number of I/Os/sec 
permissible. If there is need to assign different reserved bandwidth for 
non-real-time clients, specify the client’s bandwidth reservation in the 
RVIO config file.

The foundation of such an approach is a simple program that puts the 
stripe group into real-time mode as soon as the FSM is up and servicing 
requests. An example of such a program is included in the source code 
for the External API.

Once the stripe group is in real-time mode, the bandwidth as specified 
in the FSM configuration file is shared by all clients. In cases such as this, 
the real-time limit (rtios or rtmb) is calculated to be the total 
bandwidth desired to each client times the number of possible clients.

As each client attempted to access the disk subsystem, it would obtain a 
token. The FSM would send out callbacks adjusting down the amount of 
bandwidth available. No one client would be allowed to exceed the 
threshold specified in the non-realtime token. This assures fairness 
among all the clients.
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